Legal information

Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are graded according to the degree of danger.

⚠️ **DANGER**
indicates that death or severe personal injury will result if proper precautions are not taken.

⚠️ **WARNING**
indicates that death or severe personal injury may result if proper precautions are not taken.

⚠️ **CAUTION**
indicates that minor personal injury can result if proper precautions are not taken.

**NOTICE**
indicates that property damage can result if proper precautions are not taken.

If more than one degree of danger is present, the warning notice representing the highest degree of danger will be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property damage.

Qualified Personnel

The product/system described in this documentation may be operated only by personnel qualified for the specific task in accordance with the relevant documentation, in particular its warning notices and safety instructions. Qualified personnel are those who, based on their training and experience, are capable of identifying risks and avoiding potential hazards when working with these products/systems.

Proper use of Siemens products

Note the following:

⚠️ **WARNING**
Siemens products may only be used for the applications described in the catalog and in the relevant technical documentation. If products and components from other manufacturers are used, these must be recommended or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and maintenance are required to ensure that the products operate safely and without any problems. The permissible ambient conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks

All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability

We have reviewed the contents of this publication to ensure consistency with the hardware and software described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the information in this publication is reviewed regularly and any necessary corrections are included in subsequent editions.
Preface

SINUMERIK documentation

The SINUMERIK documentation is organized in the following categories:

- General documentation
- User documentation
- Manufacturer/service documentation

Additional information

You can find information on the following topics at www.siemens.com/motioncontrol/docu:

- Ordering documentation/overview of documentation
- Additional links to download documents
- Using documentation online (find and search in manuals/information)

Please send any questions about the technical documentation (e.g. suggestions for improvement, corrections) to the following address:

docu.motioncontrol@siemens.com

My Documentation Manager (MDM)

Under the following link you will find information to individually compile OEM-specific machine documentation based on the Siemens content:

www.siemens.com/mdm

Training

For information about the range of training courses, refer under:

- www.siemens.com/sitrain
  SITRAIN - Siemens training for products, systems and solutions in automation technology
- www.siemens.com/sinutrain
  SinuTrain - training software for SINUMERIK

FAQs

SINUMERIK

You can find information on SINUMERIK under the following link:
www.siemens.com/sinumerik

Target group

This publication is aimed at planning and application engineers.

Benefits

The Configuration Manual enables the target group to apply the rules and guidelines to be observed when configuring products and systems. It helps you select products and functions.
The Configuration Manual helps the target group to create a system or plant configuration.

Standard scope

This documentation only describes the functionality of the standard version. Additions or revisions made by the machine tool manufacturer are documented by the machine tool manufacturer.

Other functions not described in this documentation might be executable in the control. This does not, however, represent an obligation to supply such functions with a new control or when servicing.

For the sake of simplicity, this documentation does not contain all detailed information about all types of the product and cannot cover every conceivable case of installation, operation, or maintenance.

Technical Support

You will find telephone numbers for other countries for technical support in the Internet under http://www.siemens.com/automation/service&support

EC Declaration of Conformity

The EC Declaration of Conformity for the EMC Directive can be found on the Internet at:
http://support.automation.siemens.com/WW/view/de/10805517/134200
Fundamental safety instructions

⚠️ WARNING

Danger to life if the safety instructions and residual risks are not observed

If the safety instructions and residual risks in the associated hardware documentation are not observed, accidents involving severe injuries or death can occur.

- Observe the safety instructions given in the hardware documentation.
- Consider the residual risks for the risk evaluation.

⚠️ WARNING

Danger to life or malfunctions of the machine as a result of incorrect or changed parameterization

As a result of incorrect or changed parameterization, machines can malfunction, which in turn can lead to injuries or death.

- Protect the parameterization (parameter assignments) against unauthorized access.
- Respond to possible malfunctions by applying suitable measures (e.g. EMERGENCY STOP or EMERGENCY OFF).
Industrial security

Note

Industrial security

Siemens provides products and solutions with industrial security functions that support the secure operation of plants, systems, machines and networks.

In order to protect plants, systems, machines and networks against cyber threats, it is necessary to implement – and continuously maintain – a holistic, state-of-the-art industrial security concept. Siemens products and solutions only represent one component of such a concept.

The customer is responsible for preventing unauthorized access to its plants, systems, machines and networks. Systems, machines and components should only be connected to the enterprise network or the internet if and to the extent necessary and with appropriate security measures (e.g. use of firewalls and network segmentation) in place.

Additionally, Siemens’ guidance on appropriate security measures should be taken into account. For more information about industrial security, please visit: Industrial Security (http://www.siemens.com/industrialsecurity).

Siemens’ products and solutions undergo continuous development to make them more secure. Siemens strongly recommends to apply product updates as soon as available and to always use the latest product versions. Use of product versions that are no longer supported, and failure to apply latest updates may increase customer’s exposure to cyber threats.


⚠️ WARNING

Danger to life as a result of unsafe operating states resulting from software manipulation

Software manipulations (e.g. viruses, trojans, malware or worms) can cause unsafe operating states in your system that may lead to death, serious injury, and property damage.

- Keep the software up to date.
- Incorporate the automation and drive components into a holistic, state-of-the-art industrial security concept for the installation or machine.
- Make sure that you include all installed products into the holistic industrial security concept.
- Protect files stored on exchangeable storage media from malicious software by with suitable protection measures, e.g. virus scanners.
# Table of contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preface</td>
<td>3</td>
</tr>
<tr>
<td>1 Product information</td>
<td>11</td>
</tr>
<tr>
<td>1.1 Validity of the description</td>
<td>11</td>
</tr>
<tr>
<td>1.2 Product features</td>
<td>12</td>
</tr>
<tr>
<td>1.3 Installation notes</td>
<td>13</td>
</tr>
<tr>
<td>1.4 Limitations for use</td>
<td>15</td>
</tr>
<tr>
<td>2 Configuring the NCU</td>
<td>17</td>
</tr>
<tr>
<td>2.1 SINUMERIK NCU</td>
<td>17</td>
</tr>
<tr>
<td>2.1.1 Structure of SINUMERIK NCU</td>
<td>17</td>
</tr>
<tr>
<td>2.1.2 Insert NCU</td>
<td>17</td>
</tr>
<tr>
<td>2.2 Insert NX module</td>
<td>21</td>
</tr>
<tr>
<td>2.3 Replacing a device or upgrading firmware</td>
<td>25</td>
</tr>
<tr>
<td>2.3.1 Replacing the NCU</td>
<td>25</td>
</tr>
<tr>
<td>2.3.2 Replacing an NX</td>
<td>25</td>
</tr>
<tr>
<td>2.3.3 Basic procedure</td>
<td>26</td>
</tr>
<tr>
<td>2.4 Setting up the communication</td>
<td>28</td>
</tr>
<tr>
<td>2.5 Loading and closing the hardware configuration in the PLC</td>
<td>30</td>
</tr>
<tr>
<td>2.6 Creating SINUMERIK PLC archives</td>
<td>33</td>
</tr>
<tr>
<td>2.6.1 Creating a SINUMERIK PLC archive</td>
<td>33</td>
</tr>
<tr>
<td>2.6.2 Available SINUMERIK archive types</td>
<td>36</td>
</tr>
<tr>
<td>2.6.3 External tools for SINUMERIK archives</td>
<td>37</td>
</tr>
<tr>
<td>2.6.4 Creating a PLC hardware upgrade archive</td>
<td>38</td>
</tr>
<tr>
<td>2.6.5 Creating a PLC commissioning archive</td>
<td>39</td>
</tr>
<tr>
<td>2.6.6 Creating a PLC reload archive</td>
<td>41</td>
</tr>
<tr>
<td>3 Programming the PLC</td>
<td>45</td>
</tr>
<tr>
<td>3.1 General information about the PLC program</td>
<td>45</td>
</tr>
<tr>
<td>3.1.1 Introduction</td>
<td>45</td>
</tr>
<tr>
<td>3.1.2 Execution structure</td>
<td>45</td>
</tr>
<tr>
<td>3.1.3 Using copy templates</td>
<td>48</td>
</tr>
<tr>
<td>3.1.4 Block listing as table</td>
<td>52</td>
</tr>
<tr>
<td>3.1.5 Blocks with user-specific adaptations</td>
<td>55</td>
</tr>
<tr>
<td>3.1.6 Assignment overview</td>
<td>56</td>
</tr>
<tr>
<td>3.1.7 Generating blocks at runtime on the NCU</td>
<td>58</td>
</tr>
<tr>
<td>3.2 Opening the PLC basic program system library</td>
<td>59</td>
</tr>
<tr>
<td>3.3 Adding the PLC basic program</td>
<td>60</td>
</tr>
<tr>
<td>3.4 Conflicts when copying blocks</td>
<td>63</td>
</tr>
<tr>
<td>3.5 Correcting OB1</td>
<td>64</td>
</tr>
</tbody>
</table>
# Table of contents

## 3 Configuring networks

3.6 Upgrading the PLC basic program ................................................................. 65
3.7 Copying blocks from one project into another ................................................ 67
3.8 Use and handling of groups ........................................................................... 69
3.9 Create blocks from external sources ............................................................... 70
3.10 Exporting PLC symbols for SINUMERIK Operate ....................................... 72
3.10.1 Creating and loading PLC symbols .......................................................... 72
3.10.2 Exporting PLC symbols .......................................................................... 74
3.10.3 Importing PLC symbols .......................................................................... 76
3.11 Edit blocks ..................................................................................................... 77

## 4 Configuring telegrams and drive units

4.1 Configuring an Ethernet Interface ................................................................. 79
4.2 Configuring PROFIBUS DP .......................................................................... 80
4.3 Configuring Integrated PROFIBUS (DP Integrated) ..................................... 82
4.4 Configuring PROFINET .................................................................................. 83
4.5 Configuring PROFINET IO with IRT ............................................................. 84
4.5.1 Overview .................................................................................................... 84
4.5.2 Rules and requirements ............................................................................ 84
4.5.3 Isochronous-capable modules identification .............................................. 86
4.5.4 Configuring isochronous NC-controlled drives ......................................... 88
4.5.5 Configuring I/O used by NC isochronously .............................................. 89
4.5.6 Configuring the NCU ............................................................................... 90
4.5.7 Configuring PROFINET IO IRT devices .................................................. 92
4.5.8 Configuring IO modules or drive telegrams ............................................. 94
4.5.9 Configuring the input delay for digital input modules ................................ 96
4.5.10 Configuring sync domains ...................................................................... 97
4.5.11 Match values between PROFINET IO and PROFIBUS Integrated ............ 99
4.5.12 Assigning drive addresses to the NCU machine data .............................. 99
4.5.13 Assigning I/O addresses to the NCU machine data .................................. 100

## 5 Configuring telegrams and drive units

5.1 Overview ....................................................................................................... 103
5.2 Standard telegram configuration ................................................................. 104
5.3 Viewing I/O addresses in the TIA Portal ...................................................... 105
5.4 Changing the addressing schematic ............................................................. 107
5.5 Resetting telegrams ...................................................................................... 109
5.6 Displaying or adapting the telegram configuration ........................................ 110
5.6.1 Overview ................................................................................................ 110
5.6.2 Calling the telegram configuration ......................................................... 111
5.6.3 Structure of the “Telegram configuration” dialog ..................................... 112
5.6.4 Changing the properties of send telegrams (actual value) ....................... 113
5.6.5 Changing the properties of receive telegrams (setpoint) ......................... 116
5.6.6 Adapting the number of drives ............................................................... 119
5.7 Available telegram types ............................................................................. 120
5.7.1 Telegrams for the transfer of standard data (PROFIdrive) ....................... 120
Table of contents

5.7.2 Telegrams in SINUMERIK Safety Integrated (SPL) mode .......................................................... 121
5.7.3 Telegrams for PROFiSafe communication .............................................................................. 122
5.7.4 Telegrams for SIC/SCC communication .................................................................................. 123
5.8 Adapting I/O start addresses .................................................................................................... 124
5.8.1 Introduction ........................................................................................................................... 124
5.8.2 PROFIdrive telegrams for standard data .............................................................................. 126
5.8.3 PROFIdrive telegrams for Safety Integrated (SPL) .............................................................. 128
5.8.4 PROFiSafe/PROFIdrive telegrams for Safety Integrated plus (F-PLC) ............................... 130
5.9 Deviations from the standard I/O addressing schematic ......................................................... 134
5.9.1 Overview ............................................................................................................................... 134
5.9.2 Matching of deviating I/O addresses .................................................................................... 135
5.9.2.1 Matching I/O addresses for use of the optimized I/O addressing schematic ....................... 135
5.9.2.2 Matching user-specific adaptations .................................................................................... 136
5.9.3 Viewing messages in the info area ....................................................................................... 136
5.9.4 Availability of suitable I/O addresses .................................................................................... 138

6 Configuring I/O ........................................................................................................................... 139
6.1 Inserting ADI4 module (840 sl) ............................................................................................. 139
6.2 Installing general station description files for SINUMERIK I/O ............................................. 142
6.3 Inserting the SINUMERIK I/O module PP72/48 ................................................................. 144
6.4 Inserting SINUMERIK MCP/MPP .......................................................................................... 146

7 Tag selection with NC VAR selector ...................................................................................... 149
7.1 NC VAR selector ................................................................................................................... 149
7.2 Selecting tags and saving as STL file ..................................................................................... 150
7.3 Adding a tag file (STL) in the TIA Portal .............................................................................. 152

8 Importing user alarms .............................................................................................................. 153
8.1 Overview ............................................................................................................................... 153
8.2 Exporting TS files from SINUMERIK Operate ...................................................................... 154
8.3 Language assignment in language-dependent texts .................................................................. 155
8.4 Enable project languages ...................................................................................................... 157
8.5 Importing SINUMERIK PLC alarm texts ............................................................................. 158

9 Safety configuration .................................................................................................................. 161
9.1 Introduction ........................................................................................................................... 161
9.2 Representation of safety-related resources in the TIA Portal ................................................. 162
9.3 Changing the Safety Integrated mode .................................................................................... 164
9.4 Parameterization of relevant properties ................................................................................ 167
9.5 Availability of I/O addresses at the mode change ................................................................. 171
9.6 Licensing ............................................................................................................................... 174
9.6.1 Overview ........................................................................................................................... 174
9.6.2 Software options for Safety Integrated (SPL) ..................................................................... 175
9.6.3 Software options for Safety Integrated plus (F-PLC) .......................................................... 176
Table of contents

9.7 Configuring Safety Integrated (SPL) ................................................................. 177
   9.7.1 Introduction .................................................................................................. 177
   9.7.2 Configuring the F-peripherals ................................................................. 178
   9.7.3 Parameterizing F-input modules ............................................................. 180
   9.7.4 Configuring drives with F-functions ..................................................... 181
   9.7.5 Parameterizing F-output modules .......................................................... 183
   9.7.6 Configuration of the PROFIsafe addresses (peripherals) ...................... 184
   9.7.7 Configuration of the PROFIsafe addresses (drives) .............................. 188
   9.7.8 Parameterizing PROFIsafe telegrams .................................................... 191

9.8 Configuring Safety Integrated plus (F-PLC) ............................................... 192
   9.8.1 Introduction .............................................................................................. 192
   9.8.2 Configuring Safety Integrated plus (F-PLC) ......................................... 194
   9.8.3 Creating a second F-runtime group for Safety Integrated plus (F-PLC) ........................................................................................................... 196
   9.8.4 Configuring PROFIsafe ........................................................................... 198
   9.8.5 Checking the PROFIsafe address ............................................................ 200

Index ......................................................................................................................... 203
Product information

1.1 Validity of the description

These notes take precedence over statements in other documents.

Please read the notes carefully since important information for installation and use of the software is included for you.

Notes that were no longer able to be taken into account in the online help can be found under Limitations for use (Page 15).
1.2 Product features

SINUMERIK STEP 7 Toolbox V14 SP1 is an option package for SIMATIC STEP 7 Professional V14 SP1 (TIA Portal) with additional setup.

Functional scope

SINUMERIK STEP 7 Toolbox V14 SP1 contains the following tools and functions:

- Supplementation of the hardware catalog with the following modules of the SINUMERIK 840D sl (as of firmware V4.5 SP2 or higher):
  - NCU 710.3
  - NCU 720.3
  - NCU 730.3
  - NX10.3
  - NX15.3
- Supplement of the hardware catalog to include the ADI4 module
- SINUMERIK basic PLC program
  The TIA Portal Toolbox automatically installs the basic PLC program as the system library "SINUMERIK 840D sl PLC Basic Program". Matching the firmware versions of the modules, there are different versions of the PLC basic program:
  - SINUMERIK 840D sl PLC basic program V4.5.x.x
  - SINUMERIK 840D sl PLC basic program V4.7.x.x
  - SINUMERIK 840D sl PLC basic program V4.8.x.x
- Export of PLC symbols for SINUMERIK Operate
- Importing SINUMERIK user alarm texts
- Creating SINUMERIK PLC archives
- Support of PROFINET IO IRT for NCK
- Support of SINUMERIK Safety Integrated and Safety Integrated plus
- NC VAR selector (external tool)
1.3 Installation notes

Software requirements

SINUMERIK STEP 7 Toolbox V14 SP1 is a TIA Portal options package, which requires the following products to be installed:

- SIMATIC STEP 7 Professional V14 SP1

To use the SINUMERIK Safety Integrated plus safety concept, you also need the following TIA Portal options package:

- SIMATIC Safety V14 SP1

Hardware requirements and other system requirements

All of the hardware and system requirements of SIMATIC STEP 7 Professional V14 SP1 and, if applicable, SIMATIC Safety V14 SP1.

You can find the system requirements of STEP 7 Professional in the following documentation:

- STEP 7 Professional V14 SP1 System Manual
  [link](https://support.industry.siemens.com/cs/products?search=Systemhandbuch%20STEP%207%20Professional%20V14&dtp=Manual)

- TIA Portal online help, search term "System requirements STEP 7 Professional"

Installation

Before installing, exit all of the applications (e.g. TIA Portal) and execute the "Start.exe" setup file in the master directory of the product DVD.

Uninstallation

Via the installation wizard of the TIA Portal, you can uninstall the software, which is entered in the Windows dialog "Uninstall or change program":

"Control Panel > Programs > Uninstall Program > Siemens Totally Integrated Automation Portal V14 SP1"

Note

NC VAR selector must be uninstalled separately.
1.3 Installation notes
1.4 Limitations for use

According to the state of the art, it can admittedly not be excluded - given the complexity of the software products - that sporadic functional restrictions can occur under the greatly differing system and application conditions.

In this context, please observe the current boundary conditions, functional restrictions and workarounds, which you can find in a separate document on the product DVD:

<Product DVD>/Documents/Readme/English/supplementary_conditions_toolbox_V14_SP1_en.pdf
Configuring the NCU

2.1 SINUMERIK NCU

2.1.1 Structure of SINUMERIK NCU

Subcomponents of the NCU

A SINUMERIK NCU always comprises the following integrated subcomponents:
- PLC
- NCK
- CP
- HMI (SINUMERIK Operate)
- SINAMICS Integrated (DRIVE)

These subcomponents are also automatically created when you insert the NCU.

Additional connectable components

Optionally, the following components can be connected to the NCU:
- NX10.3 and NX15.3 modules

These components are not inserted automatically when inserting an NCU, but must be integrated manually (Page 21).

2.1.2 Insert NCU

Procedure

In order to insert a SINUMERIK NCU via the portal view into the project, proceed as follows:
1. Go to the portal view and select "Devices and Networks".
2. Click "Add new device".
3. Click the "Controller" button.
4. Under "Controller > SINUMERIK 840D sl > NCU", select an NCU (in this example, the "NCU 730.3 PN").
5. Select the firmware version of the configured NCU in the "Version" drop-down list.

**Note**

**Selecting the firmware version**

Note the following information concerning the firmware version:

- **Firmware versions of the configured hardware and the real hardware**
  
  Select the firmware version of the configured NCU appropriate for the envisaged firmware version of the real NCU so that the appropriate tests occur in the TIA Portal. For a version change of the real NCU, you can adapt the version in the TIA Portal with a device replacement (Page 25).

- **Select the firmware version in the project view**
  
  If you insert a device via the hardware catalog of the project view, set the firmware version in the "Information" area.

**Note**

**Safety Integrated plus (F-PLC): Different I/O addresses for telegram 701 in NCU V4.7 (TIA Portal) ad NCU ≥ V4.7 SP2 (machine data)**

If you configure an NCU V4.7 (TIA Portal) but the firmware V4.7 SP2 (or higher) is used in the actual hardware, the preset I/O addresses from the Siemens telegram 701 in the TIA Portal do not match those in the machine data (MD10393).

- To establish compatibility with NCU firmware ≥ V4.7 SP2, you can adapt the I/O addresses in the configuration.
  
  See: Calling the dialog "Cyclic data traffic", Viewing I/O addresses in the TIA Portal, PROFIsafe/PROFIdrive telegrams for Safety Integrated plus (F-PLC)

- Alternatively, you can adapt the I/O addresses in the machine data. In this case, your telegram configuration is considered as user-defined telegram configuration.
  
  See also: Synchronizing user-specific adaptations, PROFIsafe/PROFIdrive telegrams for Safety Integrated plus (F-PLC)

6. Click "Add".
Result

The SINUMERIK NCU is created as new device.

Note

Copying and pasting the NCU or the DP master system

You can also copy and insert NCUs within a project. For this purpose, switch to the network view or to the topology view of the project view.

The DP master system (PROFIBUS Integrated) cannot be individually copied, pasted or deleted. It is considered as an integral part of the NCU.

If you copy an NCU, all integrated subcomponents are also copied, e.g. SINAMICS Integrated or PROFIBUS Integrated.
2.2 Insert NX module

Procedure

In order to insert an NX module into the project via the hardware catalog, proceed as follows:

1. In the network view, navigate in the hardware catalog to the folder "Controller > SINUMERIK 840D sl > NX" and select, for example, NX15.3.

2. You can select the firmware version of the NX module at "Information" in the hardware catalog. This must match the firmware version of the NCU. Firmware versions of the configured hardware and the real hardware must match.

3. Use drag-and-drop to move the NX module from the hardware catalog to the network view.
4. To connect the NX module with a master system, click "Not assigned" and select the master system.

**Note**

**Connection to DP Integrated**

Note that the NX modules can only be connected to the DP Integrated of a SINUMERIK NCU, and not to external PROFIBUS interfaces!

The NX is connected with the NCU and the "Wiring between control and NX" dialog opens.

5. In the "Wiring between control and NX" dialog, select the DP address of the NX in the master system that matches your real wiring. The DP addresses of the NX modules are permanently assigned to the DRIVE-CLiQ sockets of the NCU.

<table>
<thead>
<tr>
<th>DP address of the NX in the master system</th>
<th>DRIVE-CLiQ socket on the NCU</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>X100</td>
</tr>
<tr>
<td>11</td>
<td>X101</td>
</tr>
<tr>
<td>12</td>
<td>X102</td>
</tr>
<tr>
<td>13</td>
<td>X103</td>
</tr>
<tr>
<td>14</td>
<td>X104</td>
</tr>
<tr>
<td>15</td>
<td>X105</td>
</tr>
</tbody>
</table>
2.2 Insert NX module

**Note**

**This setting cannot be undone**

Please note that once set, the DP address of an NX cannot be subsequently changed. The NX modules must be connected to the DRIVE-CLiQ socket of the NCU in the real wiring that corresponds to the permanently assigned DP address.

If you have incorrectly set the DP address of an NX, delete this NX from the project and add a new one.

The DP address of the NX module is specified in accordance with your setting and the appropriate I/O addresses of the telegrams are set automatically.

**Note**

**Default I/O addresses of the telegrams**

Depending on the set DP address, the appropriate I/O addresses of the telegrams are set automatically.

Change this setting only when the I/O addresses of your telegrams differ from the default setting!

You can also find information on the wiring between NCU and NX in the properties of the DP Integrated interface on the NCU and NX under "PROFIBUS address".

**Result**

The NX module has been inserted into the project and connected to an NCU.
2.2 Insert NX module

Note

Handling the NX

- If NX modules were connected with the NCU and the NCU is subsequently deleted, the NX modules are kept in the project as unconnected slave modules. They can be subsequently assigned to another NCU. The parameter settings of the NX modules are retained.

- If the DP address of the NX is specified, then the I/O addresses matching the default setting on the NCK side are entered.
2.3 Replacing a device or upgrading firmware

2.3.1 Replacing the NCU

You can replace different NCUs. By replacing a device, you can change to another NCU with a different expansion stage, with a different firmware version and other properties.

Rules for replacing an NCU

- It is not possible to replace an NCU with an NCU of the same project stage with the same or previous firmware version.
- If you replace an NCU by another NCU, then automatically all of the integrated subcomponents of the NCU (SINAMICS Integrated, PLC, NCK, CP, HMI) are also replaced.
- If you have connected NX modules to an NCU and replace the NCU, the connection between the devices remains, provided the used interfaces exist on both NCUs. If the used interface on the replaced NCU does not exist, the connection will be separated.

2.3.2 Replacing an NX

You can replace a device with a different NX type. The version of an NX is determined by the version of the NCU. Correspondingly, for a connected NX, you can only replace the type: An NX10.3 can be replaced by an NX15.3 and vice versa.

Rules for replacing an NX

If you replace NX10.3 with NX15.3, please note that NX10.3 only supports a maximum of three servo axes, whereas NX15.3 supports up to six servo axes.

For more information about the configuration of the drive objects, see Adapting the number of drives (Page 119)
2.3.3 Basic procedure

Note
Changing the firmware version of the configured NCU or NX

The firmware version of the configured hardware and the real hardware must match. Otherwise it is possible that you configure version-dependent non-detectable properties in the TIA Portal that the real hardware does not support.

To replace the firmware version for a group (NCU with NX), the replacement on the NCU must be initiated. Interconnected NXs are then also replaced automatically.

Procedure

To replace a device, proceed as follows:

1. Switch to the device view.
2. Select the device that you want to replace in the "<Select device>" drop-down list.
3. Right-click the device and then select "Replace device" in the shortcut menu. The "Replace device" dialog opens.
4. Select the new device in the folder structure.

5. Select the required firmware version in the "Version" drop-down list.

---

**Note**

*Solving compatibility problems*

If the two devices are not compatible or only have restricted compatibility, you can find further information in Section "Compatibility information". If required, click "Cancel" and correct the problems before continuing.

---

6. Confirm the dialog with "OK".

**Result**

The device has been replaced.

If you uploaded the firmware version, your telegram configuration was retained. Note that the default telegram I/O addresses of telegram 701 have changed as of V4.7 SP2.

See also: Telegram configuration and I/O addressing schematics, Resetting telegrams

**Further information**

Further information on device replacement can be found in the information system of the TIA Portal, keyword "Replacing".
2.4 Setting up the communication

Procedure

To establish a communication connection between two devices, proceed as follows:

1. In the "Online" menu, select the "Accessible devices" command.
2. In the drop-down lists "Type of PG/PC interface" and "PG/PC interface", search for the interface used.

If no devices are accessible at an interface, the connecting line between the PG/PC and the device is interrupted. If devices are accessible, the connecting line is shown and the devices accessible at the selected interface of the PG/PC are displayed in a list.
3. If you have connected a new device in the meantime, click the "Refresh" button to refresh the list of accessible devices.

4. Using "Display", transfer to the project navigator the device that has been found in the "Online accesses" folder.

   The subfolder of the interface to which the selected device is connected is selected in the project tree.

**Note**

**Several identical devices**

If several identical devices can be accessed from the PG, by clicking on the "Flash LED" button you can then display which device corresponds to the entry in the list of accessible devices.
2.5 Loading and closing the hardware configuration in the PLC

Requirement

Note
General reset before loading into a PLC with Safety Integrated plus (F-PLC)
If the actual hardware has been operated in Safety Integrated plus (F-PLC) mode and you now want to load a configured hardware configuration with changed Safety Integrated mode, you must perform a general reset of the PLC prior to the loading.

Procedure

Proceed as follows to load the configured hardware configuration into the PLC:

1. In the project tree, right-click "CNC_1" and select the "Hardware (changes only)" command in the "Compile" shortcut menu.
   The consistency of the hardware configuration is tested in the compilation process.
   Correct any errors that may occur before proceeding.

Note
Compilation
In the compilation process, all integrated subcomponents of the NCU (PLC, NCK, CP, HMI, SINAMICS Integrated) are also compiled. In addition, all optional components connected to the NCU (e.g. NX, ADI4) are also compiled.
2. To download the compiled configuration to the PLC, right-click "CNC_1" and select the "Hardware configuration" command in the "Download to device" shortcut menu. The "Extended download" dialog opens.

![Figure 2-1 "Extended download" dialog: The configured access nodes of the PLC are displayed in the upper area.](image)

3. Select the required module from "Compatible nodes in the target subnet". Alternatively, you can specify an IP address directly in the "Compatible nodes in the target subnet" list in the "Address" column.
4. Confirm the download with "Load". The "Download preview" dialog opens.

Figure 2-2 "Download preview" dialog

---

**Note**

**Consistency check**

Before the loading, the consistency of the download is checked. This means that a check is made as to whether the parameterized hardware of the TIA Portal project matches the hardware that has been actually installed.

---

**Note**

**Adapt the IP address?**

If the IP address of your PG/PC is located in a different subnet than the PLC, a dialog box is displayed as to whether the IP address in the PG/PC should be adapted.

5. In the "Download preview" dialog, check the settings and click "Load" to confirm the input.

---

**Result**

The PLC is stopped and the hardware configuring is loaded into the PLC. The "Results of the loading action" dialog opens and displays the status of the loading action. The dialog restarts the PLC after completion, provided the "Start" checkbox has not been deactivated.
2.6 Creating SINUMERIK PLC archives

2.6.1 Creating a SINUMERIK PLC archive

Introduction

Unlike TIA Portal project archives (*.zap13), SINUMERIK PLC archives (*.arc) contain precompiled commissioning data that you can import directly to the NCU (e.g. with SINUMERIK Operate).

A SINUMERIK archive offers the following possibilities:

- Direct image of the data of a PLC taken into operation in a file
- Simplification of the series commissioning
- Commissioning of the PLC with the SINUMERIK archive directly on the NCU without using a PG/PC, TIA Portal or STEP 7
- Transfer of the data to the NCU without establishing an online connection to the actual hardware

SINUMERIK archives (*.arc) have nothing in common with TIA Portal project archives (*.zap13). TIA Portal project archives are compressed files, each of which contains a complete project, including the complete folder structure of the project. (See: Information system, keyword "TIA Portal project archive").

You can create a PLC archive with the SINUMERIK Toolbox and load it to the NCU (e.g. with SINUMERIK Operate) in order to simplify the actual commissioning.

You can create the following SINUMERIK archives:

<table>
<thead>
<tr>
<th>Archive type</th>
<th>Command in the TIA Portal</th>
<th>Data included</th>
</tr>
</thead>
<tbody>
<tr>
<td>PLC hardware upgrade archive</td>
<td>Only hardware...</td>
<td>• Hardware data (SDB) of the PLC</td>
</tr>
<tr>
<td>(Page 38)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PLC commissioning archive</td>
<td>Hardware and all program</td>
<td>• Hardware data (SDB) of the PLC</td>
</tr>
<tr>
<td>(Page 39)</td>
<td>blocks...</td>
<td>• Program blocks of the PLC</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Hardware data (SDB) of the CP</td>
</tr>
<tr>
<td>PLC reload archive</td>
<td>Selected program blocks...</td>
<td>• Program blocks of the PLC</td>
</tr>
<tr>
<td>(Page 41)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Note

Editing SINUMERIK archives (.arc)

After you have created a SINUMERIK archive, you can open and edit it with various tools. See: External tools for SINUMERIK archives (Page 37)

Note

Handling of F-blocks for SINUMERIK archives

Because F-blocks must always be saved together with the associated hardware configuration, F-blocks cannot be saved in reload archives.

Further information

- General information on series commissioning archives can be found in Section "Saving and managing data" of the "SINUMERIK 840D sl, SINAMICS S120 Commissioning CNC:NCK, PLC, Drive for TIA" Commissioning Manual.

- Information about the differences of the archives that were created with STEP 7 V5.x is available at "Handling SINUMERIK archives".
Overview

You can create SINUMERIK archives in various ways:

- In the menu bar at "Tools"
- In the shortcut menu of the NCU or PLC:

Figure 2-3 Creating a SINUMERIK archive
2.6 Creating SINUMERIK PLC archives

2.6.2 Available SINUMERIK archive types

There are different types of archives which you can create in different ways. Essentially, you cannot use the TIA Portal to create archives that contain NC, drive or HMI data. However, you can save a finely granular selection of translated program blocks as an archive in the TIA Portal with the "PLC reload archive".

<table>
<thead>
<tr>
<th>Archive type</th>
<th>Command in the TIA Portal</th>
<th>Command in SINUMERIK Operate</th>
<th>Data contained</th>
</tr>
</thead>
<tbody>
<tr>
<td>NCU commissioning archive</td>
<td>-</td>
<td>Softkey &quot;Commissioning archive&quot;, option button &quot;Create commissioning archive&quot;</td>
<td>The contained data can be configured as follows in the dialog:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• NC data</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• With or without compensation data</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• With or without compile cycles</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• PLC data (all or none)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Drive data (ACX format or ASCII format)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• HMI data (all HMI data or a configurable selection)</td>
</tr>
<tr>
<td>PLC commissioning archive (Page 39)</td>
<td>Hardware and all program blocks...</td>
<td>Softkey &quot;Commissioning archive&quot;, option button &quot;Create commissioning archive&quot;</td>
<td>• Hardware data (SDB) of the PLC</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Program blocks of the PLC</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Hardware data (SDB) of the CP</td>
</tr>
<tr>
<td>PLC hardware upgrade archive (Page 38)</td>
<td>Only hardware...</td>
<td>Softkey &quot;Commissioning archive&quot;, option button &quot;Create PLC hardware upgrade archive (only SDBs)&quot;</td>
<td>• Hardware data (SDB) of the PLC</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Hardware data (SDB) of the CP</td>
</tr>
<tr>
<td>PLC reload archive (Page 41)</td>
<td>Selected program blocks...</td>
<td>-</td>
<td>• Program blocks of the PLC (configurable in the dialog)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Complete archive</td>
<td>-</td>
<td>&lt;Ctrl&gt; + &lt;Alt&gt; + S</td>
<td>All data (not configurable)</td>
</tr>
<tr>
<td>Original status archive</td>
<td>-</td>
<td>Softkey &quot;Commissioning archive&quot;, option button &quot;Create archive original status&quot;</td>
<td>Original status (factory setting) of all subcomponents or a selection of specific subcomponents and data (configurable in the dialog)</td>
</tr>
</tbody>
</table>
Note
Distinguishing between TIA Portal project archives and SINUMERIK archives
SINUMERIK archives (*.zap14) have nothing in common with TIA Portal project archives (*.arc):
• SINUMERIK archives contain precompiled commissioning data that you can import directly to the NCU.
• TIA Portal project archives are compressed files, each of which contains a complete project, including the complete folder structure of the project.
See: TIA Portal online help, search term "TIA Portal project archive".

2.6.3 External tools for SINUMERIK archives

Overview
Various tools are available to open and edit the created SINUMERIK archives:

<table>
<thead>
<tr>
<th>Tool</th>
<th>Purpose</th>
<th>Available from</th>
</tr>
</thead>
<tbody>
<tr>
<td>SinuCom ARC</td>
<td>Editing of SINUMERIK archives</td>
<td>SinuCom commissioning/service tools in the SIEMENS Industry Mall</td>
</tr>
<tr>
<td>Create MyConfig</td>
<td>Extensive software, including functions such as:</td>
<td>Create MyConfig in the SIEMENS Industry Mall</td>
</tr>
<tr>
<td></td>
<td>• Data comparison of SINUMERIK archives</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Manipulation of SINAMICS data in drive archives</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Creation of a SINAMICS archive with defined topology</td>
<td></td>
</tr>
</tbody>
</table>
2.6 Creating SINUMERIK PLC archives

2.6.4 Creating a PLC hardware upgrade archive

Requirement

- The data carrier to be used or storage location is available and has sufficient storage space.

Procedure

To create a hardware upgrade archive, proceed as follows:

1. In the project tree, right-click the device name, e.g. "CNC_1", and select "Create SINUMERIK archive > Hardware only" in the shortcut menu. The "Create SINUMERIK archive" dialog opens.

![Create SINUMERIK archive dialog with hardware](image)

Figure 2-4 "Create SINUMERIK archive" dialog with hardware

2. Make the required settings:

<table>
<thead>
<tr>
<th>Element</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>File name</td>
<td>Enter the desired file name of the SINUMERIK archive in the text field.</td>
</tr>
<tr>
<td></td>
<td><strong>File extensions cannot be changed</strong></td>
</tr>
<tr>
<td></td>
<td>The file extension (.arc) is not displayed and cannot be changed.</td>
</tr>
<tr>
<td>Path</td>
<td>Click Browse and select a directory, or enter the directory directly.</td>
</tr>
<tr>
<td></td>
<td><strong>Default storage location for data export</strong></td>
</tr>
<tr>
<td></td>
<td>The used path is shown as the default setting the next time you export an archive. To specify the default setting for the data export in the settings, switch to &quot;General &gt; General &gt; Data exchange &gt; Storage location for data export&quot; in the settings.</td>
</tr>
<tr>
<td>Author</td>
<td>Name of the author or a person responsible for the project. The default setting corresponds to the setting of the user name in the TIA Portal under: &quot;Extras &gt; Settings &gt; General &gt; General settings &gt; User name&quot;.</td>
</tr>
</tbody>
</table>
### 2.6 Creating SINUMERIK PLC archives

#### 2.6.5 Creating a PLC commissioning archive

**Requirement**

- If possible, the "Program blocks" folder should not contain any program blocks of not activated axes/spindles or the tool management.
  
  You can also save unused program blocks in the archive, although this extends the time required for creating and loading the archive.

- The data carrier to be used or storage location is available and has sufficient storage space.

**Note**

**Handling of F-blocks for SINUMERIK archives**

The handling of F-blocks depends on the used Safety Integrated mode:

- If Safety Integrated is inactive or Safety Integrated (SPL) is active, F-blocks are not stored in the SINUMERIK archive.

- In Safety Integrated plus (F-PLC) mode, F-blocks are saved in PLC commissioning archives.

Note the additional information in the Readme file for SINUMERIK Toolbox: "Start > Siemens Automation > Documentation > Readmes > German".

---

<table>
<thead>
<tr>
<th>Element</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comment</td>
<td>Input of a comment for the SINUMERIK archive.</td>
</tr>
<tr>
<td></td>
<td>As default setting, the comment field contains an entry whether the archive contains only hardware or hardware and all program blocks.</td>
</tr>
</tbody>
</table>

3. Click "Create archive" to confirm your input.

**Result**

The SINUMERIK archive is created and stored in the path that you have specified.
### Procedure

To create a PLC commissioning archive, proceed as follows:

1. In the project tree, right-click the device name, e.g. "CNC_1", and select "Create SINUMERIK archive > Hardware and all program blocks" in the shortcut menu. The "Create SINUMERIK archive" dialog opens.

![Create SINUMERIK archive dialog](image)

**Figure 2-5** "Create SINUMERIK archive" dialog with hardware data and program blocks

2. Make the required settings:

<table>
<thead>
<tr>
<th>Element</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>File name</td>
<td>Enter the desired file name of the SINUMERIK archive in the text field.</td>
</tr>
<tr>
<td></td>
<td><strong>File extensions cannot be changed</strong></td>
</tr>
<tr>
<td></td>
<td>The file extension (.arc) is not displayed and cannot be changed.</td>
</tr>
<tr>
<td>Path</td>
<td>Click Browse and select a directory, or enter the directory directly.</td>
</tr>
<tr>
<td></td>
<td><strong>Default storage location for data export</strong></td>
</tr>
<tr>
<td></td>
<td>The used path is shown as the default setting the next time you export an archive. To specify the default setting for the data export in the settings, switch to &quot;General &gt; General &gt; Data exchange &gt; Storage location for data export&quot; in the settings.</td>
</tr>
<tr>
<td>Author</td>
<td>Name of the author or a person responsible for the project.</td>
</tr>
<tr>
<td></td>
<td>The default setting corresponds to the setting of the user name in the TIA Portal under: &quot;Extras &gt; Settings &gt; General &gt; General settings &gt; User name&quot;.</td>
</tr>
<tr>
<td>Comment</td>
<td>Input of a comment for the SINUMERIK archive.</td>
</tr>
<tr>
<td></td>
<td>As default setting, the comment field contains an entry whether the archive contains only hardware or hardware and all program blocks.</td>
</tr>
</tbody>
</table>

3. Click "Create archive" to confirm your input.

### Result

The SINUMERIK archive is created and stored in the path that you have specified.
2.6 Creating SINUMERIK PLC archives

2.6.6 Creating a PLC reload archive

You can save the program blocks of the PLC as reload archive in the TIA Portal.

---

**Note**

**F-blocks are not saved in reload archives**

The F-blocks used in the SINUMERIK Safety Integrated plus (F-PLC) mode are not saved in reload archives.

If you want to save F-blocks in a SINUMERIK archive, you can save them together with the associated hardware configuration in a PLC commissioning archive.

---

**Note**

**In the PLC reload archive, existing data blocks overwrite any CPU DBs during reading in**

If you import into a PLC reload archive a CPU DBs that already exists on the control system, the CPU DBs on the control system will always be overwritten. Therefore the option "Overwrite existing blocks with identical number on the PLC for import" does not affect CPU-DB.

Therefore, do not store data blocks that already exist on the NCU as CPU DB in the PLC reload archive.

If you have already overwritten CPU DBs, you can find further information in the information system, keyword "Inconsistency in data blocks".

---

**Requirement**

- If possible, the "Program blocks" folder should not contain any program blocks of not activated axes/spindles or the tool management. Although you can save unused program blocks in the archive, this extends the time required for creating and loading the archive.

- The data carrier to be used or storage location is available and has sufficient storage space.

**Procedure**

To create a reload archive, proceed as follows:

1. You have several ways of selecting the program blocks to be archived:
   - Select the desired program blocks in the project tree or in the project tree overview. Then right-click one of the selected program blocks. You can change the actual program blocks to be exported later in the "Create SINUMERIK archive" dialog.
   - Right-click the program blocks folder of the PLC or a higher-level folder. You can select the program blocks to be exported later in the "Create SINUMERIK archive" dialog.
2. Click "Selected program blocks" in the "Create SINUMERIK archive" in the shortcut menu.
The "Create SINUMERIK archive" dialog opens.

Figure 2-6 "Create SINUMERIK archive" dialog with expanded "Block selection" section
3. Make the required settings:

<table>
<thead>
<tr>
<th>Element</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Block selection</td>
<td>In the &quot;Block selection&quot; section, you can check your selection or select the program blocks to be saved. If you have organized program blocks as groups, they are displayed as an expandable folder in the block selection.</td>
</tr>
<tr>
<td>File name</td>
<td>Enter the desired file name of the SINUMERIK archive in the text field. <strong>File extensions cannot be changed</strong> The file extension (.arc) is not displayed and cannot be changed.</td>
</tr>
<tr>
<td>Path</td>
<td>Click Browse and select a directory, or enter the directory directly. <strong>Default storage location for data export</strong> The used path is shown as the default setting the next time you export an archive. To specify the default setting for the data export in the settings, switch to &quot;General &gt; General &gt; Data exchange &gt; Storage location for data export&quot; in the settings.</td>
</tr>
<tr>
<td>Author</td>
<td>Name of the author or a person responsible for the project. The default setting corresponds to the setting of the user name in the TIA Portal under: &quot;Extras &gt; Settings &gt; General &gt; General settings &gt; User name&quot;.</td>
</tr>
<tr>
<td>Comment</td>
<td>Input of a comment for the SINUMERIK archive. If the &quot;Insert selected blocks as comment&quot; checkbox is activated, all contained program blocks are entered automatically with symbolic name and block number.</td>
</tr>
<tr>
<td>Overwrite existing blocks with identical number on the PLC for import</td>
<td>If the checkbox is activated, existing program blocks with the same block number will be replaced on the NCU during the import of the archive. If the checkbox is deactivated, any program blocks of the archive with the same block number will not be imported.</td>
</tr>
<tr>
<td>Restart the PLC after import of the new program blocks</td>
<td>If the checkbox is activated, the PLC will be restarted automatically after importing the archive. You can also deactivate the checkbox and, for example, make other installation or commissioning work before you manually restart the PLC or the complete NCU.</td>
</tr>
</tbody>
</table>

4. Click "Create archive" to confirm your input.

**Result**

The SINUMERIK archive is created and stored in the path that you have specified.
2.6 Creating SINUMERIK PLC archives
Programming the PLC

3.1 General information about the PLC program

3.1.1 Introduction

The PLC program is constructed modularly. It comprises the two parts:

- **PLC basic program**

  The PLC basic program organizes the exchange of signals and data between the PLC user program and the NCK, HMI, and machine control panel components. The PLC basic program is part of the SINUMERIK STEP 7 Toolbox V14 SP1.

  Use the appropriate PLC basic program depending on the firmware version of an NCU.
  - SINUMERIK 840D sl PLC basic program V4.5.x.x
  - SINUMERIK 840D sl PLC basic program V4.7.x.x
  - SINUMERIK 840D sl PLC basic program V4.8.x.x

- **PLC user program**

  The PLC user program is the user-specific part of the PLC program by which the PLC basic program has been augmented or extended.

3.1.2 Execution structure

**Overview**

The following organization blocks contain the entry points for the appropriate parts of the PLC basic program (and user program):

- **OB100 [OB100]** (Cold restart)
- **OB1 [OB1]** (Cyclic execution)
- **OB40 [OB40]** (Process interrupt)
- Asynchronous errors
  - **OB82 [OB82]** (Diagnostics alarm)
  - **OB86 [OB86]** (Module failure)

The RUN_UP [FB1] function block is the startup block of the PLC basic program. The call of RUN_UP [FB1] in the OB100 [OB100] must be supplied with data.
The following figure illustrates the structure of the PLC program:

![Structure of the PLC program](image)

Figure 3-1  Structure of the PLC program
3.1 General information about the PLC program

Cyclic operation (OB1)

From a chronological viewpoint, the PLC basic program runs ahead of the PLC user program. The complete processing of the NCK-PLC interface is carried out in cyclic mode. A cyclic monitoring function is activated between PLC and NCK once boot-up and the first OB1 cycle have been completed. A PLC failure produces the "2000 Sign-of-life monitoring PLC" alarm in SINUMERIK Operate.

Start-up behavior of the PLC

The PLC always starts up in RESTART mode, i.e. the PLC operating system runs OB100 after initialization and starts cyclic operation at the beginning of OB1. No return is made to the interruption point (for example, in the event of a power failure).

There are both retentive and non-retentive areas for the markers, timers and counters. The areas are contiguous and are divided by a parameterizable limit, where the area with the higher-value address range is defined as the non-retentive area. Data blocks are always retentive.

RESTART start type (OB100)

If the retentive area has no battery backup (backup battery is empty) start-up is prevented. The following operations are performed during a cold restart:

- UStack, BStack and non-retentive flags, timers and counters are deleted
- The process output image (POI) is deleted
- Process and diagnostics alarms are canceled
- The system status list is updated
- Parameterization objects of modules (from SDB100 onwards) are evaluated or default parameters are output to all modules in single-processor mode
- Cold restart (OB100) is executed
- The process input image (PII) is imported
- The command output inhibit (BASP) is canceled

Further information

The block descriptions and other information about the PLC basic program are contained in the P3 section of the SINUMERIK 840D sl Basic Functions Manual. Basic PLC program.
3.1.3 Using copy templates

Introduction

The "Global libraries" folder of the "Libraries" TaskCard contains the system library of the SINUMERIK PLC program for your device version: "SINUMERIK 840D sl PLC basic program V4.x.x.x".

![Figure 3-2 Master copies of the SINUMERIK PLC program](image)
Under the “Master copies” folder there are four subfolders with different contents. You can copy the contents of these subfolders in their entirety or you can copy the individual objects as needed.

- Using the Ctrl or shift key, you can select several objects of the same type and then copy them.
- If you copy a master copies folder in its entirety (e.g. “840D sl PLC BP”), the folder structure is imported, i.e. new groups (subfolders) are created (Page 69) in your “Program blocks” folder.

Table 3-1 Use and content of the master copies of the PLC basic program

<table>
<thead>
<tr>
<th>Folder</th>
<th>Purpose</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>840D sl PLC Basic Program</td>
<td>This master copy is intended to create a completely new project.</td>
<td>The master copy contains all the blocks that you require for the maximum configuration (31 axes, 10 channels). Use of axis/channel DB If your machine is using fewer axes or channels, you can either copy only the required blocks or you can delete the blocks that are not required in the project tree after copying. If you have blocks in your project that are not required, this increases, for example, the time required for the loading or export of the PLC symbols. Use of ALMSG_DB [DB2] This master copy contains ALMSG_DB [DB2] in the variant ExtendAlMsg=False. The used DB2 variant must match in the startup for parameterization of the RUN_UP [FB1] in OB100 [OB100] (parameter ExtendAlMsg).</td>
</tr>
<tr>
<td>840D sl PLC Basic Program</td>
<td>This master copy is used to upgrade blocks after the firmware version of an NCU is updated, i.e. if you have carried out a device replacement (Page 25) or a migration.</td>
<td>This master copy contains all the know-how-protected blocks that you require for the maximum configuration (31 axes, 10 channels). Blocks to be changed by the user are not included (no organization blocks and not FC12 [FC12], Diagnose [FB29], DB4 [DB4], DB5 [DB5]). Use of axis/channel DB If your machine is using fewer axes or channels, you can either copy only the required blocks or you can delete the blocks that are not required in the project tree after copying. If you have blocks in your project that are not required, this increases, for example, the time required for the loading or export of the PLC symbols. Use of ALMSG_DB [DB2] This master copy contains ALMSG_DB [DB2] in the variant ExtendAlMsg=False. The used DB2 variant must match in the startup for parameterization of the RUN_UP [FB1] in OB100 [OB100] (parameter ExtendAlMsg).</td>
</tr>
</tbody>
</table>
### 3.1 General information about the PLC program

<table>
<thead>
<tr>
<th>Folder</th>
<th>Purpose</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALMSG_DB_ExtendAlMsg</td>
<td>You need this master copy if you use the PLC alarm extension via AL_MSG [FC10] (ExtendAlMsg=True). Otherwise you use the DB2 variant &quot;ExtendAlMsg=False&quot;, which is contained in the two above-named master copies folders.</td>
<td>This master copy contains ALMSG_DB [DB2] in the variant ExtendAlMsg=True (PLC alarm extension via AL_MSG [FC10]). The used DB2 variant must match in the startup for parameterization of the RUN_UP [FB1] in OB100 [OB100] (parameter ExtendAlMsg).</td>
</tr>
</tbody>
</table>
| External source files   | Contains master copies for different external sources (STL). You can copy these sources into the folder "External sources", e.g. under "CNC_1 > PLC_1 > External sources". You edit objects in the "External sources" folder using an external text editor, e.g. Microsoft Editor. See also: Create blocks from external sources (Page 70) | Contains the following master copies, from which you can generate the blocks named below:  
  - bhg_db_awl  
    - strdat [DB<xy>]  
  - diagnose.awl  
    - FB29 [FB29]  
    - DB80 [DB80]  
    - DB81 [DB81]  
    - FC99 [FC99]  
  - gpob840d.awl  
    - OB1 [OB1]  
    - OB100 [OB100]  
    - OB40 [OB40]  
    - OB82 [OB82]  
    - OB86 [OB86]  
  - mdeclist.awl  
    - DB75 [DB75]  

**Note**

**Selecting the appropriate master copy for ALMSG_DB [DB2]**

There are 2 different variants of the block ALMSG_DB [DB2]. The used DB2 variant (ALMSG_DB [DB2]) must match in the startup for parameterization of the RUN_UP [FB1] in OB100 [OB100] (parameter ExtendAlMsg).

- **DB2 variant “ExtendAlMsg=False”**
  
  This variant is contained in the master copies folders "840D sl PLC Basic Program" and "840D sl PLC Basic Program (upgrade)".
  
  If you use the previous procedure (default value of the parameter ExtendAlMsg in RUN_UP [FB1]), you do not need to explicitly copy the "ALMSG_DB_ExtendAlMsg" master copy.

- **DB2 variant “ExtendAlMsg=True”**
  
  This variant is exclusively contained in the separate master copies folder "ALMSG_DB_ExtendAlMsg".
  
  If you use the extension of the PLC alarms via AL_MSG [FC10], you must use the right master copy, i.e. copy it separately into your "Program blocks" folder.

Further information about the extension of the PLC alarms via AL_MSG [FC10] is available under the keyword "ExtendAlMsg" in the Basic Functions Manual, in particular, in the "Extensions of the PLC alarms via block FC 10" section.

**Further information**

- General information on handling libraries in the TIA Portal can be found in the TIA Portal online help, Section "Using libraries".

- The block descriptions and other information about the PLC basic program is contained in the SINUMERIK 840D sl Basic Functions Manual in the P3: Basic PLC program section.
3.1.4 Block listing as table

In the following, you will find a list of all of the blocks of the SINUMERIK PLC basic program that are included in the supplied master copy "840D sl PLC Basic Program".

The master copy "840D sl PLC Basic Program (upgrade)" contains the same blocks, except for blocks with user-specific adaptations.

Further information

- Information about other blocks of the basic program (e.g. blocks generated at runtime on the NCU) or the operational principle of the basic program is contained in the SINUMERIK 840D sl / 828D Basic Functions Manual.
- Information about the changed handling of specific blocks compared with STEP 7 V5.x is available in the "Migrating SINUMERIK projects" help.

Table 3-2 Organization blocks (OB)

<table>
<thead>
<tr>
<th>Address</th>
<th>Name</th>
<th>Description</th>
<th>Called PLC basic program block</th>
</tr>
</thead>
<tbody>
<tr>
<td>OB1</td>
<td>OB1</td>
<td>Cycle OBs are higher-level logic blocks in the program which are cyclically processed and in which you can program instructions or call additional blocks.</td>
<td>GP_HP [FC2]</td>
</tr>
<tr>
<td>OB40</td>
<td>OB40</td>
<td>Hardware interrupt OBs interrupt the cyclic program processing due to a hardware event.</td>
<td>GP_PRAL [FC3]</td>
</tr>
<tr>
<td>OB82</td>
<td>OB82</td>
<td>Diagnostic error interrupt OBs interrupt the cyclic execution of the program if the diagnostic-capable module for which the diagnostic interrupt was enabled detects an error.</td>
<td>GP_DIAG [FC5]</td>
</tr>
<tr>
<td>OB86</td>
<td>OB86</td>
<td>A rack or station failure OB is called, for example, in the event of failure of a rack or station in the distributed I/O.</td>
<td>GP_DIAG [FC5]</td>
</tr>
<tr>
<td>OB100</td>
<td>OB100</td>
<td>Startup OBs are processed once when the mode of the CPU switches from STOP to RUN. After execution of the startup OB, the execution of the cycle OB is started.</td>
<td>RUN_UP [FB1] with gp_par [DB7]</td>
</tr>
</tbody>
</table>
### 3.1 General information about the PLC program

#### Table 3- 3 Function blocks (FBs)

<table>
<thead>
<tr>
<th>Address</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FB1</td>
<td>RUN_UP</td>
<td>The block configures and initializes the basic program, starts synchronization between PLC and NCK, is called in OB100 with instance DB gp_par [DB7].</td>
</tr>
<tr>
<td>FB2</td>
<td>GET</td>
<td>The block is used for reading NC tags.</td>
</tr>
<tr>
<td>FB3</td>
<td>PUT</td>
<td>The block is used for writing NC tags.</td>
</tr>
<tr>
<td>FB4</td>
<td>PI_SERV</td>
<td>The block is used for starting PI services.</td>
</tr>
<tr>
<td>FB5</td>
<td>GETGUD</td>
<td>The block is used for reading global user data (GUD) from the NC and for determining the GUD tag address.</td>
</tr>
<tr>
<td>FB7</td>
<td>PI_SERV2</td>
<td>The block is used for starting PI services that are defined in PI [DB16].</td>
</tr>
<tr>
<td>FB9</td>
<td>M2N</td>
<td>The block is used for switching over operating components (MCP/OP) which are connected with one or several control modules NCU; uses the signals from MMC [DB19].</td>
</tr>
<tr>
<td>FB10</td>
<td>SI_relay</td>
<td>Safety Integrated (SPL) block: Safety relay</td>
</tr>
<tr>
<td>FB11</td>
<td>SI_BrakeTest</td>
<td>Safety Integrated (SPL) block: Brake test</td>
</tr>
<tr>
<td>FB29</td>
<td>Diagnostics</td>
<td>Diagnostic routines for the PLC user program with logging of signal states and signal changes.</td>
</tr>
</tbody>
</table>

#### Table 3- 4 Functions (FCs)

<table>
<thead>
<tr>
<th>Address</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FC2</td>
<td>GP_HP</td>
<td>The block processes the cyclic part of the basic program, is called at the beginning of OB1.</td>
</tr>
<tr>
<td>FC3</td>
<td>GP_PRAL</td>
<td>The block processes the block-synchronous part of the basic program, is called at the beginning of OB40.</td>
</tr>
<tr>
<td>FC5</td>
<td>GP_DIAG</td>
<td>The block is used to record module disruptions and failures, is called at the beginning of the following OBs: OB82, OB83, OB86.</td>
</tr>
<tr>
<td>FC6</td>
<td>TM_TRANS2</td>
<td>The block transfers position and status information of the tools to the tool management interface in connection with Multitool.</td>
</tr>
<tr>
<td>FC7</td>
<td>TM_REV</td>
<td>The block acknowledges an implemented tool change of a turret to the tool management interface.</td>
</tr>
<tr>
<td>FC8</td>
<td>TM_TRANS</td>
<td>The block transfers position and status information of the tools to the tool management interface.</td>
</tr>
<tr>
<td>FC9</td>
<td>ASUB</td>
<td>The block starts asynchronous subprograms, the prerequisite is that it must be selected and parameterized by an NC program or by the PI service ASUP.</td>
</tr>
<tr>
<td>FC10</td>
<td>AL_MSG</td>
<td>The block evaluates the signals entered in DB2, generates incoming and outgoing error and operating messages of the operating software and acknowledges error messages. Optionally, influencing of the block and stop signals can commence.</td>
</tr>
<tr>
<td>FC12</td>
<td>FC12</td>
<td>Call interface for users for auxiliary functions, the block is called on an event-driven basis in the basic program when new auxiliary functions are available.</td>
</tr>
<tr>
<td>FC13</td>
<td>BHGDisp</td>
<td>The block handles the display control for the handheld unit (HHU or HT 2).</td>
</tr>
<tr>
<td>FC17</td>
<td>Ydelta</td>
<td>The block is used for star-delta changeover for digital main spindle drives.</td>
</tr>
<tr>
<td>FC18</td>
<td>SpinCtrl</td>
<td>The block controls axes and spindles from the user program.</td>
</tr>
<tr>
<td>FC19</td>
<td>MCP_IFM</td>
<td>The block is used for transferring data from the machine control panel (MCP milling version) to the NC/PLC interface.</td>
</tr>
<tr>
<td>FC21</td>
<td>Transfer</td>
<td>The block is used for high-speed data exchange between PLC and NCK.</td>
</tr>
</tbody>
</table>
Programming the PLC

3.1 General information about the PLC program

<table>
<thead>
<tr>
<th>Address</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FC22</td>
<td>TM_DIR</td>
<td>The blocks provides the shortest path and direction of motion for positioning a tool magazine or turret (indexing axis).</td>
</tr>
<tr>
<td>FC24</td>
<td>MCP_IFM2</td>
<td>The block is used for transferring data from the machine control panel (MCP milling version compact) to the NC/PLC interface.</td>
</tr>
<tr>
<td>FC25</td>
<td>MCP_IFT</td>
<td>The block is used for transferring data from the machine control panel (MCP turning version) to the NC/PLC interface.</td>
</tr>
<tr>
<td>FC26</td>
<td>HPU_MCP</td>
<td>The block is used for transferring data of the HT 8 to the NC/PLC interface.</td>
</tr>
<tr>
<td>FC1005</td>
<td>FC1005</td>
<td>Block transfers data to Ethernet CP.</td>
</tr>
<tr>
<td>FC1006</td>
<td>FC1006</td>
<td>Block receives data from Ethernet CP.</td>
</tr>
</tbody>
</table>

Table 3-5 Data blocks (DBs)

<table>
<thead>
<tr>
<th>Address</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB2</td>
<td>ALMSG_DB</td>
<td>Interface between user program and AL_MSG [FC10], contains bit arrays for blocking and stop signals as well as fault and status messages. Comment: If you use the DB2 variant &quot;ExtendAlMsg = True&quot;, you must copy it from the separate master copies folder &quot;ALMSG_DB_ExtendAlMsg&quot;. The other folders contain the variant &quot;ExtendAlMsg = False&quot;.</td>
</tr>
<tr>
<td>DB4</td>
<td>DB4</td>
<td>Block contains configuration data for tool management and the parameterization of the alarms for the bit fields in the ALMSG_DB [DB2] as fault or status message for the DB2 variant &quot;ExtendAlMsg = False&quot;.</td>
</tr>
<tr>
<td>DB5</td>
<td>DB5</td>
<td>Interface between user program and AL_MSG [FC10], contains the parameterization of the alarms for the bit fields in the ALMSG_DB [DB2] as fault or status message for the DB2 variant &quot;ExtendAlMsg = True&quot;.</td>
</tr>
<tr>
<td>DB7</td>
<td>gp_par</td>
<td>Instance DB from RUN_UP [FB1]. Contains parameters for configuring operating components and other parameters of the basic program.</td>
</tr>
<tr>
<td>DB8</td>
<td>DB8</td>
<td>DB only for internal use in the basic program.</td>
</tr>
<tr>
<td>DB10</td>
<td>NC</td>
<td>Interface between user program and NC, contains signals from/to the NC, PLC and operating software.</td>
</tr>
<tr>
<td>DB11</td>
<td>Mode group</td>
<td>Interface between user program and mode groups, contains signals from/to the NC, PLC and operating software.</td>
</tr>
<tr>
<td>DB15</td>
<td>DB15</td>
<td>General communication</td>
</tr>
<tr>
<td>DB16</td>
<td>PI</td>
<td>Interface for PI_SERV2 [FB7], contains definitions for all available PI services.</td>
</tr>
<tr>
<td>DB18</td>
<td>SPL</td>
<td>Safety Integrated data (SPL)</td>
</tr>
<tr>
<td>DB19</td>
<td>MMC</td>
<td>Interface for PI_SERV2 [FB7], contains definitions for all available PI services.</td>
</tr>
<tr>
<td>DB21...DB30</td>
<td>Chan1...Chan10</td>
<td>Interface between user program and channel, contains signals from/to channel 1...10.</td>
</tr>
<tr>
<td>DB31...DB61</td>
<td>Axis1...Axis31</td>
<td>Interface between user program and axis/spindle, contains signals from/to axis/spindle 1...31.</td>
</tr>
<tr>
<td>DB71</td>
<td>TMLoadIF</td>
<td>Interface between user program and tool management, contains signals from/to Load/Unload magazine</td>
</tr>
<tr>
<td>DB72</td>
<td>TMSpindleIF</td>
<td>Interface between user program and tool management, contains signals for spindle as change position.</td>
</tr>
<tr>
<td>DB73</td>
<td>TMRevIF</td>
<td>Interface between user program and tool management, contains signals for turret.</td>
</tr>
<tr>
<td>DB77</td>
<td>DB77</td>
<td>MCP/BHG (SDB210)</td>
</tr>
</tbody>
</table>
3.1.5 Blocks with user-specific adaptations

In the following, you will find a list of all of the blocks of the SINUMERIK PLC basic program which always require user-specific adaptations and therefore cannot be automatically upgraded. These blocks are therefore not contained in the master copy "840D sl PLC Basic Program (upgrade)".

Table 3-6 Blocks with user-specific adaptations

<table>
<thead>
<tr>
<th>Block type</th>
<th>Address</th>
<th>Icon</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organization block</td>
<td>OB1</td>
<td>OB1</td>
<td>Organization blocks are not available in the &quot;840D sl PLC Basic Program (upgrade)&quot; master copy due to the necessary user-specific calls. You can copy these blocks individually as needed from the &quot;840D sl PLC Basic Program&quot; master copy and then import your adaptations into the newly copied blocks.</td>
</tr>
<tr>
<td></td>
<td>OB40</td>
<td>OB40</td>
<td></td>
</tr>
<tr>
<td></td>
<td>OB82</td>
<td>OB82</td>
<td></td>
</tr>
<tr>
<td></td>
<td>OB86</td>
<td>OB86</td>
<td></td>
</tr>
<tr>
<td></td>
<td>OB100</td>
<td>OB100</td>
<td></td>
</tr>
<tr>
<td>Function block</td>
<td>FB29</td>
<td>Diagnostics</td>
<td>...</td>
</tr>
<tr>
<td>Function</td>
<td>FC12</td>
<td>FC12</td>
<td>...</td>
</tr>
<tr>
<td>Data block</td>
<td>DB2</td>
<td>ALCMSG_DB</td>
<td>Comment: The master copy &quot;840D sl PLC Basic Program (upgrade)&quot; contains the version &quot;ExtendAlMsg = False&quot;, not the version &quot;ExtendAlMsg = True&quot;.</td>
</tr>
<tr>
<td></td>
<td>DB4</td>
<td>DB4</td>
<td>...</td>
</tr>
<tr>
<td></td>
<td>DB5</td>
<td>DB5</td>
<td>...</td>
</tr>
</tbody>
</table>
3.1.6 Assignment overview

From the following block number assignment overview, you can find out whether a specific block number (or block address) can be used for the PLC user program, or whether it is assigned or reserved by Siemens or the PLC basic program.

Table 3-7 Assignment of FB numbers

<table>
<thead>
<tr>
<th>FB number</th>
<th>Availability</th>
<th>Occupied by</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Reserved</td>
<td>Siemens</td>
</tr>
<tr>
<td>1</td>
<td>Occupied</td>
<td>Siemens (PLC basic program)</td>
</tr>
<tr>
<td>2...14</td>
<td>Reserved</td>
<td>Siemens</td>
</tr>
<tr>
<td>15</td>
<td>Occupied</td>
<td>Siemens (PLC basic program)</td>
</tr>
<tr>
<td>16...29</td>
<td>Reserved</td>
<td>Siemens</td>
</tr>
<tr>
<td>30...999</td>
<td>Freely available (user program)</td>
<td>-</td>
</tr>
<tr>
<td>1000...1009</td>
<td>Reserved</td>
<td>Siemens</td>
</tr>
<tr>
<td>1010...1019</td>
<td>Reserved or available</td>
<td>Exclusively available for F blocks of Safety Integrated plus (F-PLC)</td>
</tr>
<tr>
<td>1020...1023</td>
<td>Reserved</td>
<td>Siemens</td>
</tr>
<tr>
<td>1024...7999</td>
<td>Freely available (user program)</td>
<td>-</td>
</tr>
</tbody>
</table>

Table 3-8 Assignment of FC numbers

<table>
<thead>
<tr>
<th>FC number</th>
<th>Availability</th>
<th>Occupied by</th>
</tr>
</thead>
<tbody>
<tr>
<td>0...1</td>
<td>Reserved</td>
<td>Siemens</td>
</tr>
<tr>
<td>2...3</td>
<td>Occupied</td>
<td>Siemens (PLC basic program)</td>
</tr>
<tr>
<td>4</td>
<td>Reserved</td>
<td>Siemens</td>
</tr>
<tr>
<td>5</td>
<td>Occupied</td>
<td>Siemens (PLC basic program)</td>
</tr>
<tr>
<td>6...29</td>
<td>Reserved</td>
<td>Siemens</td>
</tr>
<tr>
<td>30...999</td>
<td>Freely available (user program)</td>
<td>-</td>
</tr>
<tr>
<td>1000...1023</td>
<td>Reserved</td>
<td>Siemens</td>
</tr>
<tr>
<td>1024...7999</td>
<td>Freely available (user program)</td>
<td>-</td>
</tr>
</tbody>
</table>

Table 3-9 Assignment of DB numbers

<table>
<thead>
<tr>
<th>DB number</th>
<th>Availability</th>
<th>Occupied by</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Reserved</td>
<td>Siemens</td>
</tr>
<tr>
<td>2...11</td>
<td>Occupied</td>
<td>Siemens (PLC basic program)</td>
</tr>
<tr>
<td>12</td>
<td>Occupied</td>
<td>Siemens (computer link and transport system interface)</td>
</tr>
<tr>
<td>13...14</td>
<td>Reserved</td>
<td>Siemens (PLC basic program)</td>
</tr>
</tbody>
</table>
### 3.1 General information about the PLC program

<table>
<thead>
<tr>
<th>DB number</th>
<th>Availability</th>
<th>Occupied by</th>
</tr>
</thead>
<tbody>
<tr>
<td>15...16</td>
<td>Occupied</td>
<td>Siemens (PLC basic program)</td>
</tr>
<tr>
<td>17</td>
<td>Occupied</td>
<td>Siemens</td>
</tr>
<tr>
<td>18</td>
<td>Occupied</td>
<td>Siemens (PLC basic program: Safety Integrated (SPL))</td>
</tr>
<tr>
<td>19</td>
<td>Occupied</td>
<td>Siemens (PLC basic program)</td>
</tr>
<tr>
<td>20</td>
<td>Occupied</td>
<td>Siemens (SINUMERIK CPU-DB)</td>
</tr>
<tr>
<td>21...30</td>
<td>Occupied¹</td>
<td>Siemens (PLC basic program: Channel DB)</td>
</tr>
<tr>
<td>31...61</td>
<td>Occupied¹</td>
<td>Siemens (PLC basic program: Axis DB)</td>
</tr>
<tr>
<td>62...70</td>
<td>Freely available (user program)</td>
<td>-</td>
</tr>
<tr>
<td>71...73</td>
<td>Occupied¹</td>
<td>Siemens (PLC basic program: tool management)</td>
</tr>
<tr>
<td>74...77</td>
<td>Occupied</td>
<td>Siemens (PLC basic program)</td>
</tr>
<tr>
<td>78...80</td>
<td>Reserved</td>
<td>Siemens</td>
</tr>
<tr>
<td>81...999</td>
<td>Occupied¹</td>
<td>Siemens (ShopMill, ManualTurn)</td>
</tr>
<tr>
<td>1000...1002</td>
<td>Occupied</td>
<td>Siemens (PLC basic program)</td>
</tr>
<tr>
<td>1003...1008</td>
<td>Reserved</td>
<td>Siemens</td>
</tr>
<tr>
<td>1009</td>
<td>Occupied</td>
<td>Siemens (Safety Integrated plus (F-PLC))</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SI_DiagDB [DB1009] (automatically generated)</td>
</tr>
<tr>
<td>1010...1019</td>
<td>Reserved or available</td>
<td>Exclusively available for F blocks of Safety Integrated plus (F-PLC)</td>
</tr>
<tr>
<td>1020...1070</td>
<td>Reserved</td>
<td>Siemens</td>
</tr>
<tr>
<td>1071...1073</td>
<td>Occupied</td>
<td>Siemens (PLC basic program)</td>
</tr>
<tr>
<td>1074...1099</td>
<td>Reserved</td>
<td>Siemens</td>
</tr>
<tr>
<td>1100...16000</td>
<td>Freely available (user program)</td>
<td>-</td>
</tr>
</tbody>
</table>

¹Not recommended for use, but possible with limitations. Data blocks of channels, axes/spindles and tool management functions that have not been activated can be used by the user, but this can result in conflicts when upgrading or migrating the PLC basic program.

**Further information**

Information about the PLC basic program of the SINUMERIK 840D sl is contained in the P3 section of the SINUMERIK 840D sl Basic Functions Manual: PLC basic program for SINUMERIK 840D sl.
3.1.7 Generating blocks at runtime on the NCU

In specific circumstances, some of the basic PLC program blocks are generated by the NCU at runtime:

- If you do not load them explicitly onto the NCU
- If you load blocks with an unexpected size onto the NCU, for example because blocks do not match the machine configuration (e.g. DB20 [DB20] or AL_MSG [DB2]) or because of a different runtime version.

This concerns the following blocks:

- All axis/channel DBs actually used
- ALMSG_DB [DB2]
- DB3 [DB3]
- DB9 [DB9]
- BAG [DB11]
- DB17 [DB17]
- MMC [DB19]

The configuring of these blocks is optional and required only when, for example, you symbolically address them. Although warnings are issued when the configuration is compiled, the program can be executed because of the blocks generated at runtime.

If this involves one of the blocks of the basic program that you do not require (e.g. unused axis DB, channel DB, FB or FC), you can delete it. This reduces, for example, the time required for loading or exporting the PLC symbols and for working with SINUMERIK archives.
3.2 Opening the PLC basic program system library

Procedure

Proceed as follows to open and display the system library of the PLC basic program:

1. Switch to the "Libraries" task card.
2. Select the PLC basic program that matches the firmware version of the inserted NCU:
   - SINUMERIK 840D sl PLC basic program V4.5.x.x
   - SINUMERIK 840D sl PLC basic program V4.7.x.x
   - SINUMERIK 840D sl PLC basic program V4.8.x.x

Result

The system library of the PLC basic program has been opened. Information on handling can be found under Using copy templates (Page 48) and Adding the PLC basic program (Page 60).

Further information

The block descriptions and other information about the PLC basic program are contained in the P3 section of the SINUMERIK 840D sl Basic Functions Manual. Basic PLC program.
3.3 Adding the PLC basic program

You can copy blocks of the PLC basic program from the respective system library. The "840D sl PLC Basic Program" folder that it contains is meant for creating a completely new project. You can copy the PLC basic program blocks in their entirety or individually.

Requirement

- A SINUMERIK 840D sl NCU is inserted.
- In the project, there are no blocks from other creators in the range of numbers of the PLC basic program (Page 56).

Procedure

To copy program blocks of the basic program from a master copy to the program blocks folder of the project tree, proceed as follows:

1. Switch to the "Libraries" task card and open the PLC basic program that matches the firmware version of the inserted NCU:
   - SINUMERIK 840D sl PLC basic program V4.5.x.x
   - SINUMERIK 840D sl PLC basic program V4.7.x.x
   - SINUMERIK 840D sl PLC basic program V4.8.x.x
   See also: Replacing a device or upgrading firmware (Page 25) Using copy templates (Page 48)
2. Open the folder "Master copies > 840D sl PLC Basic Program"
3. You have several options for copying the PLC basic program blocks to your project:
   - **Copying the PLC basic program including folder structure as a whole**
     Drag and drop the master copies folder "840D sl PLC BP" into the folder Program blocks, e.g. under "CNC_1 > PLC_1 > Program blocks".
### 3.3 Adding the PLC basic program

- **Copying specific PLC basic program blocks**

  Open the master copies folder and, if applicable, other lower-level folders and manually define the blocks which you would like to copy by selecting them and then dragging and dropping them into the program blocks folder.

  To select successive objects, click on the first object, press and hold the Shift key and then click on the last object.

  To select non-successive objects, press and hold the Ctrl key and click on the objects one-by-one.

  The blocks are copied to your project. If applicable, the "Conflicts during copying" (Page 63) dialog is displayed.

**Note**

*Copy further required blocks separately (e.g. DB2 variant "ExtendAlMsg=True")*

If you are using PLC basic program blocks that are not contained in the master copies folder "840D sl Basic Program > 840D sl PLC BP", you must copy them separately:

- DB2 variant "ExtendAlMsg=True" from the master copies folder "ALMSG_DB_ExtendAlMsg"
- Different external STL sources from the master copies folder "External source files"

See: Using copy templates (Page 48)

Create blocks from external sources (Page 70)
4. In the project tree, right-click "Program blocks" and select the "Software (compile all blocks)" command in the "Compile" shortcut menu.

Result

The blocks of the basic SINUMERIK PLC program have been copied to your project. Any copied folder structure (Page 69) has been imported.

Now you can check the copied blocks and, if applicable, manually delete the PLC basic program blocks that you do not require (e.g. unused axis DB, channel DB, FB or FC). If you have unused blocks in your project, some tasks take unnecessarily long, e.g. the loading or the creation and import of SINUMERIK archives.
3.4 Conflicts when copying blocks

Two different conflict types can occur during the copy and insert of program blocks:

- If several blocks with the same block numbers exist in the program blocks folder, a message is not displayed immediately. Because duplicate block numbers are flagged only during the compilation, compile your project after performing a copy in order to detect any conflicts early.

- The presence of duplicate symbolic block names is checked already during the copy action. A message is issued if conflicts result because of existing symbolic names.

If duplicate block numbers exist, proceed as follows:

- If this involves one of the blocks of the basic program that you do not require (e.g. unused axis DB, channel DB, FB or FC), you can delete it.

- If a user block has the same block number as a required basic program block, you must change the number of the user block.
3.5 Correcting OB1

The dialog offers you the following ways of rectifying the conflict:

- You can cancel the copy process, search for the duplicate blocks in the project tree and delete them before you initiate the copy process again. In this case, click in the "Cancel" dialog box.

- You can copy the master copy to the project and overwrite duplicate blocks without knowing which blocks have caused the conflict. In this case, select in the dialog box "Replace existing objects and move to this location" and confirm with "OK".

The other possibility mentioned in the dialog, "Rename and add objects", does not resolve the conflict in this case.

3.5 Correcting OB1

When inserting the blocks from a master copy of the library, the existing organization block OB1 is duplicated because it has a different name in the library than in the newly created PLC.

- Block in project tree: Main [OB1] or the name of your migrated block.
- Block in library: OB1 [OB1]

When the project is compiled, a message is displayed that there may only be one object of the type "OB1".

Procedure

To identify the not required version of the OB1 and to rectify the problem, proceed as follows:

1. Delete one of the duplicated OB1 blocks in the "program blocks" folder:
   - If the "program blocks" folder prior to the insertion contained only the empty Main [OB1] standard block, you can delete it.
   - If you have already programmed your own instructions in the OB1, this block normally already contains the call for the basic program and you can delete the newly added "OB1 [OB1]" block.
3.6 Upgrading the PLC basic program

If you upgraded the firmware of an NCU or carried out a project migration, you should then also upgrade the PLC basic program to the current version. However, it is essential that you check beforehand whether you would inadvertently overwrite your own blocks (see requirement).

**Requirement**

- Block number ranges of the SINUMERIK PLC basic program in the project are not occupied by blocks of other creators or you have checked which blocks of other creators are located in the SINUMERIK number range (Page 56).

**Procedure**

To upgrade the PLC basic program, proceed as follows:

1. Switch to the "Libraries" task card and open the PLC basic program that matches the firmware version of the inserted NCU:
   - SINUMERIK 840D sl PLC basic program V4.5.x.x
   - SINUMERIK 840D sl PLC basic program V4.7.x.x
   - SINUMERIK 840D sl PLC basic program V4.8.x.x

   See also: Replacing a device or upgrading firmware (Page 25), Using copy templates (Page 48)

2. Open the folder "Master copies > 840D sl PLC Basic Program (upgrade)"
3. Depending on the block number assignment in your project, select one of the following options:

<table>
<thead>
<tr>
<th>Assignment of the PLC GP No. range</th>
<th>Possible procedure</th>
</tr>
</thead>
</table>
| Through blocks of other creators  | **Overwriting specific PLC basic program blocks**  
1. Open the lower-level master copies folders and select only those PLC basic program blocks that you use in your project.  
   - To select successive objects, click on the first object, press and hold the Shift key and then click on the last object.  
   - To select non-successive objects, press and hold the Ctrl key and click on the objects one-by-one.  
2. Drag and drop the selected blocks into your "Program blocks" folder, e.g. under "CNC_1 > PLC_1 > Program blocks". |
| or Exclusively through PLC basic program blocks | **Overwriting the PLC basic program including folder structure as a whole**  
Drag and drop the entire master copies folder "840D sl PLC BP" into your "Program blocks" folder, e.g. under "CNC_1 > PLC_1 > Program blocks". |

The blocks are copied to your project. A check is made for duplicate block names and the "Conflicts during copying" dialog (Page 63) is displayed.

**Note**

**Copy further required blocks separately (e.g. DB2 variant "ExtendAlMsg=True")**

If you are using PLC basic program blocks that are not contained in the master copies folder "840D sl Basic Program > 840D sl PLC BP", you must copy them separately:

- DB2 variant "ExtendAlMsg=True" from the master copies folder "ALMSG_DB_ExtendAlMsg"
- Different external STL sources from the master copies folder "External source files"

See: Using copy templates (Page 48)

4. Select the option "Replace existing objects and move to this location" and confirm with "OK".
5. In the project tree, right-click "Program blocks" and select the "Software (compile all blocks)" command in the "Compile" shortcut menu.

**Result**

The PLC basic program has been upgraded and is currently compiled.

Now you can check the copied blocks and, if applicable, manually delete the PLC basic program blocks that you do not require (e.g. unused axis DB, channel DB, FB or FC). If you have unused blocks in your project, some tasks take unnecessarily long, e.g. the loading or the creation and import of SINUMERIK archives.
3.7 Copying blocks from one project into another

Procedure

Proceed as follows to import blocks from an existing project:

1. From the "View" menu, choose the command "Reference projects".
   The "Reference projects" palette is displayed under the project tree.

2. Click the "Open reference project" icon in the "Reference projects" palette, select the
   project, and confirm with "Open".
   The project is opened (write-protected) and the associated project structure is displayed
   in the "Reference projects" palette.

3. Navigate in the reference project to the "Program blocks" folder and select the blocks that
   you want to copy.
4. Drag-and-drop the blocks from the reference project to the "Program blocks" folder of your current project.

Note

Copy additional objects separately (e.g. tags or PLC data types)

When you copy the program blocks, objects that belong together, such as tags, PLC data types or technology objects, are not automatically included in the copy. This applies both to copying from reference projects and to copying to another PLC.

Error messages are issued during the compilation, e.g. if the tags used in the copied program block are not defined in the tag table.

Therefore, additionally copy the objects used by the copied blocks.

Note

Conflicts due to names, addresses or numbers that are used multiple times

When you paste objects from a reference project whose names have already been used in the project, these are automatically renamed under certain circumstances:

- If you copy objects with the same name into the same folder or the same group, the "Conflicts when copying" dialog is displayed.
- If you copy objects with assigned names to a different folder (or group), the newly pasted objects are renamed without asking.

A check for duplicate block numbers or addresses is only done during the conversion, however.
3.8 Use and handling of groups

In the project navigation, you can create optional groups in the "program blocks" folder in order to organize your program blocks.
For example, this function is useful in the following situations:

- Creation of a dedicated group for the blocks of the basic program and of the user program.
  This allows you to display individually the editable blocks of the user program.
- Organize specific related program blocks (e.g. axis DBs).
- Organize specific program blocks in a group in order to save them quickly and easily in a reload archive (Page 41).

To maximize the overview window, select the "program blocks" folder and click the "Maximize/minimize the view" icon in the project navigation toolbar.

Information about the overview window can be found in the information system of the TIA Portal, keyword "overview window".

### 3.9 Create blocks from external sources

You do not manage external source files (e.g. *.STL or *.SCL) in TIA Portal in the "Program blocks" folder, but in the "External sources" folder, e.g. under "CNC_1 > PLC_1 > External sources". You can then generate blocks from the sources maintained there. These are saved in the "Program blocks" folder.

You do not edit the files in the "External sources" folder using a TIA Portal editor, but with any external editor, which you define under Windows.

#### Requirement

An external source is available in STL or SCL format.

#### Procedure

1. In the project tree, select the "Add new external file" command in the "CNC_1 > PLC_1 > External sources" folder.
2. Select the external file (*.STL or *.SCL) that you want to add in the "Open" dialog. The external file is copied to the "External sources" folder in the project tree.

#### Note

**Displaying external sources (e.g. STL files) using an external editor**

The internal editor of the TIA Portal does not display external sources.

If you add and open an external source in the TIA Portal, the file will be opened with the application linked with the associated file type (e.g. STL) in Windows (e.g. Microsoft Editor).

See also: TIA Portal online help, search term "Using external source files"
3. Right-click the external source, then select the "Generate blocks from source" command in the shortcut menu.

---

**Note**

**Mnemonics**

Under "Tools > Settings > General settings > Mnemonics" ensure that you have selected English as language for the Getting Started configuration example.

The setting in the TIA Portal must always match the mnemonics used in the source. The generation process will not be successful if the appropriate setting was not selected.

---

**Result**

You have successfully generated blocks from an external source.

Further information about external sources of the PLC basic program system library can be found in the SINUMERIK 840D sl Basic Functions Manual.
3.10 Exporting PLC symbols for SINUMERIK Operate

3.10.1 Creating and loading PLC symbols

You can make PLC symbols defined in the TIA Portal available for SINUMERIK Operate in order to use them for various functions there. You must export the symbols of the associated PLC in the TIA Portal and then import into SINUMERIK Operate.

Note
Deleting unwanted blocks before exporting PLC symbols

If you have saved unwanted blocks in your project, this lengthens the time required for exporting and importing PLC symbols. Consequently, delete unwanted blocks that you copied previously from the basic program library prior to the export.

See: General information about the PLC program (Page 45)

Requirement

- The software has been compiled completely.
- The associated languages are activated as project languages in the TIA Portal.

See: Information system, "Activate project languages" section

Note
Comments only in German or English

Because SINUMERIK Operate can manage only German and English comments, you can export only German and English comments from the TIA Portal.

- The PLC symbols to be exported are valid.

Note
Only valid PLC symbols are exported

The following PLC symbols are not taken into account during the export:
- PLC symbols of know-how-protected blocks
- PLC symbols of F-blocks
- Internal PLC symbols
- Invalid/faulty PLC symbols
### Procedure overview

Table 3-10  Example procedure for creating and loading PLC symbols

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1    | If necessary, check or edit symbols in the TIA Portal  
• You can change the symbolic names of blocks by right-clicking the block and selecting "Rename" from the shortcut menu.  
• You can change symbols of the individual elements in the block editor.  
• PLC variables for Flags, Times, Input, Output, Timer and Counter can be changed in the associated table field (e.g. under "CNC_1 > PLC 1 > PLC variables > Display all variables") |
| 2    | Exporting PLC symbols with the TIA Portal (Page 74) |
| 3    | If necessary, make export files available on the NCU or PCU, e.g. using a USB FlashDrive |
| 4    | Importing PLC symbols in SINUMERIK Operate (Page 76) |
3.10.2 Exporting PLC symbols

Note
Deleting unwanted blocks before exporting PLC symbols
If you have saved unwanted blocks in your project, this lengthens the time required for exporting and importing PLC symbols.
Consequently, delete unwanted blocks that you copied previously from the basic program library prior to the export.
See: General information about the PLC program (Page 45)

Requirement
- The software has been compiled completely.
- The associated languages are activated as project languages in the TIA Portal.
  See: Information system, “Activate project languages” section

Note
Comments only in German or English
Because SINUMERIK Operate can manage only German and English comments, you can export only German and English comments from the TIA Portal.

- The PLC symbols to be exported are valid.

Note
Only valid PLC symbols are exported
The following PLC symbols are not taken into account during the export:
- PLC symbols of know-how-protected blocks
- PLC symbols of F-blocks
- Internal PLC symbols
- Invalid/faulty PLC symbols
Procedure

To export PLC symbols for SINUMERIK Operate, proceed as follows:

1. In the project tree, right-click on the PLC or NCU and select the "Export PLC symbols for SINUMERIK Operate" in the shortcut menu.

The "Export PLC symbols for SINUMERIK Operate" dialog opens.

2. Enter the settings:
   - Select the languages whose PLC symbols you want to export. Only those languages that you previously selected under "Project languages" are actively displayed.
   - Select the storage location in which the exported PLC symbols are to be saved. Use, for example, a USB FlashDrive to subsequently copy the files to the NCU.

3. Click "Export" to start the export operation.

Note

Comments only in German or English

Because SINUMERIK Operate can manage only German and English comments, you can export only German and English comments from the TIA Portal.

- Select the storage location in which the exported PLC symbols are to be saved. Use, for example, a USB FlashDrive to subsequently copy the files to the NCU.
3.10 Exporting PLC symbols for SINUMERIK Operate

Result

The PLC symbols will be copied to the chosen storage location. The "PlcSym.snh" file is created. Depending on your settings, the files are also created with German or English comments: "PlcSym_GR.snt" and "PlcSym_UK.snt".

Note

Notation

The notation (upper and lower case) of the file names created by the program is mandatory and must not be changed.

3.10.3 Importing PLC symbols

Requirement

- The symbol export files are available on the NCU or PCU, e.g. using a USB FlashDrive

Note

Notation

The notation (upper and lower case) of the file names created by the program is mandatory and must not be changed.

- The current PLC symbols in SINUMERIK Operate have been saved

Note

Saving or deleting old symbol tables

Note that already existing files are overwritten during the export if you confirm that this should be done. Furthermore, it can lead to inconsistencies if not all files are exported.

We recommend that the old files are backed up or deleted before a new export, or the files are exported to an empty directory.
3.11 Edit blocks

The individual blocks of the PLC basic program or the user program can be edited directly in the TIA Portal using the STEP 7 editors.

Information about these functions and editors is available in the higher-level help "Programming the PLC" and in the STEP 7 Professional System Manual. (Sometimes functions for specific PLCs are discussed there. Information that also concerns the SINUMERIK 840D sl PLCs is marked with "S7-300".)

If you are converting from the STEP 7 V5.x toolbox, you also find special information about programming a PLC in the sections of the "Migrating SINUMERIK projects" help.
4.1 Configuring an Ethernet Interface

Procedure

In order to set the Ethernet interface, proceed as follows:

1. In the network view, click the CP in the basic rack of the NCU.

2. Under the "Properties" tab in the inspector window, select the "PN/IE interface > Ethernet addresses" entry.

3. Set the IP address matching your real configuration. If the PG/PC is connected to X127, the following IP address applies:

   **Hardware factory setting on the NCU for socket X127**
   
   IP address: 192.168.215.1
   
   Subnet mask: 255.255.255.0
4.2 Configuring PROFIBUS DP

Procedure

Configuring the PROFIBUS DP address on the PLC

1. In the network view, click the PLC in the basic rack of the NCU.
2. In the "Properties" tab, in the inspector window, select the entry "DP Interface > PROFIBUS address".
   The settings of the PROFIBUS address are displayed.

3. In the Parameters area, set the DP address of the interface on the PLC under "Address". This is transferred from the configuration to the PLC during the load action.

Configuring the PROFIBUS DP address for the ADI4 module

1. In the network view, click the "DP" interface of the ADI4.
2. In the inspector window "Properties", select the entry "PROFIBUS address".
3. Under "Address" set the DP address that matches the hardware. The configured address must match the hardware address. It is not accepted automatically.
   Information about setting the DP address on the hardware is contained in the "ADI4 - Analog drive interface for 4 axes" Device Manual.
Checking the transmission speed of the ADI4

Although you can view the "Transmission speed" parameter in the DP interface properties, you must select the bus system to change it:

1. Click the bus system.

2. In the "Properties" inspector window, check under "Network settings" the "Transmission speed" entry. The ADI4 module can be operated only with the transmission speed 12 Mbit/s.
4.3 Configuring Integrated PROFIBUS (DP Integrated)

Procedure

To check the PROFIBUS addresses, proceed as follows:

1. In the network view, click the DP Integrated interface of the PLC or select the interface in the device overview.
2. In the "Properties" tab, in the inspector window, select the entry "PROFIBUS address".

Result

The DRIVE-CLiQ sockets of the real hardware are displayed to which the NX modules must be connected.

Note

Cycle clock settings

You can only make the cycle clock settings on the PROFIBUS Integrated subnet and not directly on the interface: For the selected subnet, you find the cycle clock settings under "Equidistance" in the inspector window.

Observe the rules for setting the clock cycle at the field buses (see Commissioning Manual, "Commissioning CNC: NCK, PLC, drive").
4.4 Configuring PROFINET

Procedure

In order to set the PROFINET interface, proceed as follows:

1. In the network view, click the PLC in the basic rack of the NCU.
2. Under the "Properties" tab in the inspector window, select the "PROFINET interface > Ethernet addresses" entry.
3. Check under "IP protocol" whether the correct IP address is set ("192.168.0.1" in the example).
4.5 Configuring PROFINET IO with IRT

4.5.1 Overview

IRT (Isochronous Realtime Ethernet) is a transmission method in which the PROFINET devices are synchronized very precisely.

The following example configuring sequences serve as an aid for the configuring and provide an overview of this chapter content.

- Configuring NC-controlled drives isochronously (handling overview) (Page 88)
- Configuring I/O used by NC isochronously (handling overview) (Page 89)

You can, however, make most settings for the clock synchronization in TIA Portal in any order. You can orient yourself on the following notes:

- Isochronous modules identification in the hardware catalog (Page 86)
- Rules and requirements for clock synchronization (Page 84)
- Match values between PROFINET IO and PROFIBUS Integrated (Page 99)
- General information concerning isochronous mode is also contained in the TIA Portal online help in Section "Configuring IRT communication".

If, instead, you want to operate drives or I/O isochronously via the PLC, proceed as for a CPU S7-300. (Use the OB61 as isochronous alarm OB or the TPA1 as process image, and do not enter the drive or I/O addresses in the machine data.)

4.5.2 Rules and requirements

Irrespective whether you configure isochronous I/O used by NC or isochronous NC-controlled drives, the value of the TDP send clock must be identical in the complete system (all devices, modules, submodules and bus systems):

- You can find these settings in the TIA Portal at the following locations:
  - Properties of the PROFINET IO system under "Domain management > Sync domains > Sync-Domain_x > Send clock".
  - Properties of the PROFIBUS Integrated bus system under "Equidistance > DP cycle".

This applies, e.g. even when you connect drives via PROFINET as well as PROFIBUS Integrated. The default setting of the PROFIBUS DP cycle (send clock) at the integrated PROFIBUS is 2 ms.

During the configuring of drives, the values of the T₁ and T₀ times must also be identical in the complete system:

- Properties of the IO device under "PROFINET interface > Extended options > Isochronous mode".
- Properties of the bus system (e.g. PROFIBUS Integrated_1) under "Equidistance".
You can obtain these values automatically from the "NCK" isochronous OB or set them manually.

Note
Restriction on the use of NCU Link
The combination of isochronous PROFINET NC peripherals (drives, inputs/outputs) and NCU-Link is not supported.
4.5.3 Isochronous-capable modules identification

Whether a module supports isochronous mode can be determined in the hardware catalog in the following manner:

- When you select a device in the hardware catalog, you can see from the description in the "Information" section whether this device supports isochronous mode or IRT.

All peripheral modules that have the "HF" name suffix can be operated isochronously (e.g. DI 16x 24 VDC HF - 6ES7 521-1BH00).
• The "Information" section does not explicitly list whether drive telegrams (e.g. SIEMENS telegram 136) support isochronous mode. The compiler will issue an error message if you use an isochronous telegram without activating isochronous mode for the associated header module.

• A listing of isochronous-conform PROFINET controllers and PROFINET devices is contained in the Service & Support portal:

The associated hardware documentation specifies whether a PROFIBUS controller or device is isochronous-conform.

---

**Note**

**Differences for devices based on device description files (DDF)**

A description of the functionality is also contained in the "Information" section for DDF devices. The following differences, however, exist for the configuring:

• GSD devices are not contained in the same folder as standard devices in the hardware catalog. The SINAMICS S120/S150 CU320-2, for example, are not found under "Field devices", but rather under "Further field devices > PROFINET IO > Drives > Siemens AG > SINAMICS".

• To insert modules or submodules for a GSD device, you must use the device overview rather than the device view.
4.5 Configuring PROFINET IO with IRT

4.5.4 Configuring isochronous NC-controlled drives

The procedure for configuring isochronous NC-controlled drives is described below.

If, instead, you want to operate drives isochronously via the PLC, proceed as for a CPU S7-300. (Use the OB61 as isochronous alarm OB or the TPA1 as process image, and do not enter the drive addresses in the machine data.)

If, rather than NC-controlled drives, you want to configure I/O used by NC isochronously, proceed as described in the associated section (Page 89).

Requirement

- The devices to be configured have been inserted (at least one NCU and one PROFINET IO IRT-conform device).
- The isochronous-conform modules and submodules to be configured have been inserted in the PROFINET IO IRT-conform device.
  
  See also: Isochronous-capable modules identification (Page 86)
- The PROFINET IO IRT-conform devices are interconnected to the NCU with X150.

Note

Concurrent operation of devices with and without clock synchronization

When you configure devices that do not participate on the IRT communication, observe the rules for sync domains for PROFINET IO IRT (Page 97).

Procedure overview

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Configuring the NCU (Page 90)</td>
</tr>
<tr>
<td>2</td>
<td>Configuring PROFINET IO IRT devices (Page 92)</td>
</tr>
<tr>
<td>3</td>
<td>Configuring IO modules or drive telegrams (Page 94)</td>
</tr>
<tr>
<td>4</td>
<td>Configuring sync domains (Page 97)</td>
</tr>
</tbody>
</table>
| 5    | Compile the configuration and load into the actual hardware (Page 30)  
The compiler issues error messages if you use different values for bus cycles. In this case, match the values (Page 99). |
| 6    | Assigning drive addresses to the NCU machine data (Page 99) |
4.5 Configuring PROFINET IO with IRT

Note
Reusing configured drives or devices in other projects
You can copy preconfigured and configured drives or devices with drag-and-drop into a global library. In this manner, you can insert them later together with the made settings into another project and so save configuration effort.

Further information on handling libraries in the TIA Portal can be found in the online help under "Library > Fundamentals".

Further information
Further information on the configuration of IRT can be found in the TIA Portal online help under "Configuring IRT communication".

4.5.5 Configuring I/O used by NC isochronously
The procedure for configuring isochronous NC I/O is described below.

If, instead, you want to operate I/O isochronously via the PLC, proceed as for a CPU S7-300. (Use the OB61 as isochronous alarm OB or the TPA1 as process image, and do not enter the I/O addresses in the machine data.)

If, rather than non-NC I/O, you want to configure NC drives isochronously, proceed as described in the associated section (Page 88).

Requirement
- The devices to be configured have been inserted (at least one NCU and one PROFINET IO IRT-conform device).
- The modules to be configured have been inserted in the PROFINET IO IRT-conform device.

See also Isochronous-capable modules identification (Page 86)
- The PROFINET IO IRT-conform devices are interconnected to the NCU with X150.

Note
Concurrent operation of devices with and without clock synchronization
When you configure devices that do not participate on the IRT communication, observe the rules for sync domains for PROFINET IO IRT (Page 97).
4.5 Configuring PROFINET IO with IRT

Procedure overview

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Configuring the NCU (Page 90)</td>
</tr>
<tr>
<td>2</td>
<td>Configuring PROFINET IO IRT devices (Page 92)</td>
</tr>
<tr>
<td>3</td>
<td>Configuring IO modules or drive telegrams (Page 94)</td>
</tr>
<tr>
<td>4</td>
<td>Configuring the input delay for digital input modules (Page 96)</td>
</tr>
<tr>
<td>5</td>
<td>Configuring sync domains (Page 97)</td>
</tr>
<tr>
<td>6</td>
<td>Compile the configuration and load into the actual hardware (Page 30) The compiler issues error messages if you use different values for bus cycles. In this case, match the values (Page 99).</td>
</tr>
<tr>
<td>7</td>
<td>Assigning I/O addresses to the NCU machine data (Page 100)</td>
</tr>
</tbody>
</table>

Note

Reusing configured drives or devices in other projects

You can copy preconfigured and configured drives or devices with drag-and-drop into a global library. In this manner, you can insert them later together with the made settings into another project and so save configuration effort.

Further information for handling libraries in the TIA Portal can be found in the information system under the keyword "Library > Fundamentals".

Further information

Further information on the configuration of IRT can be found in the information system of the TIA Portal at "Configuring IRT communication".

4.5.6 Configuring the NCU

When you operate drives or IO isochronously using NC, make the following SINUMERIK-specific settings.

If, however, you operate the drives or I/O via the PLC, make the settings as for an S7-300-CPU. (See online help, keyword "Isochronous mode, configure").

Requirement

- The devices to be configured have been inserted (at least one NCU and one PROFINET IO IRT-conform device).
- The isochronous-conform modules and submodules to be configured have been inserted in the PROFINET IO IRT-conform device.
  See also: Isochronous-capable modules identification (Page 86)
- The PROFINET IO IRT-conform devices are interconnected to the NCU with X150.
4.5 Configuring PROFINET IO with IRT

Procedure

To configure the NC of the NCU to use isochronous mode, proceed as follows:

1. Select the PLC of the NCU.
2. Select the "Alarms > Isochronous alarms > NCK" entry in the "Properties > General" inspector window.
3. In the "Distributed I/O" dropdown list, select the PROFINET IO system with which you have interconnected the PROFINET IO IRT devices (e.g. "PROFINET IO system (100)").
4. In the "Application cycle (ms)" dropdown list, select the value that you defined as send clock of the sync domain and the DP cycle of SINAMICS Integrated, e.g. 2000.
5. Enter "2" in the "TPA" (subprocess image) text field. The setting must match the "process image" setting on the IO modules.

Note

Concurrent operation of devices with and without clock synchronization

When you configure devices that do not participate on the IRT communication, observe the rules for sync domains for PROFINET IO IRT (Page 97).
4.5.7 Configuring PROFINET IO IRT devices

Requirement

- The devices to be configured have been inserted (at least one NCU and one PROFINET IO IRT-conform device).
- The isochronous-conform modules and submodules to be configured have been inserted in the PROFINET IO IRT-conform device.
  See also Isochronous-capable modules identification (Page 86)
- The PROFINET IO IRT-conform devices are interconnected to the NCU with X150.
- The NCU is configured.
  See also Configuring the NCU (Page 90)

Procedure

To configure devices for isochronous operation, proceed as follows:

1. Switch to the device view of the PROFINET IO IRT device and select it.
2. Select in the "Properties > General" inspector window under "PROFINET interface > Extended options" the port (e.g. Port [X1 P1]).
3. Select a specific port on the PLC in the "Partner port" dropdown list in the "Port interconnection" section: "Port_1" (X150 P1) or "Port_2" (X150 P2).

The selected port of the device is interconnected with the appropriate port of the PLC.
(Alternatively, you can make the port interconnection between devices graphically in the topology view.)
4. In the "Cable length" dropdown list, enter the length of the actual cable in order to minimize the signal run time.

5. Switch in the sector tree of the inspector window to the "PROFINET interface > Extended options > Isochronous mode" entry.

6. Activate the "Isochronous operation" checkbox.

   The isochronous operation of the device is activated and concurrently the synchronization role of the device set to "sync slave" and the RT class set to "IRT" in the sync domain.

7. In the "Ti/To values" dropdown list, select "From the OB".

   This causes the value to be taken automatically from the setting of the isochronous alarm OB "NCK".

8. Activate the isochronous mode individually for the desired modules of the device in the "Detail overview" table.

Figure 4-4 Settings for the isochronous mode using the example of a SINAMICS S120/S150 CU320-2
4.5 Configuring PROFINET IO with IRT

4.5.8 Configuring IO modules or drive telegrams

The isochronous-conform modules (e.g. input/output modules, DO or telegrams) to be configured must be selected individually in order to make the desired settings in the "Properties" inspector window. You can select these modules in the device view or device overview (in the case of GSD-based devices, only in the device overview).

**Requirement**

- The devices to be configured have been inserted (at least one NCU and one PROFINET IO IRT-conform device).
- The isochronous-conform modules and submodules to be configured have been inserted in the PROFINET IO IRT-conform device.
  
  See also Isochronous-capable modules identification (Page 86)
- The PROFINET IO IRT-conform devices are interconnected to the NCU with X150.
- The NCU is configured.
  
  See also Configuring the NCU (Page 90)
- The device or the rack is configured.
  
  See also Configuring PROFINET IO IRT devices (Page 92)

**Procedure**

To configure the inserted IO modules, select them successively and make the settings individually for each module in the inspector window. Proceed as follows:

1. In the device view, select the rack and open the device overview.

   ![Device overview example of a GSD drive device with modules](image)

2. In the device overview, select on the rack of the PROFINET unit one of the inserted modules to be configured.
3. In the "Properties > General" inspector window, select the "I/O addresses" entry.

Figure 4-6 Settings for I/O addresses
4. Select the TPA2" as "Process image" in each of the "Input addresses" and "Output addresses" sections.

![TPA2 process image setting using a telegram 136 as example](image)

Figure 4-7 TPA2 process image setting using a telegram 136 as example

5. Enter the desired address in the associated "Start address" text field. Note the following:
   - The I/O addresses must lie within the process image of the PLC (default setting: 1024 bytes; can be configured under "Cycle" in the PLC properties).
   - Do not use any I/O addresses that are used for some other purpose, e.g. by the machine control panel.
   - The I/O addresses must match the setting in the NC (SINUMERIK Operate).

The machine data in which this is entered depends on whether drives or I/Os are to be configured:
- Assigning drive addresses to the NCU machine data (Page 99)
- Assigning I/O addresses to the NCU machine data (Page 100)

4.5.9 Configuring the input delay for digital input modules

If you configure isochronous NC IO, you must correctly set the "input delay" value on the used digital input modules. A small input delay shortens the response time, although a larger input delay can possibly suppress longer interference pulses.

- You find the setting for the input delay for a selected digital input module under "Inputs" in the "Properties" inspector window.

Configure the input delay appropriate for the send clock of the sync domain. The send clock of the sync domain cannot be set smaller than the input delay of the digital input modules. The default setting of the input delay is 3 ms.
4.5.10 Configuring sync domains

All PROFINET devices that participate on the IRT communication are synchronized to a common clock. The devices must belong to a sync domain. Just one device has the role of the sync master (clock generator) in a sync domain; all other devices have the role of a sync slave. For SINUMERIK, the PROFINET IO controller serves as sync master in the PLC.

Rules

- The configured PROFINET topology must match the actual wiring of the hardware.
- PROFINET devices that do not participate on the IRT communication, namely not synchronized, are also not part of a sync domain.
- Devices that do not belong to the sync domain may not be contained in the PROFINET topology between a node of a sync domain and its sync master.

How to remove or add nodes from or to a sync domain is described under "Specifying nodes of a sync domain" in the TIA Portal online help.

Procedure

To configure the sync domain in the properties of the PROFINET IO system, proceed as follows:

1. In the network view, select the PROFINET IO system.

   ![Figure 4-8 Selecting the PROFINET IO system](image)

   2. Select the "PROFINET > Domain management > Sync-Domain_1" entry in the "Properties > General" inspector window.

   ![Figure 4-8 Selecting the PROFINET IO system](image)
3. In the "IO devices" table, define the synchronization roles and RT classes of all devices of the sync domain:

   – Define the role of the PLC by opening the dropdown list in the "Synchronization role" column and selecting "Sync master".

   ![Figure 4-9 Selecting the sync master](image)

   – Check whether the synchronization role is set to "Sync slave" for all desired devices.

     See also: Configuring PROFINET IO IRT devices (Page 92)

4. In the "Sync-Domain_1" section, enter a value in the "send clock" dropdown list appropriate for the "Equidistant DP cycle" setting.

   **Note**

   The send clock of the sync domain and the DP cycle for SINAMICS Integrated must match!

   If you have not set the same values for these settings, an error message will be issued when the configuration is compiled. In this case, match the values and compile the project again.

   The "Equidistance DP cycle" setting is contained under "Equidistance" in the properties of the PROFIBUS Integrated subsystem. (default setting: 2 ms; minimum value: Version-dependent)
4.5.11 Match values between PROFINET IO and PROFIBUS Integrated

In case you have used different values, an error message will be issued in the "Info > Compile" inspector window during the compilation.

The following values must agree:

Isochronous mode values:
- "PLC > Alarms > Isochronous alarms > NCK > Application cycle"
- "PROFINET IO system > Domain management > Sync domains > Sync-Domain_1 > Send clock"
- "PROFIBUS Integrated_1 > Equidistance > DP cycle > Equidistant DP cycle"

Ti/To values:
- "PROFIBUS Integrated_1 > Equidistance > Ti/To values of the PROFIBUS"
- "I/O device > PROFINET interface [x1] > Extended options > Isochronous mode"

Match the values and compile the project again.

4.5.12 Assigning drive addresses to the NCU machine data

Procedure

To enter configured addresses in the machine data in the TIA Portal, proceed as follows:

1. Check in the TIA Portal which addresses you have assigned to the drives (see Configuring IO modules or drive telegrams (Page 94)).
2. Transfer the addresses to the machine data (e.g. via SINUMERIK Operate).

See Adapting I/O start addresses (Page 124).

Further information

- General information concerning this machine data is available in Chapter A4 of the SINUMERIK 840D sl Supplementary Functions Manual: Digital and analog NCK I/Os for SINUMERIK 840D sl.
- Specific information on the individual machine data can be found in the online help of SINUMERIK Operate.
4.5 Configuring PROFINET IO with IRT

4.5.13 Assigning I/O addresses to the NCU machine data

Procedure

To enter addresses configured in the TIA Portal, proceed as follows:

1. Check in the TIA Portal which addresses you have assigned to the I/O modules (see Configuring IO modules or drive telegrams (Page 94)).

2. Transfer the addresses to the following machine data (e.g. via SINUMERIK Operate):

<table>
<thead>
<tr>
<th>MD</th>
<th>Identifier</th>
<th>Description</th>
<th>Concerns the module type</th>
</tr>
</thead>
<tbody>
<tr>
<td>10500</td>
<td>$MN_DPIO_LOGIC_ADDRESS_IN</td>
<td>Logical slot address of the PROFIBUS/PROFINET I/O</td>
<td>Input module</td>
</tr>
<tr>
<td>10501</td>
<td>$MN_DPIO_RANGE_LENGTH_IN</td>
<td>Length of the PROFIBUS/PROFINET I/O range</td>
<td>Input module</td>
</tr>
<tr>
<td>10510</td>
<td>$MN_DPIO_LOGIC_ADDRESS_OUT</td>
<td>Logical slot address of the PROFIBUS/PROFINET I/O</td>
<td>Output module</td>
</tr>
<tr>
<td>10511</td>
<td>$MN_DPIO_RANGE_LENGTH_OUT</td>
<td>Length of the PROFIBUS/PROFINET I/O range</td>
<td>Output module</td>
</tr>
</tbody>
</table>

Use machine data with the same index in order to enter the address and the associated address length of a module. Use, for example, for the address of an input module, MD10500[1] and for the address length of the same module MD10501[1].

Example

The following example compares the configuration in the TIA Portal and the compared values in the machine data:

Table 4-1 Configuring in the TIA Portal with five IO modules

<table>
<thead>
<tr>
<th>Module</th>
<th>Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>2AI U HS</td>
<td>1020...1023</td>
</tr>
<tr>
<td>2AO U HS</td>
<td>1020...1023</td>
</tr>
<tr>
<td>4DI 24 VDC HF</td>
<td>1016.0...1016.3</td>
</tr>
<tr>
<td>4DI 24 VDC HF</td>
<td>1018.0...1018.7</td>
</tr>
<tr>
<td>8DO 24 VDC / 0.5 A HF</td>
<td>1018.0...1018.7</td>
</tr>
</tbody>
</table>

Assignment of the IO modules to the NCK machine data

MD10500  $MN_DPIO_LOGIC_ADDRESS_IN[0]=1016
MD10500  $MN_DPIO_LOGIC_ADDRESS_IN[1]=1018
MD10500  $MN_DPIO_LOGIC_ADDRESS_IN[2]=1020
MD10501  $MN_DPIO_RANGE_LENGTH_IN[0]=1
MD10501  $MN_DPIO_RANGE_LENGTH_IN[1]=1
MD10501  $MN_DPIO_RANGE_LENGTH_IN[2]=4
MD10510  $MN_DPIO_LOGIC_ADDRESS_OUT[0]=1018
Assignment of the IO modules to the NCK machine data

MD10510 $MN_DPIO_LOGIC_ADDRESS_OUT[1]=1020
MD10511 $MN_DPIO_RANGE_LENGTH_OUT[0]=1
MD10511 $MN_DPIO_RANGE_LENGTH_OUT[1]=4

Further information

- General information concerning this machine data is available in Chapter A4 of the SINUMERIK 840D sl Supplementary Functions Manual: Digital and analog NCK I/Os for SINUMERIK 840D sl.
- Specific information on the individual machine data can be found in the online help of SINUMERIK Operate.
5

5.1 Overview

The drive communication of a SINUMERIK NCU takes place via the SINAMICS Integrated subcomponent and, if applicable, via additional connected NX modules. The scope of functionality of the SINAMICS Integrated (or of an NX module) includes the functionality of a SINAMICS S120 of the corresponding firmware version:

<table>
<thead>
<tr>
<th>NCU firmware</th>
<th>SINAMICS firmware used</th>
</tr>
</thead>
<tbody>
<tr>
<td>V4.5</td>
<td>V4.5</td>
</tr>
<tr>
<td>V4.7</td>
<td>V4.7</td>
</tr>
<tr>
<td>V4.8</td>
<td>V4.9</td>
</tr>
</tbody>
</table>

You can find detailed information about drive communication, e.g. function charts, in the SINAMICS S120 List Manual for the corresponding SINAMICS version (https://support.industry.siemens.com/cs/document/109739998/).

The standard telegram configuration of a SINUMERIK NCU (Page 104) is redundantly preset in the TIA Portal and in the machine data and usually does not have to be modified. Alternatively, you can switch over to a user-defined telegram configuration (Page 110).

You can also use various standard functionalities of STEP 7 (TIA Portal) in combination with telegrams, e.g.:

- In the properties of the PLC, you can see a complete overview of the assigned I/O addresses (Page 105).
- In the PLC tag editor, you can define telegram I/O addresses as PLC tags to access them symbolically in the PLC program.

See: TIA Portal online help; keyword "Declaring PLC tags"
5.2 Standard telegram configuration

The standard telegram configuration of a SINUMERIK NCU can have different versions. This depends on the safety mode, I/O addressing scheme and the firmware version used:

- Depending on the safety mode used, different telegram types are used for safety-relevant communication. Telegram types for standard communication do not differ.

- SINAMICS Integrated V4.7 and V4.9 with Safety Integrated plus (F-PLC) uses different PROFIsafe telegram types by default. The I/O start addresses of the telegrams are identical, however.

<table>
<thead>
<tr>
<th>SINAMICS version</th>
<th>Difference</th>
</tr>
</thead>
<tbody>
<tr>
<td>V4.7 (NCU V4.7)</td>
<td>SIEMENS telegram 902 with 32-bit position value for SLS, without support of SCA.</td>
</tr>
<tr>
<td>V4.9 (NCU V4.8)</td>
<td>SIEMENS telegram 903 with different process data for SCA, limited process data for SLS.</td>
</tr>
</tbody>
</table>

Thus, the options and I/O addresses of the process data for controlling the SLS (safely limited speed) and SCA (safe cams) are different.

- The optimized I/O addressing scheme (Page 107) provides a larger coherent address area for other purposes and therefore uses different telegram I/O addresses (except for PROFIsafe telegrams).

A telegram configuration with an optimized I/O addressing scheme is considered the standard telegram configuration in this sense, but nevertheless requires additional adaptations of the machine data (via SINUMERIK Operate) (Page 134).

**Note**

_Safety Integrated plus (F-PLC): Different I/O addresses for telegram 701 in NCU V4.7 (TIA Portal) and NCU ≥ V4.7 SP2 (machine data)_

If you configure an NCU V4.7 (TIA Portal) but the firmware V4.7 SP2 (or higher) is used in the actual hardware, the preset I/O addresses from the Siemens telegram 701 in the TIA Portal do not match those in the machine data (MD10393).

- To establish compatibility with NCU firmware ≥ V4.7 SP2, you can adapt the I/O addresses in the configuration.

  See: Calling the telegram configuration (Page 111), Viewing I/O addresses in the TIA Portal (Page 105), PROFIsafe/PROFIdrive telegrams for Safety Integrated plus (F-PLC) (Page 130)

- Alternatively, you can adapt the I/O addresses in the machine data. In this case, your telegram configuration is considered as user-defined telegram configuration.

  See also: Synchronizing user-specific adaptations (Page 136), PROFIsafe/PROFIdrive telegrams for Safety Integrated plus (F-PLC) (Page 130)
5.3 Viewing I/O addresses in the TIA Portal

Requirement

- An NCU has been inserted
- The project view is active

Procedure

To display a complete overview of the assigned I/O addresses, proceed as follows:

1. Click the PLC subcomponent on the NCU.
2. Click "Properties > General" in the inspector window and then click "Address overview" in the sector tree.

Result

The Address overview is displayed:

![Address overview in the "Properties" inspector window of the PLC](image-url)

Figure 5-1 Address overview in the "Properties" inspector window of the PLC
You can view all I/O addresses in the address overview and filter them with the checkboxes to display Inputs, Outputs, Address gaps and Slots.

**Note**

**I/O addresses cannot be changed in the address overview**

If you want to change I/O addresses assigned in the TIA Portal, e.g. because insufficient suitable address space is available, you must switch to the properties of the peer (e.g. SINAMICS Integrated). There are several ways of switching to these properties:

- To jump directly to the configuration of a specific I/O address, right-click the appropriate line in the Address overview and then select "Go to..." in the shortcut menu.
- Alternatively, click the appropriate component (SINAMICS Integrated or NX) for example in the network view, then switch to "Properties > General > Telegram configuration" in the inspector window.

**Further information**

Commissioning Manual, CNC Commissioning: NC, PLC, Drive, Section Communication between NC and drive.
5.4 Changing the addressing schematic

The selected addressing schematic determines the principle according to which the I/O addresses of the telegrams are assigned by drive objects and influences the address range that is available for other purposes.

This addressing schematic is thus valid for the SINAMICS Integrated of the NCU as well as all NX modules. The addressing schematic is also assigned to NX modules that were connected retrospectively.

You can choose between two different I/O addressing schematics:

- **Standard I/O addressing schematic**
  - Addressing scheme, as known from the SINUMERIK Toolbox for STEP 7 V5.5.
  - The available address range for diagnostic addresses or additional peripherals is divided up and available at the start and at the end of the overall address range.
  - The I/O addresses of the telegrams are assigned in the middle of the address range and correspond to the presetting in the machine data.

- **I/O addressing schematic optimized for I/O address extension**
  - Larger, coherent address range for diagnostic addresses or additional peripherals at the start of the overall address range.
  - The telegram I/O addresses are assigned in descending order from the end of the overall address range and must be entered in the machine data (Page 135).
Procedure

In order to change the schematic for the assignment of telegram I/O addresses of SINAMICS Integrated (and of all connected NX modules), proceed as follows:

1. Click the NCU in the network or device view and select the "Addressing schematic" entry in the "Properties" inspector window under "General".

2. Click the "Change addressing schematic" button. The "Change I/O addressing schematic" dialog opens. If you select an option, the effects of the change are listed here.

3. Select the required I/O addressing schematic and confirm the reconfiguration with "Yes".

Result

The I/O addressing schematic was changed.

If you use the optimized I/O addressing schematic, you must additionally enter the I/O addresses in the machine data (Page 135) e.g. via SINUMERIK Operate.

If problems occur during the changeover, you can find further information in the "Info" inspector window at "General".
5.5 Resetting telegrams

With the command "Reset telegrams" in the properties of SINAMICS Integrated (or an NX module), you can reset the telegram configuration in the TIA Portal to the standard telegram configuration (Page 104). All telegrams in the device are deleted.

**Note**

**Settings that deviate from the standard telegram configuration (e.g. additional telegrams) are deleted**

If you reset the telegram configuration, settings that have been added retrospectively or user-specific settings are lost (e.g. added drive objects, telegrams, or changed I/O addresses).

After resetting you can, of course, customize (Page 110) the telegram configuration again.

As long as the project has not been saved, you can undo the resetting of the telegrams together with the changed settings: Click "Undo" in the toolbar.

**Procedure**

In order to reset the telegram configuration of SINAMICS Integrated or an NX module, proceed as follows:

1. Select the device in the device view:
   - To reset the telegrams of SINAMICS Integrated, select SINAMICS Integrated.
   - To reset the telegrams of an NX, select the NX.

2. In the inspector window, click "Reset telegrams" under "Properties > General".

3. Click the "Reset telegrams" button and confirm the confirmation message with "Yes".

**Result**

The existing telegrams were deleted and the standard telegram configuration (Page 104) inserted.

As many drive objects (including appropriately configured telegrams) were automatically inserted as are supported by the corresponding SINAMICS Integrated or the NX module drives.
5.6 Displaying or adapting the telegram configuration

5.6.1 Overview

You can call (Page 111) the telegram configuration via the properties of SINAMICS Integrated or NX.

Using a user-defined telegram configuration

A telegram configuration which differs from a standard telegram configuration (Page 104) due to adaptations of any kind is called a user-defined telegram configuration:

- Adapting the configured number of drives (Page 119)
- Other changes in the overview for telegram configuration (Page 112) or in the properties for the send telegram (actual value) (Page 113) or receive telegram (setpoint value) (Page 116):
  - Adding or removing telegrams
  - Adding telegram extensions
  - Changing I/O start addresses
  - Changing the telegram types used

The use of a user-defined telegram configuration leads to greater commissioning, upgrading and migration effort, because you must make the adaptations redundantly (in the TIA Portal and in SINUMERIK Operate) and these are not automatically imported during an upgrade or migration.

You can reset (Page 109) the telegram configuration in the TIA Portal to the standard telegram configuration.
5.6.2 Calling the telegram configuration

The telegram configuration is part of the device properties (SINAMICS Integrated or NX).

Procedure

Proceed as follows to display an overview of all configured telegrams:

1. Select the device in the device view:
   - To display the telegram configuration of the SINAMICS Integrated of an NCU, select SINAMICS Integrated.
   - To display the telegram configuration of an NX, select the NX.

2. In the inspector window, click "Telegram configuration" under "Properties > General".

Result

An overview of all of the telegrams configured on the device is displayed.

- Structure of the "Telegram configuration" dialog (Page 112)

When you click on one of the lower-level elements (e.g. "Send (actual value)"), you switch to the complete properties of the drive object or telegram.

- Changing the properties of receive telegrams (setpoint) (Page 116)
- Changing the properties of send telegrams (actual value) (Page 113)

See also

Adapting the number of drives (Page 119)
5.6.3 Structure of the "Telegram configuration" dialog

You can find an overview of all of the telegrams that are configured for the SINAMICS Integrated or an NX in the properties of the corresponding device under "Telegram configuration".

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the drive object or telegram channel. Display of communication direction (send/receive) and, if applicable, purpose, actual value/setpoint value.</td>
</tr>
<tr>
<td>Element</td>
<td>Positioning the element in the telegram configuration.</td>
</tr>
<tr>
<td>Telegram</td>
<td>Display or setting of the telegram type used. The standard setting (Page 104) depends on the NCU/NX device version and the Safety Integrated mode (Page 164) that is set. The selectable telegram types depend on the purpose of the telegram (Page 120).</td>
</tr>
<tr>
<td>Length</td>
<td>Length of the telegram in bytes or words. The telegram length depends on the telegram type used.</td>
</tr>
<tr>
<td>Extension</td>
<td>Display of the extension of the relevant telegram in words or setting, if supported by the telegram type.</td>
</tr>
<tr>
<td>Direction</td>
<td>Communication direction (setpoint/actual value direction)</td>
</tr>
<tr>
<td>Type</td>
<td>Type of communication:</td>
</tr>
<tr>
<td></td>
<td>MS = Master-slave communication for PROFIBUS DP</td>
</tr>
<tr>
<td></td>
<td>F-MS = PROFIsafe-specific master-slave communication</td>
</tr>
<tr>
<td>Partner</td>
<td>Name of the PLC assigned as communication partner.</td>
</tr>
<tr>
<td>Partner data area</td>
<td>I/O address range of the communication partner (PLC). The Partner data area of a telegram (one each for actual value and setpoint) results from the I/O start address and the telegram length in bytes (1 word = 2 bytes).</td>
</tr>
</tbody>
</table>
5.6.4 Changing the properties of send telegrams (actual value)

In the telegram properties "Send (actual value)" or "Send safety telegram (actual value)", all configurable properties of the corresponding object are displayed.

You can edit the parameters for the actual values of the communication between the drive and the controller. The communication direction is from the drive to the partner.

The settings relevant for PROFIsafe are marked in yellow and are only displayed if SINUMERIK Safety Integrated plus is active and a PROFIsafe telegram has been selected.

**WARNING**

Checking the PROFIsafe telegrams

The setting of the PROFIsafe telegrams under "Telegram configuration" is not password-protected. If you are working with PROFIsafe telegrams, re-check the setting of the PROFIsafe telegrams over the course of the safety acceptance inspection to be sure that the selected PROFIsafe telegram corresponds to the requirements of your application.

![Telegram properties - Send (actual value) based on the example of SIEMENS telegram 136](image)

Table 5-1 Parameters of the properties "Send (actual value)" or "Send safety telegram (actual value)"

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Drive</th>
<th>Controller</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the drive in the project</td>
<td>Name of the assigned PLC.</td>
</tr>
<tr>
<td>Role</td>
<td>Slave</td>
<td>Master</td>
</tr>
<tr>
<td>PROFIBUS address</td>
<td>PROFIBUS address of the slave</td>
<td>PROFIBUS address of the master</td>
</tr>
<tr>
<td>Telegram</td>
<td>Display or setting of the telegram type used. The standard setting (Page 104) depends on the</td>
<td></td>
</tr>
</tbody>
</table>
### Configuring telegrams and drive units

#### 5.6 Displaying or adapting the telegram configuration

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Drive</th>
<th>Controller</th>
</tr>
</thead>
<tbody>
<tr>
<td>Telegram (PROFIsafe)</td>
<td>NCU/NX device version and the Safety Integrated mode (Page 164) that is set. The selectable telegram types depend on the purpose of the telegram.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>•   Telegrams for PROFIdrive communication (Page 120)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>•   PROFIsafe telegrams (Page 122)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>•   Additional PROFIdrive telegrams for Safety Integrated plus (F-PLC) (Page 123)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>•   Additional PROFIdrive telegrams for Safety Integrated (SPL) (Page 121)</td>
<td></td>
</tr>
<tr>
<td>F address</td>
<td>PROFIsafe address of the destination (F_Dest_Add). The address is used for clear identification of the destination.</td>
<td>PROFIsafe address of the source (F_Source_Add). The address is used for clear identification of the source.</td>
</tr>
<tr>
<td>(only PROFIsafe)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Slot</td>
<td>Slot in the device</td>
<td></td>
</tr>
<tr>
<td>Start address</td>
<td>Display of the process data word (PZD)</td>
<td>Currently set start address for the configured module. You can accept or change the address.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If you change the start address for an actual value, the start address is also adapted for the setpoint.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Only PROFIsafe: The start address is part of the F-I/O DB-name of this telegram. If you change the start address, the F-I/O DB-number will also be changed.</td>
</tr>
<tr>
<td>Length</td>
<td>Length of the telegram in bytes or words. The telegram length depends on the telegram type used.</td>
<td></td>
</tr>
<tr>
<td>Extension</td>
<td>Display of the extension of the relevant telegram in words or setting, if supported by the telegram type.</td>
<td></td>
</tr>
<tr>
<td>Consistency</td>
<td>The use of various consistency areas is useful to optimize the performance of an S7-CPU. Consistency areas that are longer than two words must be edited with system functions. You can use the effective Load/Transfer commands for consistency areas up to two words.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Total length:</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>The consistency applies for all data of this slot. This default entry should usually be sufficient.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Unit:</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>The consistency applies for one process data word. You must configure at least a &quot;2&quot; word &quot;Total length&quot; for the transfer of a double word.</td>
<td></td>
</tr>
<tr>
<td>Process image</td>
<td>Display of the process image (partition), which is used to consistently transfer the data.</td>
<td></td>
</tr>
<tr>
<td>Interrupt OB number</td>
<td>Specification of the interrupt OB number for the output of diagnostic information.</td>
<td></td>
</tr>
<tr>
<td>Manual assignment of the F-Watchdog</td>
<td>If this option is activated, you have the capability of assigning the F-monitoring time manually. Otherwise the F-monitoring time will be assigned according to the global parameterization at the interface (DP interface &gt; F-parameters).</td>
<td></td>
</tr>
<tr>
<td>time (only PROFIsafe)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>F-monitoring time</td>
<td>Monitoring time in the fail-safe DP standard slave/IO standard device/PA field device. A valid, current safety telegram must arrive from the F-CPU within the monitoring time. This ensures that failures and errors are detected and the appropriate reactions triggered to keep the safety system in a safe state or to transfer it to a safe state.</td>
<td></td>
</tr>
<tr>
<td>(only PROFIsafe)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Manual assignment of the F-I/O DB</td>
<td>If this option is activated, you have the capability of assigning the F-I/O DB-number manually. Otherwise it is assigned by the F system.</td>
<td></td>
</tr>
<tr>
<td>number (only PROFIsafe)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Configuring telegrams and drive units

#### 5.6 Displaying or adapting the telegram configuration

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Drive</th>
<th>Controller</th>
</tr>
</thead>
<tbody>
<tr>
<td>F-I/O DB number (only PROFIsafe)</td>
<td>Here you assign a number for the F-I/O DB. The adjustable value range depends upon the value range for DBs set in the Safety Administration Editor (area &quot;Settings &gt; Assign numbers for F-system blocks&quot;), or is automatically managed by the F-system.</td>
<td></td>
</tr>
<tr>
<td>F-I/O DB name (only PROFIsafe)</td>
<td>The name of the F-I/O DB is displayed here. The start address is part of the F-I/O DB-name of this telegram. If you change the start address, the F-I/O DB-number will also be changed. The F-I/O DB is located at the following point in the project navigation: &quot;Controller (e.g. CNC_1 &gt; PLC 1) &gt; Program blocks &gt; System blocks &gt; STEP 7 Safety &gt; F-I/O DBs&quot;</td>
<td></td>
</tr>
</tbody>
</table>
5.6.5 Changing the properties of receive telegrams (setpoint)

In the telegram properties "Receive (setpoint)" or "Receive safety telegram (setpoint)", all configurable properties of the corresponding object are displayed.

You can edit the parameters for the setpoints of the communication between the drive and the controller. The communication direction is from the partner to the drive.

The settings relevant for PROFiSafe are marked in yellow and are only displayed if SINUMERIK Safety Integrated plus is active and a PROFiSafe telegram has been selected.

![Telegram properties - Receive (setpoint value) based on the example of SIEMENS telegram 136](image)

Table 5-2 Parameters of the properties "Receive (setpoint value)" or "Receive safety telegram (setpoint value)"

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Drive</th>
<th>Controller</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the drive in the project</td>
<td>Name of the assigned PLC.</td>
</tr>
<tr>
<td>Role</td>
<td>Slave</td>
<td>Master</td>
</tr>
<tr>
<td>PROFIBUS address</td>
<td>PROFIBUS address of the slave</td>
<td>PROFIBUS address of the master (cannot be changed).</td>
</tr>
</tbody>
</table>
### Configuring telegrams and drive units

#### 5.6 Displaying or adapting the telegram configuration

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Drive</th>
<th>Controller</th>
</tr>
</thead>
<tbody>
<tr>
<td>Telegram</td>
<td>Display or setting of the telegram type used. The standard setting (Page 104) depends on the NCU/NX device version and the Safety Integrated mode (Page 164) that is set. The selectable telegram types depend on the purpose of the telegram.</td>
<td></td>
</tr>
<tr>
<td>Telegram (PROFIsafe)</td>
<td>• Telegrams for PROFIdrive communication (Page 120)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• PROFIsafe telegrams (Page 122)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Additional PROFIdrive telegrams for Safety Integrated plus (F-PLC) (Page 123)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Additional PROFIdrive telegrams for Safety Integrated (SPL) (Page 121)</td>
<td></td>
</tr>
<tr>
<td>F address</td>
<td>PROFIsafe address of the destination (F_Dest_Add)</td>
<td>PROFIsafe address of the source (F_Source_Add)</td>
</tr>
<tr>
<td>(only PROFIsafe)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Slot</td>
<td>Slot in the device</td>
<td></td>
</tr>
<tr>
<td>Start address</td>
<td>Display of the process data word (PZD)</td>
<td>The currently set start address for the configured module that you can accept or change. If you change the start address for a setpoint value, the start address is also adapted for the actual value. Only PROFIsafe: The start address is part of the F-I/O DB-name of this telegram. If you change the start address, the F-I/O DB-number will also be changed.</td>
</tr>
<tr>
<td>Length</td>
<td>Length of the telegram in bytes or words. The telegram length depends on the telegram type used.</td>
<td></td>
</tr>
<tr>
<td>Extension</td>
<td>Display of the extension of the relevant telegram in words or setting, if supported by the telegram type.</td>
<td></td>
</tr>
<tr>
<td>Consistency</td>
<td>The use of various consistency areas is useful to optimize the performance of an S7-CPU. Consistency areas that are longer than two words must be edited with system functions. You can use the effective Load/Transfer commands for consistency areas up to two words. <strong>Total length:</strong> The consistency applies for all data of this slot. This default entry should usually be sufficient. <strong>Unit:</strong> The consistency applies for one process data word. You must configure at least a &quot;2&quot; word &quot;Total length&quot; for the transfer of a double word.</td>
<td></td>
</tr>
<tr>
<td>Process image</td>
<td>Display of the process image (partition), which is used to consistently transfer the data.</td>
<td></td>
</tr>
<tr>
<td>Interrupt OB number</td>
<td>Specification of the interrupt OB number for the output of diagnostic information.</td>
<td></td>
</tr>
<tr>
<td>Manual assignment of the F-Watchdog time (only PROFIsafe)</td>
<td>If this option is activated, you have the capability of assigning the F-monitoring time manually. Otherwise the F-monitoring time will be assigned according to the global parameterization at the interface (DP interface &gt; F-parameters).</td>
<td></td>
</tr>
</tbody>
</table>
### Configuring telegrams and drive units

#### 5.6 Displaying or adapting the telegram configuration

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Drive</th>
<th>Controller</th>
</tr>
</thead>
</table>
| F-monitoring time (only PROFIsafe)             | Monitoring time in the fail-safe DP standard slave/I/O standard device/PA field device.  
A valid, current safety telegram must arrive from the F-CPU within the monitoring time. This ensures that failures and errors are detected and the appropriate reactions triggered to keep the safety system in a safe state. |                                                                            |
| Manual assignment of the F-I/O DB number (only PROFIsafe) | If this option is activated, you have the capability of assigning the F-I/O DB-number manually. Otherwise it is assigned by the F system. |                                                                            |
| F-I/O DB number (only PROFIsafe)                | Here you assign a number for the F-I/O DB.  
The adjustable value range depends upon the value range for DBs set in the Safety Administration Editor (area "Settings > Assign numbers for F-system blocks"), or is automatically managed by the F-system. |                                                                            |
| F-I/O DB name (only PROFIsafe)                  | The name of the F-I/O DB is displayed here.  
The start address is part of the F-I/O DB-name of this telegram. If you change the start address, the F-I/O DB-number will also be changed.  
The F-I/O DBs are located at the following point in the project navigation: "Controller (e.g. CNC_1 > PLC 1) > Program blocks > System blocks > STEP 7 Safety > F-I/O DBs" |                                                                            |
5.6.6 Adapting the number of drives

When an NCU or NX module is inserted, the appropriate number of drive objects (incl. appropriate configured telegrams) that the associated NCU or NX module supports are inserted automatically. These standard settings correspond to the standard settings in the NCK (e.g. configurable via SINUMERIK Operate).

Even if you use fewer than the maximum number of drives of an appropriate NCU or NX module, you do not need to make any changes here.

If, however, for specific reasons, you make adaptations, you must make them both in the TIA Portal for the PLC and for the NCK (e.g. via SINUMERIK Operate).

Information concerning the commissioning of SINUMERIK Operate is contained in the Base Software and Operating Software Commissioning Manual.

Procedure

Proceed as follows to adapt the number of drives:

1. Select the device in the device view:
   - To configure the drive objects of the SINAMICS Integrated of an NCU, select SINAMICS Integrated.
   - To configure the drive objects of an NX, select the NX.

2. In the inspector window, click "Telegram configuration" under "Properties > General".

3. You can delete and add drive objects or add individual telegrams under "Telegram configuration".
   - To delete a drive object, right-click the drive object and select "Delete" in the shortcut menu.
   - To add a drive object, click the "<Add new drive object>" command in the "Name" column.
   - To add a user-defined telegram, click the "<Add new telegram>" command in the "Name" column of the associated drive object.
5.7 Available telegram types

5.7.1 Telegrams for the transfer of standard data (PROFIdrive)

The standard telegram configuration (Page 104) of a SINUMERIK NCU uses the following telegram types for PROFIdrive communication (standard data):

Table 5-3 Telegrams for PROFIdrive communication

<table>
<thead>
<tr>
<th>Profile</th>
<th>Designation</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>PROFIdrive</td>
<td>SIEMENS telegram 136</td>
<td>Manufacturer-specific telegram. Permits the use of the following data:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Dynamic Servo Control (DSC)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Torque feedforward control</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 2 position encoders (encoder 1 and encoder 2)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 4 trace signals</td>
</tr>
<tr>
<td>SIEMENS telegram 390</td>
<td></td>
<td>Manufacturer-specific telegram for PROFIdrive communication.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Permits the use of the following data:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Access to onboard I/O of the CU</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Use of the control and status word of the CU (CU_STW, CU_ZSW)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This telegram is used by NX modules for PROFIdrive communication.</td>
</tr>
<tr>
<td>SIEMENS telegram 391</td>
<td></td>
<td>Manufacturer-specific telegram for PROFIdrive communication.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Permits the use of the following data:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Access to onboard I/O of the CU</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Use of the control and status word of the CU (CU_STW, CU_ZSW)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Central measuring probe evaluation of up to 2 probes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This telegram is used by the NCU for PROFIdrive communication between NC and DRIVE.</td>
</tr>
<tr>
<td>SIEMENS telegram 370</td>
<td></td>
<td>Manufacturer-specific telegram for communication of the infeed (Infeed / Active Infeed (A_INF)).</td>
</tr>
</tbody>
</table>

For the purpose of implementing a user-defined telegram configuration (Page 110), you can also configure other telegram types for transferring standard data.
Further information

You will find a brief description of all configurable telegram types in the TIA Portal in the tooltip for the telegram. Detailed information can be found in the respective function block diagrams in the SINAMICS S120/S150 List Manual (https://support.industry.siemens.com/cs/document/109739998/).

<table>
<thead>
<tr>
<th>Telegram</th>
<th>Function diagram</th>
</tr>
</thead>
<tbody>
<tr>
<td>1…9</td>
<td>2415</td>
</tr>
<tr>
<td>20…83</td>
<td>2416</td>
</tr>
<tr>
<td>102…116</td>
<td>2419</td>
</tr>
<tr>
<td>118…166</td>
<td>2420</td>
</tr>
<tr>
<td>220…371</td>
<td>2421</td>
</tr>
<tr>
<td>390…396</td>
<td>2422</td>
</tr>
</tbody>
</table>

### 5.7.2 Telegrams in SINUMERIK Safety Integrated (SPL) mode

The standard telegram configuration (Page 104) of a SINUMERIK NCU with Safety Integrated plus (SPL) uses the "SI Motion Monitoring" telegram for safety-oriented communication. This telegram is also available with inactive safety mode in the configuration, but is then not used.

**Table 5-4 Telegrams for SINUMERIK Safety Integrated (SPL)**

<table>
<thead>
<tr>
<th>Profile</th>
<th>Designation</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>PROFIdrive</td>
<td>SI Motion Monitoring</td>
<td>Safety-related communication (SPL) in SINUMERIK Safety Integrated (SPL) mode.</td>
</tr>
</tbody>
</table>

Further information

You will find a brief description of all configurable telegram types in the TIA Portal in the tooltip for the telegram. Detailed information can be found in the respective function block diagrams in the SINAMICS S120/S150 List Manual (https://support.industry.siemens.com/cs/document/109739998/).

<table>
<thead>
<tr>
<th>Telegram</th>
<th>Function diagram</th>
</tr>
</thead>
<tbody>
<tr>
<td>SI Motion Monitoring (40)</td>
<td>2416</td>
</tr>
</tbody>
</table>
5.7 Available telegram types

5.7.3 Telegrams for PROFIsafe communication

The standard telegram configuration (Page 104) of a SINUMERIK NCU with Safety Integrated plus (F-PLC) uses the following telegram types for PROFIsafe communication:

Table 5-5 Telegrams for control by way of PROFIsafe

<table>
<thead>
<tr>
<th>Profile</th>
<th>Designation</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>PROFIdrive (PROFIsafe)</td>
<td>SIEMENS telegram 902</td>
<td>Extended manufacturer-specific telegram with 32-bit position value. Default setting for internal NC drives with SINAMICS firmware V4.7.</td>
</tr>
<tr>
<td></td>
<td>SIEMENS telegram 903</td>
<td>Extended manufacturer-specific telegram with 32-Bit-Safe Cam (S_ZSW_CAM1). Default setting for internal NC drives as of SINAMICS firmware V4.9.</td>
</tr>
</tbody>
</table>

For the purpose of implementing a user-defined telegram configuration (Page 110), you can also configure other telegram types for PROFIsafe communication.

Further information

You will find a brief description of all configurable telegram types in the TIA Portal in the tooltip for the telegram. Detailed information can be found in the respective function block diagrams in the SINAMICS S120/S150 List Manual (https://support.industry.siemens.com/cs/document/109739998/).

<table>
<thead>
<tr>
<th>Telegram</th>
<th>Function diagram</th>
</tr>
</thead>
<tbody>
<tr>
<td>30…31</td>
<td>2915</td>
</tr>
<tr>
<td>901…903</td>
<td>2916</td>
</tr>
</tbody>
</table>
5.7.4  Telegrams for SIC/SCC communication

The standard telegram configuration (Page 104) of a SINUMERIK NCU with Safety Integrated plus (F-PLC) uses the following telegram types for SIC/SCC communication:

Table 5-6  Telegrams for control via PROFIsafe and SIC/SCC (PROFIdrive)

<table>
<thead>
<tr>
<th>Profile</th>
<th>Designation</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>PROFIdrive (SIC/SCC)</td>
<td>SIEMENS telegram 701</td>
<td>Manufacturer-specific telegram for SIC/SCC communication. With SINUMERIK, SIC/SCC communication only takes place via telegram 701.</td>
</tr>
</tbody>
</table>

For the purpose of implementing a user-defined telegram configuration (Page 110), you can also configure telegram 700.

Further information

You will find a brief description of all configurable telegram types in the TIA Portal in the tooltip for the telegram. Detailed information can be found in the respective function block diagrams in the SINAMICS S120/S150 List Manual (https://support.industry.siemens.com/cs/document/109739998/).

<table>
<thead>
<tr>
<th>Telegram</th>
<th>Function diagram</th>
</tr>
</thead>
<tbody>
<tr>
<td>700...701</td>
<td>2423</td>
</tr>
</tbody>
</table>
5.8 Adapting I/O start addresses

5.8.1 Introduction

Telegram configuration and I/O addressing schematics

The I/O addresses of the NX and SINAMICS Integrated components for communication between the NCU and the drive are entered in the TIA Portal and in the machine data of the NCU.

In order that the I/O addresses match in the TIA Portal and in the machine data of the NCU, they are identical by default and correspond to the standard I/O addressing schematic.

If you use the expanded I/O addressing schematic or have made user-specific adjustments to the telegram configuration, you must synchronize these I/O addresses between TIA Portal and machine data.

Note

Safety Integrated plus (F-PLC): Different I/O addresses for telegram 701 in NCU V4.7 (TIA Portal) ad NCU ≥ V4.7 SP2 (machine data)

If you configure an NCU V4.7 (TIA Portal) but the firmware V4.7 SP2 (or higher) is used in the actual hardware, the preset I/O addresses from the Siemens telegram 701 in the TIA Portal do not match those in the machine data (MD10393).

- To establish compatibility with NCU firmware ≥ V4.7 SP2, you can adapt the I/O addresses in the configuration.
  - See: Calling the telegram configuration (Page 111), Viewing I/O addresses in the TIA Portal (Page 105), PROFlsafe/PROFldrive telegrams for Safety Integrated plus (F-PLC) (Page 130)
- Alternatively, you can adapt the I/O addresses in the machine data. In this case, your telegram configuration is considered as user-defined telegram configuration.
  - See also: Synchronizing user-specific adaptations (Page 136), PROFlsafe/PROFldrive telegrams for Safety Integrated plus (F-PLC) (Page 130)

Telegrams used by default

- Which telegrams are used by default depends on the SINUMERIK Safety Integrated mode.
- Which I/O start addresses are assigned to the telegrams by default depends on the I/O addressing schematic used.
- The Partner data area of a telegram (one each for actual value and setpoint) results from the I/O start address and the telegram length in bytes (1 WORD = 2 bytes). The telegram length depends on the telegram type used.
### Table 5-7 Telegrams used by default in the safety modes

<table>
<thead>
<tr>
<th>Designation</th>
<th>Partner data area</th>
<th>Used in mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIEMENS Telegramm 136</td>
<td>19 Words</td>
<td>These telegrams transfer standard data and are used in all safety modes:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Inactive safety functionality</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Safety Integrated (SPL)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Safety Integrated plus (F-PLC)</td>
</tr>
<tr>
<td>SIEMENS Telegramm 390</td>
<td>2 Words</td>
<td></td>
</tr>
<tr>
<td>SIEMENS Telegramm 391</td>
<td>7 Words</td>
<td></td>
</tr>
<tr>
<td>SIEMENS Telegramm 370</td>
<td>1 Words</td>
<td></td>
</tr>
<tr>
<td>SI Motion Monitoring</td>
<td>12 Words</td>
<td>• Safety Integrated (SPL) Comment: This telegram is also available with</td>
</tr>
<tr>
<td></td>
<td></td>
<td>inactive safety mode in the telegram configuration, but is then not used.</td>
</tr>
<tr>
<td>SIEMENS Telegramm 902</td>
<td>16 Bytes</td>
<td>• Safety Integrated plus (F-PLC) When using the NCU firmware V4.7</td>
</tr>
<tr>
<td>SIEMENS Telegramm 903</td>
<td>14 Bytes</td>
<td>• Safety Integrated plus (F-PLC) When using the NCU firmware V4.8 (or higher)</td>
</tr>
<tr>
<td>SIEMENS Telegramm 701</td>
<td>5 Words</td>
<td>• Safety Integrated plus (F-PLC)</td>
</tr>
</tbody>
</table>

**Machine data to be configured**

You must adapt the following machine data if you do not use the default I/O addressing schematic:

- MD10393 $MN_SAFE_DRIVE_LOGIC_ADDRESS
- MD13050 $MN_DRIVE_LOGIC_ADDRESS

Specific information on the individual machine data can be found in the online help of SINUMERIK Operate.

The following tables show the machine data (MD) of the NCU in which a specific I/O start address is entered.
5.8 Adapting I/O start addresses

### 5.8.2 PROFIdrive telegrams for standard data

Table 5-8 SINAMICS Integrated: I/O addresses of PROFIdrive telegrams

<table>
<thead>
<tr>
<th>Drive</th>
<th>Telegram type</th>
<th>I/O address</th>
<th>Machine data</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Standard addressing</td>
<td>Optimized addressing</td>
</tr>
<tr>
<td>Drive_Axis_1</td>
<td>SIEMENS telegram 136</td>
<td>4100</td>
<td>15700</td>
</tr>
<tr>
<td>Drive_Axis_2</td>
<td>SIEMENS telegram 136</td>
<td>4140</td>
<td>15620</td>
</tr>
<tr>
<td>Drive_Axis_3</td>
<td>SIEMENS telegram 136</td>
<td>4180</td>
<td>15540</td>
</tr>
<tr>
<td>Drive_Axis_4</td>
<td>SIEMENS telegram 136</td>
<td>4220</td>
<td>15460</td>
</tr>
<tr>
<td>Drive_Axis_5</td>
<td>SIEMENS telegram 136</td>
<td>4260</td>
<td>15380</td>
</tr>
<tr>
<td>Drive_Axis_6</td>
<td>SIEMENS telegram 136</td>
<td>4300</td>
<td>15300</td>
</tr>
<tr>
<td>Drive_CU_1</td>
<td>SIEMENS telegram 391</td>
<td>6500</td>
<td>15780</td>
</tr>
<tr>
<td>Infeed_1</td>
<td>SIEMENS telegram 370</td>
<td>6514</td>
<td>15830</td>
</tr>
</tbody>
</table>

Table 5-9 NX on DRIVE-CLiQ socket X105; DP address 15: I/O addresses of PROFIdrive telegrams

<table>
<thead>
<tr>
<th>Drive</th>
<th>Telegram type</th>
<th>I/O address</th>
<th>Machine data</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Standard addressing</td>
<td>Optimized addressing</td>
</tr>
<tr>
<td>Drive_Axis_1</td>
<td>SIEMENS telegram 136</td>
<td>4340</td>
<td>15150</td>
</tr>
<tr>
<td>Drive_Axis_2</td>
<td>SIEMENS telegram 136</td>
<td>4380</td>
<td>15070</td>
</tr>
<tr>
<td>Drive_Axis_3</td>
<td>SIEMENS telegram 136</td>
<td>4420</td>
<td>14990</td>
</tr>
<tr>
<td>Drive_Axis_4</td>
<td>SIEMENS telegram 136</td>
<td>4460</td>
<td>14910</td>
</tr>
<tr>
<td>Drive_Axis_5</td>
<td>SIEMENS telegram 136</td>
<td>4500</td>
<td>14830</td>
</tr>
<tr>
<td>Drive_Axis_6</td>
<td>SIEMENS telegram 136</td>
<td>4540</td>
<td>14750</td>
</tr>
<tr>
<td>Drive_CU_1</td>
<td>SIEMENS telegram 390</td>
<td>6530</td>
<td>15230</td>
</tr>
<tr>
<td>Infeed_1</td>
<td>SIEMENS telegram 370</td>
<td>6534</td>
<td>15280</td>
</tr>
</tbody>
</table>

Table 5-10 NX on DRIVE-CLiQ socket X104; DP address 14: I/O addresses of PROFIdrive telegrams

<table>
<thead>
<tr>
<th>Drive</th>
<th>Telegram type</th>
<th>I/O address</th>
<th>Machine data</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Standard addressing</td>
<td>Optimized addressing</td>
</tr>
<tr>
<td>Drive_Axis_1</td>
<td>SIEMENS telegram 136</td>
<td>4580</td>
<td>14600</td>
</tr>
<tr>
<td>Drive_Axis_2</td>
<td>SIEMENS telegram 136</td>
<td>4620</td>
<td>14520</td>
</tr>
<tr>
<td>Drive_Axis_3</td>
<td>SIEMENS telegram 136</td>
<td>4660</td>
<td>14440</td>
</tr>
<tr>
<td>Drive_Axis_4</td>
<td>SIEMENS telegram 136</td>
<td>4700</td>
<td>14360</td>
</tr>
<tr>
<td>Drive_Axis_5</td>
<td>SIEMENS telegram 136</td>
<td>4740</td>
<td>14280</td>
</tr>
<tr>
<td>Drive_Axis_6</td>
<td>SIEMENS telegram 136</td>
<td>4780</td>
<td>14200</td>
</tr>
<tr>
<td>Drive_CU_1</td>
<td>SIEMENS telegram 390</td>
<td>6560</td>
<td>14680</td>
</tr>
<tr>
<td>Infeed_1</td>
<td>SIEMENS telegram 370</td>
<td>6554</td>
<td>14730</td>
</tr>
</tbody>
</table>
### Table 5-11  NX on DRIVE-CLiQ socket X103; DP address 13: I/O addresses of PROFIdrive telegrams

<table>
<thead>
<tr>
<th>Drive</th>
<th>Telegram type</th>
<th>I/O address</th>
<th>Machine data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drive_Axis_1</td>
<td>SIEMENS telegram 136</td>
<td>4820</td>
<td>14050</td>
</tr>
<tr>
<td>Drive_Axis_2</td>
<td>SIEMENS telegram 136</td>
<td>4860</td>
<td>13970</td>
</tr>
<tr>
<td>Drive_Axis_3</td>
<td>SIEMENS telegram 136</td>
<td>4900</td>
<td>13890</td>
</tr>
<tr>
<td>Drive_Axis_4</td>
<td>SIEMENS telegram 136</td>
<td>4940</td>
<td>13810</td>
</tr>
<tr>
<td>Drive_Axis_5</td>
<td>SIEMENS telegram 136</td>
<td>4980</td>
<td>13730</td>
</tr>
<tr>
<td>Drive_Axis_6</td>
<td>SIEMENS telegram 136</td>
<td>5020</td>
<td>13650</td>
</tr>
<tr>
<td>Drive_CU_1</td>
<td>SIEMENS telegram 390</td>
<td>6590</td>
<td>14130</td>
</tr>
<tr>
<td>Infeed_1</td>
<td>SIEMENS telegram 370</td>
<td>6574</td>
<td>14180</td>
</tr>
</tbody>
</table>

### Table 5-12  NX on DRIVE-CLiQ socket X102; DP address 12: I/O addresses of PROFIdrive telegrams

<table>
<thead>
<tr>
<th>Drive</th>
<th>Telegram type</th>
<th>I/O address</th>
<th>Machine data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drive_Axis_1</td>
<td>SIEMENS telegram 136</td>
<td>5060</td>
<td>13500</td>
</tr>
<tr>
<td>Drive_Axis_2</td>
<td>SIEMENS telegram 136</td>
<td>5100</td>
<td>13420</td>
</tr>
<tr>
<td>Drive_Axis_3</td>
<td>SIEMENS telegram 136</td>
<td>5140</td>
<td>13340</td>
</tr>
<tr>
<td>Drive_Axis_4</td>
<td>SIEMENS telegram 136</td>
<td>5180</td>
<td>13260</td>
</tr>
<tr>
<td>Drive_Axis_5</td>
<td>SIEMENS telegram 136</td>
<td>5220</td>
<td>13180</td>
</tr>
<tr>
<td>Drive_Axis_6</td>
<td>SIEMENS telegram 136</td>
<td>5260</td>
<td>13100</td>
</tr>
<tr>
<td>Drive_CU_1</td>
<td>SIEMENS telegram 390</td>
<td>6620</td>
<td>13580</td>
</tr>
<tr>
<td>Infeed_1</td>
<td>SIEMENS telegram 370</td>
<td>6594</td>
<td>13630</td>
</tr>
</tbody>
</table>

### Table 5-13  NX on DRIVE-CLiQ socket X101; DP address 11: I/O addresses of PROFIdrive telegrams

<table>
<thead>
<tr>
<th>Drive</th>
<th>Telegram type</th>
<th>I/O address</th>
<th>Machine data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drive_Axis_1</td>
<td>SIEMENS telegram 136</td>
<td>5300</td>
<td>12950</td>
</tr>
<tr>
<td>Drive_Axis_2</td>
<td>SIEMENS telegram 136</td>
<td>5340</td>
<td>12870</td>
</tr>
<tr>
<td>Drive_Axis_3</td>
<td>SIEMENS telegram 136</td>
<td>5380</td>
<td>12790</td>
</tr>
<tr>
<td>Drive_Axis_4</td>
<td>SIEMENS telegram 136</td>
<td>5420</td>
<td>12710</td>
</tr>
<tr>
<td>Drive_Axis_5</td>
<td>SIEMENS telegram 136</td>
<td>5460</td>
<td>12630</td>
</tr>
<tr>
<td>Drive_Axis_6</td>
<td>SIEMENS telegram 136</td>
<td>5500</td>
<td>12550</td>
</tr>
<tr>
<td>Drive_CU_1</td>
<td>SIEMENS telegram 390</td>
<td>6650</td>
<td>13030</td>
</tr>
<tr>
<td>Infeed_1</td>
<td>SIEMENS telegram 370</td>
<td>6614</td>
<td>13080</td>
</tr>
</tbody>
</table>
### Configuring telegrams and drive units

#### 5.8 Adapting I/O start addresses

Table 5-14 NX on DRIVE-CLiQ socket X100; DP address 10: I/O addresses of PROFIdrive telegrams

<table>
<thead>
<tr>
<th>Drive</th>
<th>Telegram type</th>
<th>I/O address</th>
<th>Machine data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drive_Axis_1</td>
<td>SIEMENS telegram 136</td>
<td>5540</td>
<td>13050[36]</td>
</tr>
<tr>
<td>Drive_Axis_2</td>
<td>SIEMENS telegram 136</td>
<td>5580</td>
<td>13050[37]</td>
</tr>
<tr>
<td>Drive_Axis_3</td>
<td>SIEMENS telegram 136</td>
<td>5620</td>
<td>13050[38]</td>
</tr>
<tr>
<td>Drive_Axis_4</td>
<td>SIEMENS telegram 136</td>
<td>5660</td>
<td>13050[39]</td>
</tr>
<tr>
<td>Drive_Axis_5</td>
<td>SIEMENS telegram 136</td>
<td>5700</td>
<td>13050[40]</td>
</tr>
<tr>
<td>Drive_Axis_6</td>
<td>SIEMENS telegram 136</td>
<td>5740</td>
<td>13050[41]</td>
</tr>
<tr>
<td>Drive_CU_1</td>
<td>SIEMENS telegram 390</td>
<td>6680</td>
<td>12480</td>
</tr>
<tr>
<td>Infeed_1</td>
<td>SIEMENS telegram 370</td>
<td>6634</td>
<td>12530</td>
</tr>
</tbody>
</table>

#### 5.8.3 PROFIdrive telegrams for Safety Integrated (SPL)

Table 5-15 SINAMICS Integrated: I/O addresses of telegram SI Motion Monitoring

<table>
<thead>
<tr>
<th>Drive</th>
<th>Telegram type</th>
<th>I/O address</th>
<th>Machine data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drive_Axis_1</td>
<td>SI Motion Monitoring</td>
<td>6700</td>
<td>10393[0]</td>
</tr>
<tr>
<td>Drive_Axis_2</td>
<td>SI Motion Monitoring</td>
<td>6724</td>
<td>10393[1]</td>
</tr>
<tr>
<td>Drive_Axis_3</td>
<td>SI Motion Monitoring</td>
<td>6748</td>
<td>10393[2]</td>
</tr>
<tr>
<td>Drive_Axis_4</td>
<td>SI Motion Monitoring</td>
<td>6772</td>
<td>10393[3]</td>
</tr>
<tr>
<td>Drive_Axis_5</td>
<td>SI Motion Monitoring</td>
<td>6796</td>
<td>10393[4]</td>
</tr>
<tr>
<td>Drive_Axis_6</td>
<td>SI Motion Monitoring</td>
<td>6820</td>
<td>10393[5]</td>
</tr>
</tbody>
</table>

Table 5-16 NX on DRIVE-CLiQ socket X105; DP address 15: I/O addresses of telegram SI Motion Monitoring

<table>
<thead>
<tr>
<th>Drive</th>
<th>Telegram type</th>
<th>I/O address</th>
<th>Machine data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drive_Axis_1</td>
<td>SI Motion Monitoring</td>
<td>6844</td>
<td>10393[6]</td>
</tr>
<tr>
<td>Drive_Axis_2</td>
<td>SI Motion Monitoring</td>
<td>6868</td>
<td>10393[7]</td>
</tr>
<tr>
<td>Drive_Axis_3</td>
<td>SI Motion Monitoring</td>
<td>6892</td>
<td>10393[8]</td>
</tr>
<tr>
<td>Drive_Axis_4</td>
<td>SI Motion Monitoring</td>
<td>6916</td>
<td>10393[9]</td>
</tr>
<tr>
<td>Drive_Axis_5</td>
<td>SI Motion Monitoring</td>
<td>6940</td>
<td>10393[10]</td>
</tr>
<tr>
<td>Drive_Axis_6</td>
<td>SI Motion Monitoring</td>
<td>6964</td>
<td>10393[11]</td>
</tr>
</tbody>
</table>
Configuring telegrams and drive units

5.8 Adapting I/O start addresses

Table 5- 17  NX on DRIVE-CLiQ socket X104; DP address 14: I/O addresses of telegram SI Motion Monitoring

<table>
<thead>
<tr>
<th>Drive</th>
<th>Telegram type</th>
<th>I/O address</th>
<th>Machine data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drive_Axis_1</td>
<td>SI Motion Monitoring</td>
<td>6988</td>
<td>14656</td>
</tr>
<tr>
<td>Drive_Axis_2</td>
<td>SI Motion Monitoring</td>
<td>7012</td>
<td>14576</td>
</tr>
<tr>
<td>Drive_Axis_3</td>
<td>SI Motion Monitoring</td>
<td>7036</td>
<td>14496</td>
</tr>
<tr>
<td>Drive_Axis_4</td>
<td>SI Motion Monitoring</td>
<td>7060</td>
<td>14416</td>
</tr>
<tr>
<td>Drive_Axis_5</td>
<td>SI Motion Monitoring</td>
<td>7084</td>
<td>14336</td>
</tr>
<tr>
<td>Drive_Axis_6</td>
<td>SI Motion Monitoring</td>
<td>7108</td>
<td>14256</td>
</tr>
</tbody>
</table>

Table 5- 18  NX on DRIVE-CLiQ socket X103; DP address 13: I/O addresses of telegram SI Motion Monitoring

<table>
<thead>
<tr>
<th>Drive</th>
<th>Telegram type</th>
<th>I/O address</th>
<th>Machine data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drive_Axis_1</td>
<td>SI Motion Monitoring</td>
<td>7132</td>
<td>14106</td>
</tr>
<tr>
<td>Drive_Axis_2</td>
<td>SI Motion Monitoring</td>
<td>7156</td>
<td>14026</td>
</tr>
<tr>
<td>Drive_Axis_3</td>
<td>SI Motion Monitoring</td>
<td>7180</td>
<td>13946</td>
</tr>
<tr>
<td>Drive_Axis_4</td>
<td>SI Motion Monitoring</td>
<td>7204</td>
<td>13866</td>
</tr>
<tr>
<td>Drive_Axis_5</td>
<td>SI Motion Monitoring</td>
<td>7228</td>
<td>13786</td>
</tr>
<tr>
<td>Drive_Axis_6</td>
<td>SI Motion Monitoring</td>
<td>7252</td>
<td>13706</td>
</tr>
</tbody>
</table>

Table 5- 19  NX on DRIVE-CLiQ socket X102; DP address 12: I/O addresses of telegram SI Motion Monitoring

<table>
<thead>
<tr>
<th>Drive</th>
<th>Telegram type</th>
<th>I/O address</th>
<th>Machine data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drive_Axis_1</td>
<td>SI Motion Monitoring</td>
<td>7276</td>
<td>13556</td>
</tr>
<tr>
<td>Drive_Axis_2</td>
<td>SI Motion Monitoring</td>
<td>7300</td>
<td>13476</td>
</tr>
<tr>
<td>Drive_Axis_3</td>
<td>SI Motion Monitoring</td>
<td>7324</td>
<td>13396</td>
</tr>
<tr>
<td>Drive_Axis_4</td>
<td>SI Motion Monitoring</td>
<td>7348</td>
<td>13316</td>
</tr>
<tr>
<td>Drive_Axis_5</td>
<td>SI Motion Monitoring</td>
<td>7372</td>
<td>13236</td>
</tr>
<tr>
<td>Drive_Axis_6</td>
<td>SI Motion Monitoring</td>
<td>7396</td>
<td>13156</td>
</tr>
</tbody>
</table>

Table 5- 20  NX on DRIVE-CLiQ socket X101; DP address 11: I/O addresses of telegram SI Motion Monitoring

<table>
<thead>
<tr>
<th>Drive</th>
<th>Telegram type</th>
<th>I/O address</th>
<th>Machine data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drive_Axis_1</td>
<td>SI Motion Monitoring</td>
<td>7420</td>
<td>13006</td>
</tr>
<tr>
<td>Drive_Axis_2</td>
<td>SI Motion Monitoring</td>
<td>7444</td>
<td>12926</td>
</tr>
<tr>
<td>Drive_Axis_3</td>
<td>SI Motion Monitoring</td>
<td>7468</td>
<td>12846</td>
</tr>
<tr>
<td>Drive_Axis_4</td>
<td>SI Motion Monitoring</td>
<td>7492</td>
<td>12766</td>
</tr>
<tr>
<td>Drive_Axis_5</td>
<td>SI Motion Monitoring</td>
<td>7516</td>
<td>12686</td>
</tr>
<tr>
<td>Drive_Axis_6</td>
<td>SI Motion Monitoring</td>
<td>7540</td>
<td>12606</td>
</tr>
</tbody>
</table>
Configuring telegrams and drive units

5.8 Adapting I/O start addresses

Table 5-21 NX on DRIVE-CLiQ socket X100; DP address 10: I/O addresses of telegram SI Motion Monitoring

<table>
<thead>
<tr>
<th>Drive</th>
<th>Telegram type</th>
<th>I/O address</th>
<th>Standard addressing schematic</th>
<th>Optimized addressing schematic</th>
<th>Machine data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drive_Axis_1</td>
<td>SI Motion Monitoring</td>
<td>7564</td>
<td>12456</td>
<td>10393[36]</td>
<td></td>
</tr>
<tr>
<td>Drive_Axis_2</td>
<td>SI Motion Monitoring</td>
<td>7588</td>
<td>12376</td>
<td>10393[37]</td>
<td></td>
</tr>
<tr>
<td>Drive_Axis_3</td>
<td>SI Motion Monitoring</td>
<td>7612</td>
<td>12296</td>
<td>10393[38]</td>
<td></td>
</tr>
<tr>
<td>Drive_Axis_4</td>
<td>SI Motion Monitoring</td>
<td>7636</td>
<td>12216</td>
<td>10393[39]</td>
<td></td>
</tr>
<tr>
<td>Drive_Axis_5</td>
<td>SI Motion Monitoring</td>
<td>7660</td>
<td>12136</td>
<td>10393[40]</td>
<td></td>
</tr>
<tr>
<td>Drive_Axis_6</td>
<td>SI Motion Monitoring</td>
<td>7684</td>
<td>12056</td>
<td>10393[41]</td>
<td></td>
</tr>
</tbody>
</table>

5.8.4 PROFIsafe/PROFIdrive telegrams for Safety Integrated plus (F-PLC)

Table 5-22 SINAMICS Integrated: I/O addresses of PROFIsafe/PROFIdrive telegrams

<table>
<thead>
<tr>
<th>Drive</th>
<th>Telegram type</th>
<th>I/O start address</th>
<th>Standard addressing schematic</th>
<th>Optimized addressing schematic</th>
<th>Machine data</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>≤ V4.7 SP1</td>
<td>≥ V4.7 SP2</td>
<td></td>
</tr>
<tr>
<td>Drive_Axis_1</td>
<td>SIEMENS telegram 701</td>
<td>6700</td>
<td>5800</td>
<td>15756</td>
<td>10393[0]</td>
</tr>
<tr>
<td></td>
<td>SIEMENS telegram 902/903</td>
<td>1008</td>
<td>6724</td>
<td>5816</td>
<td>15676</td>
</tr>
<tr>
<td>Drive_Axis_2</td>
<td>SIEMENS telegram 701</td>
<td>6748</td>
<td>5832</td>
<td>15596</td>
<td>10393[2]</td>
</tr>
<tr>
<td></td>
<td>SIEMENS telegram 902/903</td>
<td>976</td>
<td>6772</td>
<td>5848</td>
<td>15516</td>
</tr>
<tr>
<td>Drive_Axis_3</td>
<td>SIEMENS telegram 701</td>
<td>6796</td>
<td>5864</td>
<td>15436</td>
<td>10393[4]</td>
</tr>
<tr>
<td></td>
<td>SIEMENS telegram 902/903</td>
<td>928</td>
<td>6820</td>
<td>5880</td>
<td>15356</td>
</tr>
<tr>
<td>Drive_Axis_4</td>
<td>SIEMENS telegram 701</td>
<td>6842</td>
<td>5908</td>
<td>15276</td>
<td>10393[6]</td>
</tr>
<tr>
<td></td>
<td>SIEMENS telegram 902/903</td>
<td>954</td>
<td>6864</td>
<td>5932</td>
<td>15196</td>
</tr>
<tr>
<td>Drive_Axis_5</td>
<td>SIEMENS telegram 701</td>
<td>6884</td>
<td>5964</td>
<td>15116</td>
<td>10393[8]</td>
</tr>
<tr>
<td></td>
<td>SIEMENS telegram 902/903</td>
<td>984</td>
<td>6908</td>
<td>5990</td>
<td>15036</td>
</tr>
<tr>
<td>Drive_Axis_6</td>
<td>SIEMENS telegram 701</td>
<td>6932</td>
<td>6016</td>
<td>14956</td>
<td>10393[10]</td>
</tr>
<tr>
<td></td>
<td>SIEMENS telegram 902/903</td>
<td>994</td>
<td>6956</td>
<td>6040</td>
<td>14876</td>
</tr>
</tbody>
</table>
Table 5-23  NX on DRIVE-CLiQ socket X105; DP address 15: I/O addresses of PROFIsafe/PROFIdrive telegrams

<table>
<thead>
<tr>
<th>Drive</th>
<th>Telegram type</th>
<th>I/O start address</th>
<th>Machine data</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Standard addressing schematic</td>
<td>Optimized addressing schematic</td>
</tr>
<tr>
<td></td>
<td></td>
<td>≤ V4.7 SP1</td>
<td>≥ V4.7 SP2</td>
</tr>
<tr>
<td>Drive_Axis_1</td>
<td>SIEMENS telegram 701</td>
<td>6844</td>
<td>5896</td>
</tr>
<tr>
<td></td>
<td>SIEMENS telegram 902/903</td>
<td>912</td>
<td></td>
</tr>
<tr>
<td>Drive_Axis_2</td>
<td>SIEMENS telegram 701</td>
<td>6868</td>
<td>5912</td>
</tr>
<tr>
<td></td>
<td>SIEMENS telegram 902/903</td>
<td>896</td>
<td></td>
</tr>
<tr>
<td>Drive_Axis_3</td>
<td>SIEMENS telegram 701</td>
<td>6892</td>
<td>5928</td>
</tr>
<tr>
<td></td>
<td>SIEMENS telegram 902/903</td>
<td>880</td>
<td></td>
</tr>
<tr>
<td>Drive_Axis_4</td>
<td>SIEMENS telegram 701</td>
<td>6916</td>
<td>5944</td>
</tr>
<tr>
<td></td>
<td>SIEMENS telegram 902/903</td>
<td>864</td>
<td></td>
</tr>
<tr>
<td>Drive_Axis_5</td>
<td>SIEMENS telegram 701</td>
<td>6940</td>
<td>5960</td>
</tr>
<tr>
<td></td>
<td>SIEMENS telegram 902/903</td>
<td>848</td>
<td></td>
</tr>
<tr>
<td>Drive_Axis_6</td>
<td>SIEMENS telegram 701</td>
<td>6964</td>
<td>5976</td>
</tr>
<tr>
<td></td>
<td>SIEMENS telegram 902/903</td>
<td>832</td>
<td></td>
</tr>
</tbody>
</table>

Table 5-24  NX on DRIVE-CLiQ socket X104; DP address 14: I/O addresses of PROFIsafe/PROFIdrive telegrams

<table>
<thead>
<tr>
<th>Drive</th>
<th>Telegram type</th>
<th>I/O start address</th>
<th>Machine data</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Standard addressing schematic</td>
<td>Optimized addressing schematic</td>
</tr>
<tr>
<td></td>
<td></td>
<td>≤ V4.7 SP1</td>
<td>≥ V4.7 SP2</td>
</tr>
<tr>
<td>Drive_Axis_1</td>
<td>SIEMENS telegram 701</td>
<td>6988</td>
<td>5992</td>
</tr>
<tr>
<td></td>
<td>SIEMENS telegram 902/903</td>
<td>816</td>
<td></td>
</tr>
<tr>
<td>Drive_Axis_2</td>
<td>SIEMENS telegram 701</td>
<td>7012</td>
<td>6008</td>
</tr>
<tr>
<td></td>
<td>SIEMENS telegram 902/903</td>
<td>800</td>
<td></td>
</tr>
<tr>
<td>Drive_Axis_3</td>
<td>SIEMENS telegram 701</td>
<td>7036</td>
<td>6024</td>
</tr>
<tr>
<td></td>
<td>SIEMENS telegram 902/903</td>
<td>784</td>
<td></td>
</tr>
<tr>
<td>Drive_Axis_4</td>
<td>SIEMENS telegram 701</td>
<td>7060</td>
<td>6040</td>
</tr>
<tr>
<td></td>
<td>SIEMENS telegram 902/903</td>
<td>768</td>
<td></td>
</tr>
<tr>
<td>Drive_Axis_5</td>
<td>SIEMENS telegram 701</td>
<td>7084</td>
<td>6056</td>
</tr>
<tr>
<td></td>
<td>SIEMENS telegram 902/903</td>
<td>752</td>
<td></td>
</tr>
<tr>
<td>Drive_Axis_6</td>
<td>SIEMENS telegram 701</td>
<td>7108</td>
<td>6072</td>
</tr>
<tr>
<td></td>
<td>SIEMENS telegram 902/903</td>
<td>736</td>
<td></td>
</tr>
</tbody>
</table>
5.8 Adapting I/O start addresses

Table 5-25  NX on DRIVE-CLiQ socket X103; DP address 13: I/O addresses of PROFIsafe/PROFIdrive telegrams

<table>
<thead>
<tr>
<th>Drive</th>
<th>Telegram type</th>
<th>I/O start address</th>
<th>Machine data</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Standard addressing schematic</td>
<td>Optimized addressing schematic</td>
</tr>
<tr>
<td></td>
<td></td>
<td>≤ V4.7 SP1</td>
<td>≥ V4.7 SP2</td>
</tr>
<tr>
<td>Drive_Axis_1</td>
<td>SIEMENS telegram 701</td>
<td>7132</td>
<td>6088</td>
</tr>
<tr>
<td></td>
<td>SIEMENS telegram 902/903</td>
<td>720</td>
<td></td>
</tr>
<tr>
<td>Drive_Axis_2</td>
<td>SIEMENS telegram 701</td>
<td>7156</td>
<td>6104</td>
</tr>
<tr>
<td></td>
<td>SIEMENS telegram 902/903</td>
<td>704</td>
<td></td>
</tr>
<tr>
<td>Drive_Axis_3</td>
<td>SIEMENS telegram 701</td>
<td>7180</td>
<td>6120</td>
</tr>
<tr>
<td></td>
<td>SIEMENS telegram 902/903</td>
<td>688</td>
<td></td>
</tr>
<tr>
<td>Drive_Axis_4</td>
<td>SIEMENS telegram 701</td>
<td>7204</td>
<td>6136</td>
</tr>
<tr>
<td></td>
<td>SIEMENS telegram 902/903</td>
<td>672</td>
<td></td>
</tr>
<tr>
<td>Drive_Axis_5</td>
<td>SIEMENS telegram 701</td>
<td>7228</td>
<td>6152</td>
</tr>
<tr>
<td></td>
<td>SIEMENS telegram 902/903</td>
<td>656</td>
<td></td>
</tr>
<tr>
<td>Drive_Axis_6</td>
<td>SIEMENS telegram 701</td>
<td>7252</td>
<td>6168</td>
</tr>
<tr>
<td></td>
<td>SIEMENS telegram 902/903</td>
<td>640</td>
<td></td>
</tr>
</tbody>
</table>

Table 5-26  NX on DRIVE-CLiQ socket X102; DP address 12: I/O addresses of PROFIsafe/PROFIdrive telegrams

<table>
<thead>
<tr>
<th>Drive</th>
<th>Telegram type</th>
<th>I/O start address</th>
<th>Machine data</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Standard addressing schematic</td>
<td>Optimized addressing schematic</td>
</tr>
<tr>
<td></td>
<td></td>
<td>≤ V4.7 SP1</td>
<td>≥ V4.7 SP2</td>
</tr>
<tr>
<td>Drive_Axis_1</td>
<td>SIEMENS telegram 701</td>
<td>7276</td>
<td>6184</td>
</tr>
<tr>
<td></td>
<td>SIEMENS telegram 902/903</td>
<td>624</td>
<td></td>
</tr>
<tr>
<td>Drive_Axis_2</td>
<td>SIEMENS telegram 701</td>
<td>7300</td>
<td>6200</td>
</tr>
<tr>
<td></td>
<td>SIEMENS telegram 902/903</td>
<td>608</td>
<td></td>
</tr>
<tr>
<td>Drive_Axis_3</td>
<td>SIEMENS telegram 701</td>
<td>7324</td>
<td>6216</td>
</tr>
<tr>
<td></td>
<td>SIEMENS telegram 902/903</td>
<td>592</td>
<td></td>
</tr>
<tr>
<td>Drive_Axis_4</td>
<td>SIEMENS telegram 701</td>
<td>7348</td>
<td>6232</td>
</tr>
<tr>
<td></td>
<td>SIEMENS telegram 902/903</td>
<td>576</td>
<td></td>
</tr>
<tr>
<td>Drive_Axis_5</td>
<td>SIEMENS telegram 701</td>
<td>7372</td>
<td>6248</td>
</tr>
<tr>
<td></td>
<td>SIEMENS telegram 902/903</td>
<td>560</td>
<td></td>
</tr>
<tr>
<td>Drive_Axis_6</td>
<td>SIEMENS telegram 701</td>
<td>7396</td>
<td>6264</td>
</tr>
<tr>
<td></td>
<td>SIEMENS telegram 902/903</td>
<td>544</td>
<td></td>
</tr>
</tbody>
</table>
### Table 5-27 NX on DRIVE-CLiQ socket X101; DP address 11: I/O addresses of PROFIsafe/PROFIdrive telegrams

<table>
<thead>
<tr>
<th>Drive</th>
<th>Telegram type</th>
<th>I/O start address</th>
<th>Machine data</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>≤ V4.7 SP1</td>
<td>≥ V4.7 SP2</td>
</tr>
<tr>
<td>Drive_Axis_1</td>
<td>SIEMENS telegram 701</td>
<td>7420</td>
<td>6280</td>
</tr>
<tr>
<td></td>
<td>SIEMENS telegram 902/903</td>
<td>528</td>
<td></td>
</tr>
<tr>
<td>Drive_Axis_2</td>
<td>SIEMENS telegram 701</td>
<td>7444</td>
<td>6296</td>
</tr>
<tr>
<td></td>
<td>SIEMENS telegram 902/903</td>
<td>512</td>
<td></td>
</tr>
<tr>
<td>Drive_Axis_3</td>
<td>SIEMENS telegram 701</td>
<td>7468</td>
<td>6312</td>
</tr>
<tr>
<td></td>
<td>SIEMENS telegram 902/903</td>
<td>496</td>
<td></td>
</tr>
<tr>
<td>Drive_Axis_4</td>
<td>SIEMENS telegram 701</td>
<td>7492</td>
<td>6328</td>
</tr>
<tr>
<td></td>
<td>SIEMENS telegram 902/903</td>
<td>480</td>
<td></td>
</tr>
<tr>
<td>Drive_Axis_5</td>
<td>SIEMENS telegram 701</td>
<td>7516</td>
<td>6344</td>
</tr>
<tr>
<td></td>
<td>SIEMENS telegram 902/903</td>
<td>464</td>
<td></td>
</tr>
<tr>
<td>Drive_Axis_6</td>
<td>SIEMENS telegram 701</td>
<td>7540</td>
<td>6360</td>
</tr>
<tr>
<td></td>
<td>SIEMENS telegram 902/903</td>
<td>448</td>
<td></td>
</tr>
</tbody>
</table>

### Table 5-28 NX on DRIVE-CLiQ socket X100; DP address 10: I/O addresses of PROFIsafe/PROFIdrive telegrams

<table>
<thead>
<tr>
<th>Drive</th>
<th>Telegram type</th>
<th>I/O start address</th>
<th>Machine data</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>≤ V4.7 SP1</td>
<td>≥ V4.7 SP2</td>
</tr>
<tr>
<td>Drive_Axis_1</td>
<td>SIEMENS telegram 701</td>
<td>7564</td>
<td>6376</td>
</tr>
<tr>
<td></td>
<td>SIEMENS telegram 902/903</td>
<td>432</td>
<td></td>
</tr>
<tr>
<td>Drive_Axis_2</td>
<td>SIEMENS telegram 701</td>
<td>7588</td>
<td>6392</td>
</tr>
<tr>
<td></td>
<td>SIEMENS telegram 902/903</td>
<td>416</td>
<td></td>
</tr>
<tr>
<td>Drive_Axis_3</td>
<td>SIEMENS telegram 701</td>
<td>7612</td>
<td>6408</td>
</tr>
<tr>
<td></td>
<td>SIEMENS telegram 902/903</td>
<td>400</td>
<td></td>
</tr>
<tr>
<td>Drive_Axis_4</td>
<td>SIEMENS telegram 701</td>
<td>7636</td>
<td>6424</td>
</tr>
<tr>
<td></td>
<td>SIEMENS telegram 902/903</td>
<td>384</td>
<td></td>
</tr>
<tr>
<td>Drive_Axis_5</td>
<td>SIEMENS telegram 701</td>
<td>7660</td>
<td>6440</td>
</tr>
<tr>
<td></td>
<td>SIEMENS telegram 902/903</td>
<td>368</td>
<td></td>
</tr>
<tr>
<td>Drive_Axis_6</td>
<td>SIEMENS telegram 701</td>
<td>7684</td>
<td>6456</td>
</tr>
<tr>
<td></td>
<td>SIEMENS telegram 902/903</td>
<td>352</td>
<td></td>
</tr>
</tbody>
</table>
5.9 Deviations from the standard I/O addressing schematic

5.9.1 Overview

Use of the optimized I/O addressing schematic

If you use the optimized I/O addressing schematic, you must activate it in TIA Portal (Page 107) and you must enter the I/O addresses in the machine data, e.g. via SINUMERIK Operate (Page 135).

Use of user-specific adaptations of an addressing schematic

In some cases when configuring in the TIA Portal, the preset default I/O addresses for the communication with the drive have already been assigned, e.g.:

- If you added telegrams that are not part of the default telegram configuration.
- If you have subsequently changed the size of the process image.
- If you have subsequently changed the Safety Integrated mode.
- If you have subsequently added NX modules.

A message is then displayed in the TIA Portal, indicating that you must check the telegram configuration. The actual procedure depends on whether suitable alternative I/O addresses could be assigned:

- Suitable alternative I/O addresses have been assigned in the TIA Portal that do not match the standard I/O addresses in the machine data of the NCU. In this case, you must align the I/O addresses in the TIA Portal with the I/O addresses in the machine data of the NCU (Page 136).

- There are not enough suitable I/O addresses available in the TIA Portal. In this case, you must release suitable I/O addresses in the TIA Portal, re-assign them and then align them with the I/O addresses in the machine data of the NCU. See: Availability of suitable I/O addresses (Page 138).

If you do not want to make these settings at this time, and have not saved the project, you can undo the changes: Click "Undo" in the toolbar.
5.9.2 Matching of deviating I/O addresses

5.9.2.1 Matching I/O addresses for use of the optimized I/O addressing schematic

If you use the optimized I/O addressing schematic, you must activate it in TIA Portal and you must enter the I/O addresses in the machine data, e.g. via SINUMERIK Operate.

Requirement

- I/O addressing schematic optimized for I/O address extension has been selected.  
  See also: Changing the addressing schematic (Page 107)
- No user-specific adaptations to I/O addresses exist.  
  If you have made user-specific adaptations, refer to Chapter Matching user-specific adaptations (Page 136).

Procedure

To enter the I/O addresses of the optimized addressing schematic in the machine data, proceed as follows:

1. Call or print out the tabular overview for the addressing schematic:
   - Adapting I/O start addresses (Page 124)
2. In SINUMERIK Operate, enter the I/O addresses of all related drives into the corresponding machine datum (MD).  
   For how to change to the machine data in SINUMERIK Operate, refer to the Commissioning Manual, "CNC Commissioning: NCK, PLC, Drive for TIA", Section "Communication between NC and drive".
5.9 Deviations from the standard I/O addressing schematic

5.9.2.2 Matching user-specific adaptations

Default I/O addresses are preset in the machine data of the NCU during the first commissioning that match the default I/O addresses in the TIA Portal. If these default I/O addresses were already assigned during a configuration change (e.g. change of the Safety Integrated mode), proceed as follows:

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1    | Check which I/O addresses in the TIA Portal differ from the standard I/O addressing schematic. There are several ways to find differing I/O addresses:  
  • Check the messages in the inspector window, "Info > General" (Page 136)  
  • Check the address overview in the PLC properties (Page 138) |
| 2    | Check in which machine data (MD) of the NCU the differing I/O address is entered. To do this, use the tabular overview (Page 124) corresponding to the Safety Integrated mode. |
| 3    | Enter the differing I/O addresses in the associated machine data (MD) in SINUMERIK Operate. For how to change to the machine data in SINUMERIK Operate, refer to the Commissioning Manual, "CNC Commissioning: NCK, PLC, Drive for TIA", Section "Communication between NC and drive". |

5.9.3 Viewing messages in the info area

If, after a configuration change, e.g. deviations from the standard schema, the I/O addresses cause conflicts, you can view this information in the message log until the TIA Portal is restarted. This message log is displayed in various inspector windows depending on the message type:

- For example, messages displayed when the device configuration is changed are listed under "Info > General".
- Some conflicts are checked only during the compilation. Such messages are not displayed under "Info > General", but rather under "Info > Compile".

Check these messages in order to be able to align the entries for the I/O addresses between the TIA Portal and the NCU machine data.

The most recent message is always displayed in the status line of the TIA Portal (lower left). This shows at any time whether conflicts have occurred.

The message log is deleted when the TIA Portal is closed or restarted. Consequently, rectify or note any conflicts before you exit the TIA Portal. If this is not possible, you can discard the changes that caused the conflicts or display the information in some other way (e.g. in the address overview (Page 105)) before exiting.

Requirement

The default I/O addresses were already assigned at a configuration change (or during the compilation) so that alternative valid I/O addresses were assigned.
Procedure

To directly view after a configuration change (or after the compile) which I/O addresses differ from the standard schema, proceed as follows:

1. Click “General” or “Compile” in the "Info" inspector window. The message log is displayed.

![Figure 5-5 The "Info > General" inspector window shows which default I/O addresses were already assigned for each individual telegram.](image)

The inspector window has the following options:

- All components and telegrams that differ from the default scheme are listed in the "Message" column.
- To switch directly to the detail view of the respective component or I/O address, click the symbol in the "Go to" column.
- To call the associated help entry in the information system of the TIA Portal, click the symbol in the "?" column.

2. Note the required information.
5.9.4 Availability of suitable I/O addresses

If the message is displayed that insufficient suitable I/O addresses are available, you must release suitable I/O addresses.

Basic procedure

Release suitable I/O addresses
Check whether you can release suitable address space with one of the following procedures:

- If the associated addresses are PROFIsafe addresses, zoom the process image of the OB1 in the PLC properties under "Cycle".
- Check which device is occupying the required address range. You may be able to assign a different address space to this device in order to release the required I/O addresses.
- Release address space directly by removing empty space that is not required between different I/O addresses and adapting the I/O addresses of the relevant device.

Assign suitable I/O addresses
You must then assign suitable I/O addresses to the relevant devices in the TIA Portal. Devices without suitable I/O addresses are displayed as follows:

- Select the appropriate component (SINAMICS Integrated or NX), then click "Telegram configuration" in the "Properties" inspector window. Cells with unsuitable I/O addresses are highlighted in red.
- If a message showing which I/O addresses were not available has already been displayed, you can view these in the "Info" inspector window at "General".

Align the I/O addresses with the machine data of the NCU
Finally, enter the assignment of the I/O address different to the default scheme in the machine data of the NCU. Refer to Adapting I/O start addresses (Page 124) to find the machine data in which you must align the corresponding I/O address.

See also:
- Online help of SINUMERIK Operate
- Commissioning Manual, "Commissioning CNC: NCK, PLC, Drive", Section Communication between NC and drive
Configuring I/O

6.1 Inserting ADI4 module (840 sl)

Procedure

In order to insert an ADI4 module into the project via the hardware catalog, proceed as follows:

1. In the hardware catalog, navigate to the folder "Distributed I/O > Drive Interfaces > ADI4" and select the ADI4 module.

2. Use drag-and-drop to move the ADI4 module from the hardware catalog and place it in the network view.
3. To connect the module to the master system, click "Not assigned" and select the DP interface.

4. Click the "PROFIBUS_1" bus system and at "General > Network settings" in the "Properties" tab in the inspector window, change the "Transmission rate" entry from 1.5 Mbit/s to 12 Mbit/s. The ADI4 module can only be operated with 12 Mbit/s.

Reference

You can find additional information on the precise parameter assignment of the ADI4 module in the "ADI4 - analog drive interface for four axes" manual.
Result

The ADI4 module has been created as new device and connected to the NCU.
6.2 Installing general station description files for SINUMERIK I/O

Requirement

The current version of the general station description (GSD/GSDML) files to be installed is stored on your PG/PC.

Note

General station description files on the Service&Support pages

You can find the current versions of the general station description files in the Siemens Industry Online Support:

SINUMERIK I/O: GSD/GSDML files (SIOS)

Procedure

To install SINUMERIK I/O via general station description files, proceed as follows:

1. In the "Options" menu, select the command "Manage general station description files (GSD)".
2. In the "Manage general station description files" dialog, select the folder that contains the GSD/GSDML files.

The device description files saved in the source path are listed.
3. Select the checkboxes of the files that you want to install.

4. Confirm your entry with "Install".

Result

The general station description files are installed, and then the SINUMERIK I/O in the hardware catalog displayed in the appropriate folders:

- SINUMERIK I/O for PROFINET IO: "Further field devices > PROFINET IO > I/O > SIEMENS AG > SINUMERIK"

- SINUMERIK I/O for PROFIBUS DP: "Further field devices > PROFIBUS DP > NC/RC > SIEMENS AG > MOTION CONTROL"

Figure 6-1  Installed SINUMERIK I/O in the hardware catalog
6.3 Inserting the SINUMERIK I/O module PP72/48

Requirement

- The respective PROFIBUS GSD file or PROFINET GSDML file is installed.
  See: Installing general station description files for SINUMERIK I/O (Page 142)
- The network view is active.

Procedure

Proceed as follows to insert a PP72/48 I/O module:

1. In the hardware catalog, navigate to the respective device:
   - PP72/48 (PROFIBUS): "Further field devices > PROFIBUS DP > NC/RC > SIEMENS AG > MOTION CONTROL"
   - PP72/48 (PROFINET): "Further field devices > PROFINET IO > I/O > SIEMENS AG > SINUMERIK > PP72/48"

2. Use drag-and-drop to move the PP72/48 from the hardware catalog to the network view.

3. Interconnect the inserted SINUMERIK I/O with the NCU.
   See TIA Portal online help, search term "Interconnect devices in the network view"
Result

The SINUMERIK I/O modules were created as new devices and connected to the NCU.

Additional information

You can find general information about the device in the SINUMERIK I/O module PP72/48D 2/2A PN manual.
6.4 Inserting SINUMERIK MCP/MPP

Requirement

- The respective PROFIBUS GSD file or PROFINET GSDML file is installed. See: Installing general station description files for SINUMERIK I/O (Page 142)
- The network view is active.

Procedure

Proceed as follows to insert a SINUMERIK MCP/MPP:

1. In the hardware catalog, navigate to the respective device:
   - MCP/MPP (PROFIBUS): "Further field devices > PROFIBUS DP > NC/RC > SIEMENS AG > MOTION CONTROL"
   - MCP/MPP (PROFINET): "Further field devices > PROFINET IO > I/O > SIEMENS AG > SINUMERIK"

2. Use drag-and-drop to move the corresponding MCP/MPP from the hardware catalog to the network view.

3. Interconnect the inserted SINUMERIK I/O with the NCU. See TIA Portal online help, search term "Interconnect devices in the network view"
**Result**

The SINUMERIK MCP/MPP has been created as new device and connected to the NCU.

**Additional information**

General information on the device can be found in the respective manual.
7.1 NC VAR selector

Introduction

The external tool "NC VAR Selector" obtains addresses of the required NC tags and processes them for access in the PLC program (PUT [FB3] and GET [FB2]).

- In the NC VAR Selector, you can select the required NC and drive tag addresses and save them as ASCII file (*.STL) (Page 150).
- In the TIA Portal, you can import this STL file (Page 152), use it to create data blocks and to make program access to the tags.

Further information

- A detailed description for the NC VAR Selector is contained in the P3 section of the SINUMERIK 840D sl Basic Functions Manual: PLC basic program for SINUMERIK 840D sl.
- The block descriptions and other information about the PLC basic program are contained in the P3 section of the SINUMERIK 840D sl Basic Functions Manual. Basic PLC program.
7.2 Selecting tags and saving as STL file

**Requirement**

- The "NC-VAR-Selector" program is installed. The program is installed automatically when installing the SINUMERIK Toolbox if you have selected the program during installation.

**Procedure**

To select the NC tags to be configured and save them as an STL file, proceed as follows:

1. In the Start menu, click on "All Programs > NC Tag Selector 32 Bit > NCVar Selector". NC-VAR Selector opens.

2. Select the firmware version of the configured NCU in the "Software version" drop-down list.

3. Select "New" from the "Project" menu.

4. Add all of the necessary tags from the "NcData" and "Sinamics" tag lists into your project list in the bottom section. The following options are available:
   - You can sort the tags in ascending or descending order by column captions.
   - The command "Find, Filter" gives you various filter criteria.
   - If you double-click on a tag name, a configuration dialog with a help entry for this tag is displayed.
   - To add a tag to your project list, double-click on the tag name, adapt the values "Area No.", "Row" and "Column" if applicable and confirm with "OK".
5. Save your project data (*.var).

6. In the "Code" menu, click on "Generate", select a save location for your NC tag file (*.stl) and confirm with "Save".

Result

The selected tag addresses were saved in an STL file, which you can use in the TIA Portal.
7.3 Adding a tag file (STL) in the TIA Portal

Procedure

To add the STL file with the selected tags in the TIA Portal as an external source, proceed as follows:

1. In the project tree, select "CNC > PLC > External source files > Add new external file".

2. Then generate the data block via the shortcut menu "Generate blocks from source".

Result

You can now address the selected variables in your PLC program and use the PUT [FB3] and GET [FB2] blocks to write and read the variables.

Note

Displaying external sources (e.g. STL files) using an external editor

The internal editor of the TIA Portal does not display external sources.

If you add and open an external source in the TIA Portal, the file will be opened with the application linked with the associated file type (e.g. STL) in Windows (e.g. Microsoft Editor).

In order to be able to open external sources directly from the TIA Portal with any external editor, define this once in Windows.
Importing user alarms

8.1 Overview

The procedure overview below describes how to copy the SINUMERIK user alarm files directly from a PCU 50.5 or NCU and import them into TIA Portal.

Alternatively, the import of alarm files in CSV format is also supported. This can, for example, be created if you manage your language-dependent text files with SINUMERIK Integrate Access My Machine /P2P.

Requirement

- The user alarms are available in SINUMERIK Operate (or AMM).
- A SINUMERIK NCU or device proxy (PLC 300) is inserted in the TIA Portal project.

Procedure overview

To use SINUMERIK user alarms in the TIA Portal, proceed as follows:

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1    | Make the user alarm files available in the required languages. The following options are available:  
  - You can copy the files via the SINUMERIK Operate user interface, for example to a USB flash drive (Page 154).  
  - You can copy the files with Windows Explorer from the following directory that is created during the installation of SINUMERIK Operate:  
    C:\Program Files (x86)\Siemens\MotionControl\oem\Sinumerik\hmi\lng |
| 2    | Check whether all languages or language variants in which you want to import SINUMERIK user alarms are enabled as project languages in the TIA Portal.  
  - To check which exported alarm files correspond to which project languages in the TIA Portal, refer to Section Language assignment in language-dependent texts (Page 155).  
  - How to activate the project languages is described in Section Enable project languages (Page 157). |
| 3    | Import the SINUMERIK user alarms into the TIA Portal (Page 158). |
8.2 Exporting TS files from SINUMERIK Operate

This chapter describes how you export the DB2 alarms using the user interface of SINUMERIK Operate.

If you have installed SINUMERIK Operate on a Siemens PC system, you can alternatively copy the files via the Windows Explorer.

Example for PCU 50.5 with SINUMERIK Operate for SINUMERIK 840D sl:
- C:\Program Files (x86)\Siemens\MotionControl\oem\Sinumerik\hmi\lng\ 

Precondition

- A USB flash drive is inserted at a PC system with SINUMERIK Operate.
- In SINUMERIK Operate, the USB port is activated under "Commissioning > HMI > Log. Drive"
- Access rights of access level 3 (user) are available in SINUMERIK Operate.

Procedure

To copy TS files from SINUMERIK Operate, proceed as follows:

1. In SINUMERIK Operate select the screen "Commissioning > System data" – and in the folder structure, navigate in the "HMI data/Texts/Manufacturer/" directory.
2. Select the required TS files and actuate the "Copy" softkey.
3. Select the directory structure of your USB flash drive and press the "Paste" softkey.

Result

The DB2 alarms were copied from SINUMERIK Operate as TS files.
8.3 Language assignment in language-dependent texts

Language ID in the file name of language-dependent texts

Language-dependent texts are saved in TS files in SINUMERIK Operate. There is a separate file for each language which is assigned via the language ID in the file name.

- `<Name><LanguageID>.ts`
- E. g.: `oem_alarms_plc_eng.ts`

Assignment of the DB2 alarm texts to project languages

If you import an alarm file into the TIA Portal, this will be assigned to all of the relevant activated project languages (or language variants), depending on the language ID in the file name. For example, if you have activated the project languages "English (USA)" and "English (Great Britain)" and imported an `oem_alarms_plc_eng.ts` file, these alarm texts are mapped to the two project languages.

Availability of languages in SINUMERIK Operate

SINUMERIK Operate has 6 languages (standard languages) installed in the factory state. If you need additional languages, you can order them separately:

- DVD "Language extension": 6FC5860-0YC40-0YA8
- Software option "Additional languages": 6FC5800-0AN00-0YB0

Storing the active language in the NC block [DB10]

The language that is presently active in SINUMERIK Operate is saved in communication block NC [DB10] in address DB10.DBB96 as value.

<table>
<thead>
<tr>
<th>Value in DB10.DBB96</th>
<th>Language in SINUMERIK Operate</th>
<th>Language code</th>
<th>Default language</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>German</td>
<td>deu</td>
<td>x</td>
</tr>
<tr>
<td>2</td>
<td>French</td>
<td>fra</td>
<td>x</td>
</tr>
<tr>
<td>3</td>
<td>English</td>
<td>eng</td>
<td>x</td>
</tr>
<tr>
<td>4</td>
<td>Spanish</td>
<td>esp</td>
<td>x</td>
</tr>
<tr>
<td>6</td>
<td>Italian</td>
<td>ita</td>
<td>x</td>
</tr>
<tr>
<td>7</td>
<td>Dutch</td>
<td>nld</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Simplified Chinese</td>
<td>chs</td>
<td>x</td>
</tr>
<tr>
<td>9</td>
<td>Swedish</td>
<td>sve</td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>Hungarian</td>
<td>hun</td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>Finnish</td>
<td>fin</td>
<td></td>
</tr>
<tr>
<td>28</td>
<td>Czech</td>
<td>csy</td>
<td></td>
</tr>
<tr>
<td>50</td>
<td>Portuguese</td>
<td>ptb</td>
<td></td>
</tr>
<tr>
<td>53</td>
<td>Polish</td>
<td>plk</td>
<td></td>
</tr>
<tr>
<td>55</td>
<td>Danish</td>
<td>dan</td>
<td></td>
</tr>
<tr>
<td>57</td>
<td>Russian</td>
<td>rus</td>
<td></td>
</tr>
</tbody>
</table>
## 8.3 Language assignment in language-dependent texts

<table>
<thead>
<tr>
<th>Value in DB10.DBB96</th>
<th>Language in SINUMERIK Operate</th>
<th>Language code</th>
<th>Default language</th>
</tr>
</thead>
<tbody>
<tr>
<td>68</td>
<td>Slovakian</td>
<td>sky</td>
<td></td>
</tr>
<tr>
<td>69</td>
<td>Slovenian</td>
<td>slv</td>
<td></td>
</tr>
<tr>
<td>72</td>
<td>Rumanian</td>
<td>rom</td>
<td></td>
</tr>
<tr>
<td>80</td>
<td>Traditional Chinese</td>
<td>cht</td>
<td></td>
</tr>
<tr>
<td>85</td>
<td>Korean</td>
<td>kor</td>
<td></td>
</tr>
<tr>
<td>87</td>
<td>Japanese</td>
<td>jap</td>
<td></td>
</tr>
<tr>
<td>89</td>
<td>Turkish</td>
<td>trk</td>
<td></td>
</tr>
<tr>
<td>212</td>
<td>Thai</td>
<td>tha</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Malay</td>
<td>msl</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Indonesian</td>
<td>ind</td>
<td></td>
</tr>
</tbody>
</table>
8.4 Enable project languages

The project languages are set in the "Project languages" editor. You define which project language is to be the reference language and which the editing language.

Enable project languages

1. In the project tree, click on the arrow symbol to the left of "Languages & Resources". The lower-level elements are displayed.
2. Double-click on "Project languages". The available project languages are displayed in the working area.
3. Activate the languages or language variants that should be available as project languages.

Note

Copying multilingual objects

The copies of multilingual objects to a different project only include text objects in the project languages which are activated in the target project. Activate all project languages in the target project to include the corresponding text objects when transferring the copy.

Disabling project languages

1. Disable the languages that are not be available as project languages.

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you disable a project language, all text and graphic objects you have already created in this language will be deleted from the current project.</td>
</tr>
</tbody>
</table>
8.5 Importing SINUMERIK PLC alarm texts

Requirement

- A SINUMERIK NCU or device proxy (PLC 300) is inserted.
- The TS files of the corresponding language are available on the configuration computer. See Exporting TS files from SINUMERIK Operate (Page 154)
- The languages in which the TS files are available are activated as project languages (Page 157) in the TIA Portal.

If you would like to assign a TS file that is to be imported to several language variants, enable all of the desired language variants.

Note

Please ensure that the number of alarm numbers is the same in all languages to be imported. If required, you can enter an alarm number without text in the alarm text list.

Procedure

To import SINUMERIK user alarm texts into the TIA Portal, proceed as follows:

1. In the Project tree, right-click the PLC or the device proxy, then select "Import SINUMERIK PLC alarm texts" in the shortcut menu.

   The "Import SINUMERIK PLC alarm texts" dialog opens.

   ![Import SINUMERIK PLC alarm texts dialog](image)

2. Enter the path in which you have saved the user alarm files.
3. Select the file formats which you would like to import in the "File type" drop-down list. You can only import one file per language, but you can import different files or file types for different languages.
   - TS and CSV files
   - TS files: Importing of DB2 alarm texts that were copied directly from the NCU.
   - CSV file: Importing of DB2 alarm texts that were converted beforehand into the CSV format, for example with AMM /P2P.

4. Check the checkboxes of the desired files individually or activate the higher-level checkboxes to import all of the displayed files.

5. Confirm the selection with "Import".

Result

The SINUMERIK user alarm texts have been imported and are displayed in the TIA Portal under the PLC in the "PLC messages" editor.
Importing user alarms

8.5 Importing SINUMERIK PLC alarm texts
9.1 Introduction

The integrated safety functions of SINUMERIK Safety Integrated are used in the machine tools sector. In the TIA Portal, you can select one of two Safety Integrated modes in conjunction with the SINUMERIK Toolbox:

- Safety Integrated (SPL) (general) (Page 177)
- Safety Integrated plus (F-PLC) (general) (Page 192)

Because the Safety Integrated modes must be licensed (Page 174) and configured differently, Safety Integrated is not active as default setting. You should activate the desired Safety Integrated mode directly at the start of the configuring work so that the system can assign the affected parameters automatically where possible.

The following sample configuring sequences serve as an aid for the configuring and provide an overview of this chapter content.

- Configuring Safety Integrated (SPL) (handling overview) (Page 177)
- Configuring Safety Integrated plus (F-PLC) (handling overview) (Page 194)

You can, however, make most settings for Safety Integrated in TIA Portal in any order. If you already have experience with configuring SINUMERIK Safety Integrated, you can orient yourself on the overview of the Safety Integrated relevant parameters (Page 167).
9.2 Representation of safety-related resources in the TIA Portal

Overview

Yellow markings identify all safety-related resources in the views of the TIA Portal:

- Network view, device view, topology view
- Project tree
- Hardware catalog
- Inspector window

This also applies to the SINUMERIK components:

- NCU
  Because the PLC and SINAMICS Integrated Safety subcomponents support integrated functions, the higher-level NCU is marked as safety-oriented resource.
- Integrated PLC
- Integrated SINAMICS Integrated
- NX
Figure 9-1 Marking of safety-related resources in the TIA Portal

<table>
<thead>
<tr>
<th>No.</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The project tree shows which components of your project are F-components.</td>
</tr>
<tr>
<td>2</td>
<td>In the network view, device view or topology view, the Safety Integrated marking is on the NCU, representative for the integrated components. External devices, e.g. NX, may have their own Safety Integrated marking.</td>
</tr>
<tr>
<td>3</td>
<td>Safety-related settings are marked in the “Properties” inspector window.</td>
</tr>
<tr>
<td>4</td>
<td>Folders and the devices themselves are marked in the hardware catalog. You can therefore see whether SINUMERIK Safety Integrated is supported before inserting the device.</td>
</tr>
<tr>
<td>5</td>
<td>Fail-safe devices are also marked in the information area of the hardware catalog.</td>
</tr>
</tbody>
</table>
9.3 Changing the Safety Integrated mode

Requirement

- The "SIMATIC STEP 7 Safety Advanced" option package has been installed.

Procedure

To change the Safety Integrated mode, proceed as follows:

1. Click the NCU in the network or device view and select the "Safety Integrated" entry in the "Properties" inspector window at "General".
2. Click the "Change Safety Integrated mode" button. The "Change Safety Integrated mode" dialog opens. If you select an option, the effects of the mode change are performed here.

![Change Safety Integrated mode dialog](image)

3. Select the required Safety Integrated mode and confirm the reconfiguration with "Yes".

Result

The Safety Integrated mode has been changed. The precise effects depend on the selected mode and can be seen in the "Change Safety Integrated mode" dialog (step 2).

If you are using the Safety Integrated (SPL) mode, configure next the PROFIsafe addresses (peripherals (Page 184) or drives (Page 188)).
If problems occur during the changeover, you can find further information in the "Info" inspector window at "General".

**Note**

**Effects on telegram configuration**

The Safety Integrated mode affects the telegram configuration because, in the Safety Integrated plus (F-PLC) mode, different telegrams are used than in the inactivated Safety Integrated or the Safety Integrated modes.

Telegrams that are added or changed are kept, however, as long as they are compatible with the newly selected Safety Integrated mode.

Make sure, if applicable, that any modifications are still present following the change of mode in the telegram configuration.

As long as you have not saved the project, you can completely undo the change of the Safety Integrated mode by clicking "Undo" in the toolbar.

**Further information**

General information on the Safety Integrated modes can be found in the following sections:

- Safety Integrated (SPL) (Page 177)
- Safety Integrated plus (F-PLC) (Page 192)

Note also the following documents with information on Safety Integrated:

- Function Manual, SINUMERIK Safety Integrated
- Function Manual, SINUMERIK Safety Integrated plus
- SIMATIC Safety Integrated System Manual
9.4 Parameterization of relevant properties

The Safety Integrated modes of the NCU control the safety behavior of the NCU together with the integrated subcomponents, such as the PLC, SINAMICS Integrated and possibly connected NX modules. Depending on the used mode and communications standard (PROFINET or PROFIBUS), you must configure further relevant properties and F-parameters for various modules. Sample configuring sequences can be found in Sections Configuring Safety Integrated (SPL) (Page 177) and Configuring Safety Integrated plus (F-PLC) (Page 192).

You can, however, also parameterize the appropriate properties in a different order.

Overview

The following table shows in which device properties and in which section you find a specific configuration-relevant setting:

Note that not all parameters are relevant in both Safety Integrated modes. In addition, some parameters are displayed only in a specific Safety Integrated mode for the SINAMICS Integrated and NX components and the associated telegrams.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Can be found at</th>
<th>Further information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Safety Integrated mode</td>
<td>NCU &gt; Safety Integrated</td>
<td>• This chapter, &quot;NCU properties&quot; section.</td>
</tr>
<tr>
<td>(operating mode)</td>
<td></td>
<td>• Changing the Safety Integrated mode (Page 164)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Safety Integrated mode (SPL)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Safety Integrated plus mode (F-PLC)</td>
</tr>
<tr>
<td>Basis for PROFI safe addresses</td>
<td>PLC &gt; Fail-safe &gt; F-parameters</td>
<td>• Information system, keyword &quot;Basis for PROFI safe addresses&quot;.</td>
</tr>
<tr>
<td>F-source address (F_Source_Add)</td>
<td>PLC &gt; Fail-safe &gt; F-source addresses</td>
<td>• Configuration of the PROFI safe addresses (peripherals)</td>
</tr>
<tr>
<td></td>
<td>(only for Safety Integrated mode (SPL))</td>
<td>• Configuration of the PROFI safe addresses (drives)</td>
</tr>
<tr>
<td></td>
<td>(for a GSD module, also under &quot;Module &gt; PROFI safe&quot;)</td>
<td>• Information system, keyword &quot;Special considerations when configuring the F-system&quot;</td>
</tr>
<tr>
<td>F-destination address (F_Dest_Add)</td>
<td>Module/submodule &gt; F-parameters</td>
<td>• Information system, keyword &quot;Special considerations when configuring the F-system&quot;</td>
</tr>
<tr>
<td>DIL switching setting</td>
<td>Module/submodule &gt; F-parameters</td>
<td>• Configuring Safety Integrated plus (F-PLC) (handling overview)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Configuring Safety Integrated (SPL) (handling overview)</td>
</tr>
</tbody>
</table>
### 9.4 Parameterization of relevant properties

<table>
<thead>
<tr>
<th>Setting</th>
<th>Can be found at</th>
<th>Further information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default F-monitoring time for F-peripherals of this interface</td>
<td>Interface &gt; F-parameters</td>
<td>• Information system, keyword &quot;Monitoring and response times&quot;</td>
</tr>
<tr>
<td>F-monitoring time</td>
<td>Module/submodule &gt; F-parameters</td>
<td>• Information system, keyword &quot;Configuring the F-peripherals&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Information system, keyword &quot;Monitoring and response times&quot;</td>
</tr>
<tr>
<td>I/O address</td>
<td>Module/submodule &gt; I/O addresses</td>
<td>• Information system, keyword &quot;Addressing modules (S7-300, S7-400)&quot;</td>
</tr>
<tr>
<td>Size of the PLC process image</td>
<td>PLC &gt; Cycle</td>
<td>• Information system, keyword &quot;Settings for the cycle behavior (S7-300, S7-400)&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Information system, keyword &quot;S7-300 memory areas&quot;</td>
</tr>
<tr>
<td>Name of an I/O system node</td>
<td>Device / header module &gt; General</td>
<td>• Information system, keyword &quot;Assign device name and IP address&quot;</td>
</tr>
<tr>
<td>IP address of an I/O system node</td>
<td>Device / header module &gt; PROFINET interface &gt; Ethernet addresses</td>
<td>• Information system, keyword &quot;Assign device name and IP address&quot;</td>
</tr>
</tbody>
</table>
NCU properties

The Safety Integrated mode of the NCU affects not only the configuration of the integrated PLC, but rather also that of the integrated drives.

SINAMICS Integrated and NX modules always use automatically the same Safety Integrated mode as the associated NCU.

Therefore, set this mode in the NCU properties and not in the PLC properties:

![Changing the Safety Integrated mode](image)

Figure 9-5  Changing the Safety Integrated mode

With the activation of a Safety Integrated mode, the F-capability of the PLC is set appropriate for the Safety Integrated mode of the NCU.
PLC properties

Safety Integrated settings are available in the PLC properties if the NCU uses a safety mode.

Figure 9-6 Fail-safety in the PLC properties - the "F-activation" section is inactive (grayed-out) because the F-activation is controlled via the selection of the Safety Integrated mode in the NCU properties.

Loading the changed Safety Integrated mode into the hardware

If the actual hardware has been operated in Safety Integrated plus (F-PLC) mode and you now want to load a configured hardware configuration with changed Safety Integrated mode, you must perform a general reset of the PLC prior to the loading.

Further information

General information on the Safety Integrated modes can be found in the following sections:

- Safety Integrated (SPL)
- Safety Integrated (F-PLC)

Note also the following documents with information on Safety Integrated:

- Function Manual, SINUMERIK Safety Integrated
- Function Manual, SINUMERIK Safety Integrated plus
9.5 Availability of I/O addresses at the mode change

If the default I/O addresses for communication with the drive are already assigned when changing the Safety Integrated mode, you must configure the telegrams and I/O addresses.

Note

Undoing changes

As long as the project has not been saved, you can undo the change of the Safety Integrated mode together with the changed drive telegram and address settings. Click "Undo" in the toolbar.
Refer to the "Change Safety Integrated mode" dialog or the "Info" inspector window to see which I/O addresses are effected.

- The "Change Safety Integrated mode" dialog shows the components for which the default I/O addresses are assigned.

![Change Safety Integrated mode dialog](image)

**Figure 9-7** "Change Safety Integrated mode" dialog: Default I/O addresses are not available

- The "Info" inspector window shows which default I/O addresses were already assigned for each individual telegram.

![Info inspector window](image)

**Figure 9-8** You can click the symbol in the "Go to" column in the "Info > General" inspector window to display the relevant I/O address.

- You can also display an overview of the telegram settings by clicking "Address overview" in the PLC properties.
Further information

Detailed information on aligning and configuring I/O addresses can be found in Section Configuring telegrams and drive units (Page 103).
9.6 Licensing

9.6.1 Overview

The integrated safety functions of SINUMERIK Safety Integrated are used in the machine tools sector. They are integrated with two channels in the NC, the drive and the internal PLC, and are used to monitor speed, standstill and position. Such monitoring is necessary if the danger zone of the machines and systems is not blocked off.

During operation, the integrated safety functions provide effective operator protection as well as protection of tools, materials and machines.

In the TIA Portal, you can select one of three modes in conjunction with the SINUMERIK:

<table>
<thead>
<tr>
<th>Mode</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>SINUMERIK Safety Integrated not active</td>
<td>-</td>
</tr>
</tbody>
</table>
| Safety Integrated (SPL)       | • SIMATIC STEP 7 Safety Advanced option package (no license required: SIMATIC STEP 7 Safety Advanced without license corresponds to the F-configuration tool from STEP 7 V5.x)  
                                     • Appropriate software option for SPL                                     |
| Safety Integrated plus (F-PLC) | • NCU V4.7 or higher  
                                     • SIMATIC STEP 7 Safety Advanced option package  
                                     • License for SIMATIC STEP 7 Safety Advanced  
                                     • Appropriate software option for F-PLC                                     |

Refer to Section Changing the Safety Integrated mode for a description of how to set the Safety Integrated mode.
9.6.2 Software options for Safety Integrated (SPL)

To configure SINUMERIK Safety Integrated (SPL), SIMATIC STEP 7 Safety Advanced (TIA Portal) without license suffices. (SIMATIC STEP 7 Safety Advanced without license corresponds to the F-configuration tool from STEP 7 V5.x)

To use the configuring in SINUMERIK Operate, you require the appropriate software options:

Table 9-2 Software options for use of Safety Integrated (SPL)

<table>
<thead>
<tr>
<th>Software option</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>SI Basic</td>
<td>Activate SPL</td>
</tr>
<tr>
<td></td>
<td>Contains a license for one axis/spindle, up to four SPL I/O</td>
</tr>
<tr>
<td>SI Comfort</td>
<td>Activate SPL</td>
</tr>
<tr>
<td></td>
<td>Contains a license for one axis/spindle, up to 64 SPL I/O</td>
</tr>
<tr>
<td>SI High Feature</td>
<td>Activate SPL</td>
</tr>
<tr>
<td></td>
<td>Contains a license for one axis/spindle, up to 192 SPL I/O</td>
</tr>
<tr>
<td>SI Axis/Spindle</td>
<td>Additional license for one axis/spindle, multiple licensing in order to use further axes/spindles.</td>
</tr>
<tr>
<td>SI Axis/Spindle package</td>
<td>Additional license for 15 axes/spindles, multiple licensing in order to use further axes/spindles.</td>
</tr>
<tr>
<td>SI-Connect</td>
<td>Make more than three FSEND and three FRECV connections available.</td>
</tr>
</tbody>
</table>

Depending on the functionality used, you must license the appropriate software options and set in the machine data:

- MD19120 $MN_NUM_SAFE_AXES: Number of SI axes/spindles
- MD19122 $MN_NUM_SPL_IO: Number of SPL I/Os
  - 1 = 4 SPL I/O or SI-Basic software option
  - 2 = 64 SPL I/O or SI-Comfort software option
  - 3 = 192 SPL I/O or SI-High Feature software option
- MD19510 $MN_SAFE_FUNCTION_MASK: Number of FSEND and FRECV connections SI-Connect software option: Bit 0 = 1

See also:
- Function Manual, SINUMERIK Safety Integrated
9.6.3 **Software options for Safety Integrated plus (F-PLC)**

For the use of Safety Integrated plus (F-PLC), you require in addition to the license for SIMATIC STEP 7 Safety Advanced (TIA Portal), the appropriate software options for the RT function:

Table 9-3 Software options for the use of Safety Integrated plus (F-PLC)

<table>
<thead>
<tr>
<th>Software option</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>SINUMERIK Safety Integrated plus /SI logic</td>
<td>Activate the F-PLC in SINUMERIK 840D sl in order to process the fail-safe sensors and actuators in an F-program.</td>
</tr>
<tr>
<td>SINUMERIK Safety Integrated plus /SI axis/spindle</td>
<td>Use the motion control functions of the SINAMICS Integrated in the SINUMERIK Safety Integrated plus (F-PLC) mode. License for one axis/spindle, multiple licensing in order to be able to use further axes/spindles.</td>
</tr>
<tr>
<td>SINUMERIK Safety Integrated plus /SI multi-axis package</td>
<td>Use the motion control functions of the SINAMICS Integrated in the SINUMERIK Safety Integrated plus (F-PLC) mode. License for any number of axes/spindles.</td>
</tr>
</tbody>
</table>

Depending on the functions used, you must license the appropriate software options and set in the machine data:

- MD19500 $MN_SAFE_PLC_LOGIC: Safety Integrated plus /SI-Logic basic option
- MD19121 $MN_NUM_DRIVEBASED_SAFE_AXES: Number of axes/spindles in Safety Integrated plus (F-PLC) mode

**See also:**

SINUMERIK 840D sl Basic Software and Operating Software Commissioning Manual, Section SINUMERIK Operate (IM9)

Function Manual, SINUMERIK Safety Integrated plus
9.7 Configuring Safety Integrated (SPL)

9.7.1 Introduction

With the aid of safe programmable logic (SPL), safety-related sensors and actuators can be directly connected to the control's I/O and evaluated by means of software without external evaluation units.

In order to check that the NCK SPL and PLC SPL are functioning, the system program organizes a cyclic data cross-check between the PLC and the NCK.

![Diagram of SPL - data cross-check](image)

The Safety Integrated (SPL) mode is supported by all NCU versions available in the TIA Portal.

The Safety Integrated (SPL) mode has the following characteristics:

- SINAMICS Integrated or connected NX use the SINUMERIK "SI Motion Monitoring" telegrams, not the PROFIsafe telegrams.

- The user program is programmed like a standard user program in the editors for STL, FBD or LAD. Each safety-related program must be created in two programming languages in order to allow the data cross-check (PLC SPL and NCK SPL).

- During the programming, the SGE/SGA of the data block SPL [DB18] is used that you assign on the NCU (e.g. via SINUMERIK Operate) to the I/O addresses of the field devices.

See: Function Manual, SINUMERIK Safety Integrated
Configuring the F-peripherals

During the configuring of F-peripherals with Safety Integrated (SPL), you can orient yourself on the following handling overview with sample configuring sequence. This serves, however, only as an introduction to the configuring and programming of SINUMERIK Safety Integrated (SPL).

Therefore, observe the following documentation prior to configuring Safety Integrated (SPL):

- Function Manual, SINUMERIK Safety Integrated

⚠️ WARNING

Depending on the application area, the SINUMERIK NCU, being a part of plants and systems, requires the observance of special standards and regulations. Observe the appropriate safety and accident prevention regulations, e.g. IEC 60204-1 (general requirements placed on the safety of machines).

This sample handling overview serves only as an introduction to the configuring and programming of STEP 7 Safety Advanced with SINUMERIK. It cannot always be used for effective regular operation. Before you do this, ensure that you reference the current version of the SINUMERIK Safety Integrated Function Manual. The warnings and other notes contained in that manual must be observed, even when they are not repeated in this document!

The non-observance of these regulations can lead to severe injuries and damage to machines and equipment.

Requirement

- The "SIMATIC STEP 7 Safety Advanced" option package has been installed.
  (No license required: SIMATIC STEP 7 Safety Advanced without license corresponds to the F-configuration tool from STEP 7 V5.x)
- The devices to be configured have been inserted
  (at least one NCU and one peripheral device)
- The "Safety Integrated (SPL)" mode is activated in the NCU properties.
  See: Changing the Safety Integrated mode

Note

Activating Safety Integrated mode at the start of the configuring work

If you activate the Safety Integrated mode first at the end of the configuring work, it is possible that all parameters are no longer assigned automatically by the system and you must match these values.

Consequently, activate the desired Safety Integrated mode directly after inserting the NCU.
The required modules, submodules and telegrams are inserted on the peripheral device.

The devices are interconnected with each other using the desired interfaces (PROFINET or PROFIBUS).

You can also connect devices to the interfaces of both types (PROFINET and PROFIBUS) and operate in the Safety Integrated (SPL) mode.

### Procedure overview

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1    | Configuring the basis for PROFIsafe addresses  
See also: TIA Portal online help, keyword "Basis for PROFIsafe addresses". |
| 2    | Configure the input modules. |
| 3    | Configure the output modules. |
| 4    | If necessary, set the F-monitoring time manually:  
- You can configure the parameterization of the F-monitoring time for all devices on a specific interface in the interface settings under "F-parameters > Default F-monitoring time for F-peripherals of this interface".  
- You can configure each F-module individually under "F-parameters" in the settings of the associated module.  
A valid current safety telegram must be received from the F-CPU within the F-monitoring time. Otherwise, the F-module enters the safe state.  
The F-monitoring time should be sufficiently long so that telegram delays are tolerated, but sufficiently short so that the process can respond as fast as possible in a fault situation and run without impairments. The Excel file for the response time calculation provides help with the time determination.  
See also: Monitoring and response times |
| 5    | Enter the PROFIsafe addresses in the NCU MD. |
| 6    | Assign the F-destination addresses. The procedure depends on the associated device:  
- For devices with DIL switches, set the DIL switches on the F-modules to set the PROFIsafe destination addresses as configured in the TIA Portal.  
- For the ET200SP fail-safe modules, assign the F-destination address.  
Further information and information for other devices is available in the documentation for your device and from the manufacturer. |

To use the configuring in SINUMERIK Operate, you require the appropriate software options.
9.7.3 Parameterizing F-input modules

The F-modules and F-submodules to be configured must be selected individually in order to make the desired settings in the "Properties" inspector window. You can select the modules and submodules in the device view or device overview (in the case of GSD-based devices, only in the device overview).

You can set the I/O addresses in the properties of the F-modules and F-submodules. These I/O addresses must lie within the process image of the PLC. (default setting: 1024 bytes; can be configured under "Cycle" in the PLC properties).

You can select F-modules and F-submodules in the device view or device overview of the rack.

Procedure

To configure the inserted F-input modules, select them successively and make the settings individually for each module in the inspector window. Proceed as follows:

1. In the device view, select the rack and open the device overview.
2. In the device overview, select on the rack one of the modules to be configured.
3. In the "Properties > General" inspector window, select the "I/O addresses" entry.
4. Select the "OB1-PA" in the "Process image" dropdown list in each of the "Input addresses" and "Output addresses" sections.
5. Enter the desired address in the associated "Start address" text field. Note the following:
   - The I/O addresses must lie within the process image of the PLC (default setting: 1024 bytes; can be configured under "Cycle" in the PLC properties).
   - Do not use any I/O addresses that are used for some other purpose, e.g. by the machine control panel.
6. In the "Properties > General" inspector window, select the "DI parameters" entry. The properties will be displayed. Safety-relevant settings are marked yellow.

7. Make the required settings, e.g.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Encoder power supply</td>
<td>Select the type of the encoder power supply:</td>
</tr>
<tr>
<td></td>
<td>• Internal: VS1, VS2 are used; the short-circuit test is active</td>
</tr>
<tr>
<td></td>
<td>• Internal: VS1, VS2 are not used; the short-circuit test is inactive</td>
</tr>
<tr>
<td>Encoder evaluation</td>
<td>Select the encoder evaluation:</td>
</tr>
<tr>
<td></td>
<td>• 1oo2 (2v2) evaluation: Dual-channel activation 2v2</td>
</tr>
<tr>
<td></td>
<td>• 1oo1 (1v1) evaluation: Single-channel activation 1v1</td>
</tr>
<tr>
<td>Type of encoder connection</td>
<td>Select between equivalent or non-equivalent encoder interconnection.</td>
</tr>
<tr>
<td>Discrepancy time</td>
<td>Specify the discrepancy time in ms.</td>
</tr>
<tr>
<td>Reintegration after discrepancy error</td>
<td>Select whether Test 0 signal is required. (Test 0 signal, for example, is required for the EMERGENCY STOP button)</td>
</tr>
</tbody>
</table>

### 9.7.4 Configuring drives with F-functions

During the configuring of drives Safety Integrated, you can orient yourself on the following handling overview with sample configuring sequence. This serves, however, only as an introduction to the configuring and programming of SINUMERIK Safety Integrated (SPL).

Therefore, observe the following documentation prior to configuring Safety Integrated (SPL):

- Function Manual, SINUMERIK Safety Integrated

---

**WARNING**

Depending on the application area, the SINUMERIK NCU, being a part of plants and systems, requires the observance of special standards and regulations. Observe the appropriate safety and accident prevention regulations, e.g. IEC 60204-1 (general requirements placed on the safety of machines).

This sample handling overview serves only as an introduction to the configuring and programming of STEP 7 Safety Advanced with SINUMERIK. It cannot always be used for effective regular operation. Before you do this, ensure that you reference the current version of the SINUMERIK Safety Integrated Function Manual. The warnings and other notes contained in that manual must be observed, even when they are not repeated in this document!

The non-observance of these regulations can lead to severe injuries and damage to machines and equipment.
## Requirement

- The "SIMATIC STEP 7 Safety Advanced" option package has been installed.
  (No license required: SIMATIC STEP 7 Safety Advanced without license corresponds to the F-configuration tool from STEP 7 V5.x)
- The devices to be configured have been inserted
  (at least one NCU and one drive device)
- The "Safety Integrated (SPL)" mode is activated in the NCU properties.
  See: Changing the Safety Integrated mode

### Note

**Activating Safety Integrated mode at the start of the configuring work**

If you activate the Safety Integrated mode first at the end of the configuring work, it is possible that all parameters are no longer assigned automatically by the system and you must match these values.

Consequently, activate the desired Safety Integrated mode directly after inserting the NCU.

- The required modules, submodules and telegrams are inserted on the drive device.
- The devices are interconnected with each other using the desired interfaces (PROFINET or PROFIBUS).

  You can also connect devices to the interfaces of both types (PROFINET and PROFIBUS) and operate in the Safety Integrated (SPL) mode.

## Procedure overview

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1    | Configuring the basis for PROFIsafe addresses  
See also TIA Portal online help, keyword "Basis for PROFIsafe addresses". |
| 2    | Configure the PROFIsafe telegrams. |
| 3    | Enter the PROFIsafe addresses in the NCU MD. |
| 4    | During the commissioning of the drive, enter the PROFIsafe addresses as hexadecimal value in p9610 and p9810.  
Further information is available in the documentation for your device and from the manufacturer. |

To use the configuring in SINUMERIK Operate, you require the appropriate software options.
9.7.5 Parameterizing F-output modules

Procedure

To configure the inserted F-output modules, select them successively and make the settings individually for each module in the inspector window. Proceed as follows:

1. In the device view, select the rack and open the device overview.
2. In the device overview, select on the rack one of the modules to be configured.
3. In the "Properties" inspector window, select the "I/O address" entry.
4. Enter the desired address in the "Input addresses > Start address" field. Note the following:
   - The I/O addresses must lie within the process image of the PLC (default setting: 1024 bytes; can be configured under "Cycle" in the PLC properties).
   - Do not use any I/O addresses that are used for some other purpose, e.g. by the machine control panel.
5. In the "Properties" inspector window, select the "DO parameters" entry.
   The properties will be displayed. Safety-relevant settings are marked yellow.
6. Make the required settings, e.g.
   - Enter the desired value (in ms) under "Read-back time". This time should be set to at least 200 ms for large capacitive or inductive loads.
   - "Diagnosis: Wire breakage" should be activated.
9.7.6 Configuration of the PROFlsafe addresses (peripherals)

The PROFlsafe addresses (F-source address, F-destination address) are used to uniquely identify the source and the destination.

Note

Problem solution for the 27220, 27221 alarms (Safety Integrated (SPL))

- Alarm27220: "PROFlsafe: Number of NCK-F modules (6) <> number of S7-F modules (0)"
- Alarm27221: "PROFlsafe: NCK-F module MD$MN_PROFISAFE_IN_ADDRESS[0] unknown or"PROFlsafe: NCK-F module MD $MN_PROFISAFE_OUT_ADDRESS[0] unknown"

Even if you reuse the existing machine data settings (e.g. using an existing SINUMERIK archive), you can change the PROFlsafe addresses. In this case, alarms 27220 and 27221 are displayed in SINUMERIK Operate.

You must also modify or augment the details in MD10385, as described here.

Rules for configuring F-source addresses

When Safety Integrated (SPL) is used, you must enter the associated F-source addresses in the MD10385[0..2]. A maximum of three different F-source addresses are permitted throughout the system.

You can view the assigned F-source addresses in the PLC properties under "Fail-safe > F-source addresses".

The assignment methods of the F-source address in the TIA Portal depend on the used F-peripherals, not on the controller or the used Safety Integrated mode:

- F-peripherals based on the device description file:
  The configured F-source address can be set in the properties of the module under "PROFlsafe > F_Source_Add".

- F-peripherals for PROFlsafe address type 1 (e.g. F-module ET 200S)
  The F-source address has the constant value "1".
  (The unique identification is made using the set F-destination address.)

- F-peripherals for PROFlsafe address type 2 (e.g. F-module ET200SP)
  The F-source address is assigned depending on the PROFlsafe base address (can be set in the PLC properties under "Fail-safe > F-parameters").

The "Basis for PROFlsafe addresses" parameter differs in its effect from STEP 7 V5.x. This parameter is not used in the TIA Portal to influence the F-source address for fail-safe I/O of the PROFlsafe address type 1 (e.g. ET200S).
Requirement

- The software options for Safety Integrated (SPL) are licensed and enabled in the associated machine data.

- A maximum of three different F-source addresses are used in the configuration. You can view the used F-source addresses in the PLC properties under "Fail-safe > F-parameters". If more than three different F-source addresses are used, you must standardize the F-source addresses because a maximum of 3 different F-source addresses can be entered in the MD10385.

- The current configuration is compiled and loaded into the PLC.

- The MD10385, MD10386, MD10387, MD10388 and MD10389 machine data items are not yet filled.

- No red LED illuminates on the F-peripherals. If a red LED illuminates, check and correct the DIL switch setting or the F-source address, e.g. using online diagnosis.
9.7 Configuring Safety Integrated (SPL)

**Procedure**

To enter the PROFlsafe addresses in the NCK machine data, proceed as follows:

1. In the TIA Portal, open the properties of the associated object:
   - Click the PLC and switch in the "Properties" inspector window to "Fail-safe > F-source addresses". A tabular view with the used F-source addresses and the associated values for MD10385 is displayed.
   - Click the DI/DO modules and switch to "Module > F-parameters > F-destination address" in the "Properties" inspector window.

2. In SINUMERIK Operate, call the general machine data and enter the values:

<table>
<thead>
<tr>
<th>Machine data</th>
<th>Value to be entered</th>
<th>Property in the TIA Portal</th>
</tr>
</thead>
<tbody>
<tr>
<td>MD10385[0..2]</td>
<td>F-source addresses</td>
<td></td>
</tr>
<tr>
<td></td>
<td>$MN_PROFISAFE_MASTER_ADDRESS</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Notation: &lt;Identifier for PROFIsafe (5000)&gt; &lt;F source address as hexadecimal number&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>For example, enter &quot;5000001&quot; for F-source address 1.</td>
<td></td>
</tr>
<tr>
<td>MD10386[0..47]</td>
<td>F-destination addresses of the F-DI modules</td>
<td></td>
</tr>
<tr>
<td></td>
<td>$MN_PROFISAFE_IN_ADDRESS</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Format: 0s 0x aaaa</td>
<td></td>
</tr>
<tr>
<td></td>
<td>s: Bus segment (5 = DP connection on the PLC side)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>x: Sub-slot address</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Range of values: 0...2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>x = 0 addresses the F net data signals 1...32</td>
<td></td>
</tr>
<tr>
<td></td>
<td>x = 1 addresses the F net data signals 33...64</td>
<td></td>
</tr>
<tr>
<td></td>
<td>x = 2 addresses the F net data signals 65...96</td>
<td></td>
</tr>
<tr>
<td></td>
<td>aaaa: Hexadecimal PROFIsafe address of the F module</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Example:</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>For example, enter &quot;50000C8&quot; for F-destination address 200.</td>
<td></td>
</tr>
<tr>
<td>MD10387[0..47]</td>
<td>F-destination addresses of the F-DO modules</td>
<td></td>
</tr>
<tr>
<td></td>
<td>$MN_PROFISAFE_OUT_ADDRESS</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Format: See above (MD10386)</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Example:</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>For example, enter &quot;50000C7&quot; for F-destination address 199.</td>
<td></td>
</tr>
</tbody>
</table>
### Machine data

<table>
<thead>
<tr>
<th>Machine data</th>
<th>Value to be entered</th>
<th>Property in the TIA Portal</th>
</tr>
</thead>
</table>
| MD10388[0..47] | Inputs of the F-DI modules $MN_PROFISAFE_IN_ASSIGN  
For example, enter “1004” when INSE/INSEP 1 to 4 is used. | - |
| MD10389[0..47] | Outputs of the F-DO modules $MN_PROFISAFE_OUT_ASSIGN.  
For example, enter “1004” when OUTSE/OUTSEP 1 to 4 is used. | - |
| MD10098 | Factor for PROFIsafe cycle $MN_PROFISAFE_IPO_TIME_RATIO  
The PROFIsafe cycle is displayed in MD10099 and is constructed as follows:  
MD10098 (factor for PROFIsafe clock cycle) x MD10071 (IPO clock cycle)  
The value should lie between 16 ms and 24 ms. | - |

The sequence and the index entered for the PROFIsafe addresses is irrelevant.

3. Restart the NCK.

4. Check the enabled input bytes in DBB 138 "Profisafe input bytes". One bit must be set for each byte.

5. Check the enabled output bytes in DBB 140 "Profisafe output bytes". One bit must be set for each byte.

### Further information

- Detailed information about the SINUMERIK Safety Integrated safety concept and for MD10385 can be found in the "SINUMERIK Safety Integrated" Function Manual.

- Information about individual machine data items is contained in the online help for SINUMERIK Operate and in the "SINUMERIK 840D sl detailed description of the machine data" Lists Manual.

- Information on the parameterization of machine data in SINUMERIK Operate can be found in the SINUMERIK 840D sl Basic Software and Operating Software Commissioning Manual in Section SINUMERIK Operate (IM9).
9.7 Configuring Safety Integrated (SPL)

9.7.7 Configuration of the PROFIsafe addresses (drives)

The PROFIsafe addresses (F-source address, F-destination address) are used to uniquely identify the source and the destination.

---

**Note**

Problem solution for the 27220, 27221 alarms (Safety Integrated (SPL))

- Alarm27220: "PROFIsafe: Number of NCK-F modules (6) <> number of S7-F modules (0)"
- Alarm27221: "PROFIsafe: NCK-F module MD$MN_PROFISAFE_IN_ADDRESS[0] unknown or"PROFIsafe: NCK-F module MD $MN_PROFISAFE_OUT_ADDRESS[0] unknown"

Even if you reuse the existing machine data settings (e.g. using an existing SINUMERIK archive), you can change the PROFIsafe addresses. In this case, alarms 27220 and 27221 are displayed in SINUMERIK Operate.

You must also modify or augment the details in MD10385, as described here.

---

**Rules for configuring F-source addresses**

When Safety Integrated (SPL) is used, you must enter the associated F-source addresses in the MD10385[0..2]. A maximum of three different F-source addresses are permitted throughout the system.

You can view the assigned F-source addresses in the PLC properties under "Fail-safe > F-source addresses".

The assignment method of the F-source address in the TIA Portal depends on the used device type:

- Drive device based on the device description file:
  
  The configured F-source address can be set in the properties of the telegram under "PROFIsafe > F_Source_Add".

**Requirement**

- The software options for Safety Integrated (SPL) are licensed and enabled in the associated machine data.
- A maximum of three different F-source addresses are used in the configuration. You can view the used F-source addresses in the PLC properties under "Fail-safe > F-parameters". If more than three different F-source addresses are used, you must standardize the F-source addresses because a maximum of three different F-source addresses can be entered in the MD1385.
- The current configuration is compiled and loaded into the PLC.
- The MD10385, MD10386, MD10387, MD10388 and MD10389 machine data items are not yet filled.
Procedure

To enter the PROFiSAFE addresses in the NCK machine data, proceed as follows:

1. In the TIA Portal, open the properties of the associated object:
   - Click the PLC and switch in the "Properties" inspector window to "Fail-safe > F-source addresses".
     A tabular view with the used F-source addresses and the associated values for MD10385 is displayed.
   - In the device overview of the drive device, select the telegram and switch in the "Properties" inspector window to "PROFiSAFE > F_Source_Add".

2. In SINUMERIK Operate, call the general machine data and enter the values:

<table>
<thead>
<tr>
<th>Machine data</th>
<th>Value to be entered</th>
<th>Property in the TIA Portal</th>
</tr>
</thead>
<tbody>
<tr>
<td>MD10385[0..2]</td>
<td>F-source addresses $MN_PROFISAFE_MASTER_ADDRESS</td>
<td>PLC &gt; Fail-safe &gt; F-source addresses Telegram &gt; PROFiSAFE &gt; F_Source_Add</td>
</tr>
<tr>
<td></td>
<td>Notation: &lt;Identifier for PROFiSAFE (5000)&gt; &lt;F source address as hexadecimal number&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>For example, enter &quot;5000001&quot; for F-source address 1.</td>
<td></td>
</tr>
<tr>
<td>MD10386[0..47]</td>
<td>F-destination addresses of the F-DI modules $MN_PROFISAFE_IN_ADDRESS</td>
<td>Telegram &gt; PROFiSAFE &gt; F_Dest_Add</td>
</tr>
<tr>
<td></td>
<td>Format: 0s 0x aaaa</td>
<td></td>
</tr>
<tr>
<td></td>
<td>s: Bus segment (5 = DP connection on the PLC side)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>x : Sub-slot address</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Range of values: 0...2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>x = 0 addresses the F net data signals 1...32</td>
<td></td>
</tr>
<tr>
<td></td>
<td>x = 1 addresses the F net data signals 33...64</td>
<td></td>
</tr>
<tr>
<td></td>
<td>x = 2 addresses the F net data signals 65...96</td>
<td></td>
</tr>
<tr>
<td></td>
<td>aaaa: Hexadecimal PROFiSAFE address of the F module</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Example:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>For example, enter &quot;500000C8&quot; for F-destination address 200.</td>
<td></td>
</tr>
<tr>
<td>MD10387[0..47]</td>
<td>F-destination addresses of the F-DO modules $MN_PROFISAFE_OUT_ADDRESS</td>
<td>Telegram &gt; PROFiSAFE &gt; F_Dest_Add</td>
</tr>
<tr>
<td></td>
<td>Format: See above (MD10386)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Example:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>For example, enter &quot;500000C7&quot; for F-destination address 199.</td>
<td></td>
</tr>
</tbody>
</table>
### Machine data

<table>
<thead>
<tr>
<th>Machine data</th>
<th>Value to be entered</th>
<th>Property in the TIA Portal</th>
</tr>
</thead>
</table>
| MD10388[0..47] | Inputs of the F-DI modules  
$\text{MN\_PROFISAFE\_IN\_ASSIGN}$  
For example, enter “1004” when INSE/INSEP 1 to 4 is used. | - |
| MD10389[0..47] | Outputs of the F-DO modules  
$\text{MN\_PROFISAFE\_OUT\_ASSIGN}$  
For example, enter “1004” when OUTSE/OUTSEP 1 to 4 is used. | - |
| MD10098 | Factor for PROFIsafe cycle  
$\text{MN\_PROFISAFE\_IPO\_TIME\_RATIO}$  
The PROFIsafe cycle is displayed in MD10099 and is constructed as follows:  
MD10098 (factor for PROFIsafe clock cycle) x  
MD10071 (IPO clock cycle)  
The value should lie between 16 ms and 24 ms. | - |

The sequence and the index entered for the PROFIsafe addresses is irrelevant.

3. Restart the NCK.

4. Check the enabled input bytes in DBB 138 “Profisafe input bytes”. One bit must be set for each byte.

5. Check the enabled output bytes in DBB 140 “Profisafe output bytes”. One bit must be set for each byte.

### Further information

- Detailed information about the SINUMERIK Safety Integrated safety concept and for MD10385 can be found in the "SINUMERIK Safety Integrated" Function Manual.

- Information about individual machine data items is contained in the online help for SINUMERIK Operate and in the “SINUMERIK 840D sl detailed description of the machine data” Lists Manual.

- Information on the parameterization of machine data in SINUMERIK Operate can be found in the SINUMERIK 840D sl Basic Software and Operating Software Commissioning Manual in Section SINUMERIK Operate (IM9).
9.7.8 Parameterizing PROFlsafe telegrams

The modules and submodules to be configured must be selected individually in order to make the desired settings in the "Properties" inspector window. You can select the modules and submodules in the device view or device overview (in the case of GSD-based devices, only in the device overview).

You can set the I/O addresses in the properties of the telegrams. These I/O addresses must lie within the process image of the PLC. (Default setting: 1024 bytes; can be configured under "Cycle" in the PLC properties.)

You can select telegrams in the device view or device overview of the rack.

Procedure

To configure the inserted input modules, select them successively and make the settings individually for each telegram in the inspector window. Proceed as follows:

1. In the device overview of the drive device, select one of the telegrams to be configured.
2. In the "Properties > General" inspector window, select the "I/O addresses" entry.
3. Select the "OB1-PA" in the "Process image" dropdown list in each of the "Input addresses" and "Output addresses" sections.
4. Enter the desired address in the associated "Start address" text field. Note the following:
   - The I/O addresses must lie within the process image of the PLC (OB1-PA).
   - Do not use any I/O addresses that are used for some other purpose, e.g. by the machine control panel.
9.8 Configuring Safety Integrated plus (F-PLC)

9.8.1 Introduction

New safety functions are available in the SINUMERIK TIA Portal Toolbox with the Safety Integrated plus (F-PLC) mode. The Safety Integrated plus (F-PLC) mode is supported as of NCU V4.7.

The following safety functions are used in the SINUMERIK Integrated plus (F-PLC) mode:

- Use of PROFIsafe telegrams for SINAMICS Integrated or connected NX modules
- Programming of F-blocks with F-logic via the editors for F-FBD or F-LAD
- Handling of configurations and the F-library in the same way as with SIMATIC F-CPUs
- Configuration via the Safety Administration Editor (see below)

Safety Administration Editor

In the SINUMERIK Safety Integrated plus (F-PLC) mode, the "Safety Administration Editor" is also available in the project tree.

It supports the following tasks:

- Display of the safety program status
- Display of the F-collective signature
- Display of the safety mode status
- Creation/organization of F-runtime groups
- Display of information on the F-blocks
- Definition/change of the access protection
- Definition/change of the general settings for the safety program
The Safety Administration Editor is divided into the following sections:

- General
- F-runtime groups
- F-blocks
- Access protection
- Settings

**F-libraries**

You can not only store F-blocks in global libraries and project libraries as master copies, but also use them as already tested and approved safety functions.

However, you must observe additional conditions, which are described in the following help functions:

- Help on SIMATIC Safety, Section "Acceptance of the system"
- TIA Portal online help, Section "Libraries"

**Reserved block numbers for SINUMERIK Safety Integrated plus (F-PLC)**

An F-runtime group is created when you activate Safety Integrated plus (F-PLC) mode. An associated F-FB, F-FC and F-DB is created in the reserved number range for F-runtime groups:

Reserved number range for F-runtime groups

- F-FB 1010..1019
- F-FC 1010..1019
- F-DB 1010..1019

Further reserved number range for F-runtime groups

- F-FB: 3999..7999
- F-FC: 3999..7999
- F-DB: 8000..16000

See also: Creating a second F-runtime group for Safety Integrated plus (F-PLC) (Page 196)

**Further information**

Detailed information on the Safety Administration Editor can be found in the Programming and Operating Manual SIMATIC Safety – Configuring and Programming, or in the section with the same name in the TIA Portal online help.
9.8 Configuring Safety Integrated plus (F-PLC)

9.8.2 Configuring Safety Integrated plus (F-PLC)

The following sample handling overview illustrates the features for the configuring of Safety Integrated plus (F-PLC) with a SINUMERIK NCU compared to a CPU S7-300. Consequently, the overview serves only as an introduction to the configuring and programming of STEP 7 Safety Advanced with SINUMERIK.

Therefore, observe the following documentation prior to configuring Safety Integrated plus (F-PLC):

- SIMATIC Safety - Configuring and Programming
- SIMATIC Safety - Getting Started
- SINUMERIK Safety Integrated plus Function Manual

⚠️ WARNING

Depending on the application area, the SINUMERIK NCU, being a part of plants and systems, requires the observance of special standards and regulations. Observe the appropriate safety and accident prevention regulations, e.g. IEC 60204-1 (general requirements placed on the safety of machines).

This sample handling overview serves only as an introduction to the configuring and programming of STEP 7 Safety Advanced with SINUMERIK. It cannot always be used for effective regular operation. Before you do this, ensure that you reference the current version of the "SIMATIC Safety - Configuring and Programming" manual. The warnings and other notes contained in that manual must be observed, even when they are not repeated in this document!

The non-observance of these regulations can lead to severe injuries and damage to machines and equipment.

Requirement

- The "SIMATIC STEP 7 Safety Advanced" option package has been installed and licensed.
- A project is created in the TIA Portal and an NCU added.

Example handling overview

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Activate the SINUMERIK Safety Integrated plus (F-PLC) mode in the NCU properties (Page 164). With the activation of the F-capability of the NCU, among other things, an F-execution group is created and telegrams are inserted for PROFIsafe and SIC/SCC.</td>
</tr>
<tr>
<td>2</td>
<td>Add the desired components (e.g. peripheral device, drive device, NX module, etc.). See: Insert NX module (Page 21), insert SINUMERIK I/O (Page 139), insert device (Page 17).</td>
</tr>
<tr>
<td>3</td>
<td>In the network view, interconnect the peripheral device or drive device with the PROFINET interface X150 of the NCU.</td>
</tr>
</tbody>
</table>
9.8 Configuring Safety Integrated plus (F-PLC)

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
</table>
| 4    | Switch to the device view of the peripheral device or drive device and add the desired modules (e.g. power module, F-DI/DO module, telegrams).  
See: Configuring PROFIsafe (Page 198) Calling the telegram configuration (Page 111) |
| 5    | Check the PROFIsafe addresses. (Page 200)  
The PROFIsafe addresses must be unique throughout the network and in all stations. To prevent an incorrect parameterization, the addresses are assigned automatically.  
You can configure the F-parameters manually as follows:  
- Under "Fail-safe > F-parameters" in the PLC properties.  
- Under "F-parameters" in the F-module properties.  
See also: Parameterization of relevant properties (Page 167) |
| 6    | If necessary, set the F-monitoring time manually:  
- You can configure the parameterization of the F-monitoring time for all devices on a specific interface in the interface settings under "F-parameters > Default F-monitoring time for F-peripherals of this interface".  
- You can configure each F-module individually under "F-parameters" in the settings of the associated module.  
A valid current safety telegram must be received from the F-CPU within the F-monitoring time. Otherwise, the F-module enters the safe state.  
The F-monitoring time should be sufficiently long so that telegram delays are tolerated, but sufficiently short so that the process can respond as fast as possible in a fault situation and run without impairments. The Excel file for the response time calculation provides help with the time determination. |
| 7    | Assign the F-destination addresses. The procedure depends on the associated device:  
- For devices with DIL switches, set the DIL switches on the F-modules to set the PROFIsafe destination addresses as configured in the TIA Portal.  
- For the ET200SP fail-safe modules, assign the F-destination address.  
Further information and information for other devices is available in the documentation for your device and from the manufacturer.  
For the final approval of the system, all relevant use-specific norms must be adhered to. |
9.8 Configuring Safety Integrated plus (F-PLC)

9.8.3 Creating a second F-runtime group for Safety Integrated plus (F-PLC)

An F-runtime group is automatically created when you activate Safety Integrated plus (F-PLC) mode. The "Program blocks" folder contains the created F-blocks of the F-runtime group: CYC_INT5 [OB35], Main-Safety [FB1010] and Main-Safety_DB [DB1010].

The procedure how you can create a second F-runtime group is described below, e.g. to organize fast-running safety-oriented program sections in a dedicated F-runtime group.

Characteristic SINUMERIK-specific features are described in particular. Detailed information can be found in the SIMATIC Safety help, Chapter "Defining F-runtime groups".

Procedure

To create a second F-runtime group, proceed as follows:

1. In the project tree, double-click the command "Safety administration", e.g. under "CNC_1 > PLC_1".
2. In the Safety Administration Editor, select the "F-runtime group" entry in the sector tree.
3. Click "Create new F-runtime group".
   The "Add new F-runtime group for PLC_1" dialog opens.

Figure 9-11 "Add new F-runtime group for PLC_1" dialog
4. Adjust the settings:
   - In the "Calling block" section, you select the desired block, e.g. the organization block with the number 32 [OB32].
     (You can then adapt the cyclical execution time of the calling block in the properties of the PLC under "Alarms > Watchdog interrupts".)
   - In the "Main safety block" section, enter a free block number reserved for Safety Integrated in the "Number" text field: 1010..1019.

5. Confirm the entries with "OK".
   The "Call options for PLC" dialog opens.

   ![Figure 9-12 "Call options for PLC_1" dialog]

   6. In the "Number" text field, enter a free block number reserved for Safety Integrated: 1010..1019.

   7. Confirm the creation of the data block with "OK".

   8. Right-click the NCU in the project navigation and select the "Compile > Hardware and software (only changes)" command.

     The configuration will be compiled. This may create further program blocks and F-constants that are useful for programming.

Result

The F-runtime group has been created in the "Program blocks" folder. The Safety Administration Editor provides an overview of all available F-blocks.

Further information

- Information about the reserved number range can be found under Introduction (Page 192).
- Information on block assignments can be found in the SINUMERIK 840D sl Basic Functions Function Manual.
9.8 Configuring Safety Integrated plus (F-PLC)

9.8.4 Configuring PROFIsafe

The safety functions can be controlled via PROFIBUS DP using the PROFIsafe profile. Telegrams are available for the data exchange with the higher-level controller which enable the triggering of the safety functions in the converter by the controller as well as the feedback of the status of the safety functions from the converter to the controller.

PROFIsafe address type for SINAMICS Integrated and NX

SINAMICS Integrated, as integrated subcomponent of the NCU as well as of NX modules are considered as F-I/O of PROFIsafe address type 1 in the TIA Portal. (This address type is also valid for other SINAMICS drives.)

For the I/Os of PROFIsafe address type 1, the uniqueness of the PROFIsafe address is only ensured by the F-destination address (F_DEST_ADD). The F-source address has no effect on the uniqueness of the PROFIsafe address.

The F-destination address must therefore be unique throughout the network and CPU (see section "Rules for address assignment").

Configuration of safety telegrams

Safety telegrams can be configured in the properties of SINAMICS Integrated or NX under "Cyclic data traffic".

Safety-relevant parameters, such as the fields for PROFIsafe addresses, are displayed if a PROFIsafe telegram was added:

- The telegram configuration of SINAMICS Integrated or NX modules is automatically adapted when you activate the Safety Integrated plus (F-PLC) mode. PROFIsafe telegrams are added here (SIEMENS telegram 902).
- For additionally connected drive units, add a PROFIsafe telegram in the device overview.

Unique PROFIsafe addresses

For safe operation, you must check whether the used PROFIsafe addresses are unique before starting the communication.

The uniqueness of the PROFIsafe address is only ensured by the fail-safe destination address. The PROFIsafe address must be unique throughout the network and the CPU.

You can configure the fail-safe destination address under "Cyclic data exchange" in the properties of the PROFIsafe telegrams (Safety actual value or Safety setpoint value).
**WARNING**

**Unique PROFIsafe addresses**

You must ensure the unique assignment of the PROFIsafe address throughout the network and the CPU.

- The fail-safe I/O of PROFIsafe address type 1 is addressed clearly by its fail-safe destination address.
- The fail-safe destination address of the fail-safe I/O (drive units in this case) must be unique for the entire fail-safe I/O throughout the network and the CPU (system-wide). The fail-safe I/O of PROFIsafe address type 2, e.g. modules of the ET 200SP type, must also be taken into account.
- Note also the corresponding documentation in the TIA Portal online help in Section “SIMATIC Safety - Configuration and programming”.

(SIN001)

---

**Acceptance of the system**

Information on the acceptance of a safety configuration with controller can be found in the TIA Portal information system under "Acceptance of the system".

**Note**

**Error-free hardware and software transmission**

Error-free HW and SW transmission is the prerequisite for the creation of the safety printout for acceptance purposes. Only then is it assured that all consistency checks have been performed and therefore the safety printout created for a consistent project.
9.8.5 Checking the PROFIsafe address

Unique PROFIsafe address

To ensure safe communication, unique PROFIsafe addresses are required throughout the CPU and the network.

For this reason, it is also necessary that you check the settings of the PROFIsafe addresses carefully.

⚠️ WARNING

Unique PROFIsafe addresses

You must ensure the unique assignment of the PROFIsafe address throughout the network and the CPU.

- The fail-safe I/O of PROFIsafe address type 1 is addressed clearly by its fail-safe destination address.
- The fail-safe destination address of the fail-safe I/O (drive units in this case) must be unique for the entire fail-safe I/O throughout the network and the CPU (system-wide). The fail-safe I/O of PROFIsafe address type 2, e.g. modules of the ET 200SP type, must also be taken into account.
- Note also the corresponding documentation in the TIA Portal online help in the section "SIMATIC Safety - Configuration and programming". (SIN001)

During compilation of the safety program, a warning indicates the importance of unique PROFIsafe addresses:

Creating and checking the safety printout of the PLC

Create the safety printout by right-clicking on "Safety administration" and selecting "Print" in the shortcut menu.
All the relevant data is listed in the safety printout.

**Note**

**Error-free hardware and software transmission**

Error-free HW and SW transmission is the prerequisite for the creation of the safety printout for acceptance purposes. Only then is it assured that all consistency checks have been performed and therefore the safety printout created for a consistent project.

**Example of a safety printout**

Here is an example of an NCU 730.3 PN with SINAMICS Integrated standard configuration (6 drive objects).

In the SINAMICS Integrated overview table, the PROFIsafe addresses of the individual drive objects are listed under "F-destination address".

<table>
<thead>
<tr>
<th>SINAMICS Integrated_1</th>
<th>Start address</th>
<th>F-destination address</th>
<th>F-monitoring time</th>
<th>Parameter signature (w/o addresses)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 Drive Axis 1 Siemens telegram 903</td>
<td>1008</td>
<td>1</td>
<td>150 ms</td>
<td>OxEE5 (3813)</td>
</tr>
<tr>
<td>0 Drive Axis 2 Siemens telegram 903</td>
<td>992</td>
<td>2</td>
<td>150 ms</td>
<td>OxEE5 (3813)</td>
</tr>
<tr>
<td>0 Drive Axis 3 Siemens telegram 903</td>
<td>976</td>
<td>3</td>
<td>150 ms</td>
<td>OxEE5 (3813)</td>
</tr>
<tr>
<td>0 Drive Axis 4 Siemens telegram 903</td>
<td>960</td>
<td>4</td>
<td>150 ms</td>
<td>OxEE5 (3813)</td>
</tr>
<tr>
<td>0 Drive Axis 5 Siemens telegram 903</td>
<td>944</td>
<td>5</td>
<td>150 ms</td>
<td>OxEE5 (3813)</td>
</tr>
<tr>
<td>0 Drive Axis 6 Siemens telegram 903</td>
<td>928</td>
<td>6</td>
<td>150 ms</td>
<td>OxEE5 (3813)</td>
</tr>
</tbody>
</table>

Figure 9-13 PROFIsafe address in the safety printout

In the tables below, further details on the PROFIsafe telegrams of the individual drive objects are listed.

**Checking the PROFIsafe address in the safety printout**

- Compare the PROFIsafe address with the value of the drive parameter p9610 in SINUMERIK Operate. See: Function Manual, SINUMERIK Safety Integrated plus
- Compare this PROFIsafe address with the values of all other nodes and ensure uniqueness.

**Further information**

- Information on the configuration of drives with PROFIsafe via SINUMERIK Operate can be found in the SINUMERIK Safety Integrated plus Function Manual.
- Further information on the unambiguosity of PROFIsafe addresses can be found in the Programming and Operating Manual, SIMATIC Safety – Configuring and Programming, or in the section with the same name in the information system of the TIA Portal.
Index

A
Activate
  Project language, 157
Actual values
  Cyclic communication, 113, 116
Add
  Drive object, 119
ADI4 module
  connect, 139
  Insert, 139
Alarm
  SINUMERIK DB2 alarm, 158
Archive
  PLC hardware upgrade archive, 33, 36
  Series start-up archive, 33, 36
  SINUMERIK archive, 33, 36

B
Basic PLC program
  Blocks with user-specific adaptations, 55
Block
  Conflicts during copying, 63
  DB1010, 196
  DB1010..1019, 193
  DB8000..16000, 193
  External source, 70
  FB1, 45
  FB1010, 196
  FB1010..1019, 193
  FB3999..7999, 193, 193
  F-block, 193
  FC1010..1019, 193
  List of all basic program blocks, 52
  OB1, 45
  OB100, 45
  OB35, 196
  OB40, 45
  OB82, 45
  OB86, 45
  Blocks
    editing, 77
    open, 77

C
Communications
  establishing, 28
Compile
  Hardware, 30
Components
  NCU, 17
Configuration
  Drive object, 119
Connect
  ADI4 module, 139
  NX module, 21
Copy
  NCU, 17
Cyclic data exchange, 111

D
Delete
  Drive object, 119
  NCU, 17
Device replacement
  Drive object, 119
  Firmware version, 25, 26
  NCU, 25, 26
  NX, 25, 26
Disabling
  Project language, 157
DP Integrated
  setting, 82

E
Ethernet interface
  configuring, 79
Extended download, 31
External source
  SCL, 149
  STL, 149

F
FBD, 77
F-Config, 175
F-configuration tool, 175
Firmware version, (NCU), 21
  Change, 26
F-runtime group, 196

G
GSD file
  downloading, 142
GSD files
  Installing, 142
GSDML file
  downloading, 142
GSDML files
  Installing, 142

H
Hardware
  compile, 30
  Hardware configuration
    load, 31

I
Import
  NC tags, 149
  SCL file, 149
  STL file, 149
Insert
  ADI4 module, 139
  NCU, 17
  NX module, 21
Integrated PROFIBUS
  setting, 82

L
LAD, 77
Language
  Activate project language, 157
  Disabling a project language, 157
Library
  Global library, 59
  System library, 59

M
Machine data
  MD10385, 184, 188
Master copies
  PLC basic program, 48
Mnemonics
  setting, 71
N
NC tags, 149
NC VAR selector, 149
NCU
Copy, 17
Delete, 17
Firmware version, 26
Insert, 17
Optional subcomponents, 17
Subcomponents, 17
NX
Firmware version, 26
NX module
connect, 21
Insert, 21
P
PLC
Communication setup, 28
PLC basic program, 48
Assignment overview, 56
Block listing as table, 52
Execution structure, 45
Upgrade, 65
PLC symbol export, 72
PLC symbols
generate, 72
load, 72
PROFIBUS DP
configuring, 80
PROFINET interface
Configuring, 83
PROFIsafe
Address, 113, 116
Destination address, 184, 188
Master address, 184, 188
Source address, 184, 188
Programming language
FBD, 77
LAD, 77
STL, 77
Project language
Activate, 157
Deactivate, 157
S
Safety Integrated mode
Change, 30
Safety Integrated plus (F-PLC), 196
SCL
Importing the SCL file, 149
SINAMICS Integrated
F-source address, 188
STL, 77
Importing the STL file, 149
Subcomponents
NCU, 17
T
Telegram configuration, 111
Troubleshooting
Alarm 27220, 184, 188
Alarm 27221, 184, 188
Safety Integrated (SPL), 184, 188
U
Upgrade
NCU, 26
NX, 26